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Preface

About This Guide

This guide describes how to install and configure RSA® Authentication Manager. It is intended for
administrators and other trusted personnel.

For a complete list of documentation, see "RSA SecurID Access Product Documentation" on RSA Link at
https://community.rsa.com/docs/DOC-60094.

For a description of common RSA Authentication Manager terms, see the "RSA Authentication Manager
Glossary" on RSA Link at https://community.rsa.com/docs/DOC-76682.

RSA SecurID Access Support and Service

You can access community and support information on RSA Link at https://community.rsa.com. RSA Link
contains a knowledgebase that answers common questions and provides solutions to known problems, product
documentation, community discussions, and case management.

Support for RSA Authentication Manager
Before you call Customer Support for help with the RSA Authentication Manager appliance, have the following
information available:

l Access to the RSA Authentication Manager appliance.

l Your license serial number. To find this number, do one of the following:
l Look at the order confirmation e-mail that you received when your ordered the product. This e-
mail contains the license serial number.

l Log on to the Security Console, and click License Status. Click View Installed License.

l The appliance software version. This information is located in the top, right corner of the Quick Setup, or
you can log on to the Security Console and click Software Version Information.

Support for the Cloud Authentication Service and Identity Routers
If your company has deployed identity routers and uses the Cloud Authentication Service, RSA provides you with
a unique identifier, called the Customer Support ID, which is required when you register with RSA Customer
Support. To see your Customer Support ID, sign in to the Cloud Administration Console and clickMy Account >
Company Settings.

RSA Ready Partner Program

The RSA Ready Partner Program website at www.rsaready.com provides information about third-party hardware
and software products that have been certified to work with RSA products. The website includes
Implementation Guides with step-by-step instructions and other information on how RSA products work with
third-party products.

Preface 11
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How RSA Authentication Manager Protects Your Resources

RSA Authentication Manager is a multi-factor authentication solution that verifies authentication requests and
centrally administers authentication policies for enterprise networks. Use Authentication Manager to manage
security tokens, users, multiple applications, agents, and resources across physical sites and in the Cloud, and
to help secure access to network, Cloud, and web-accessible applications, such as SSL-VPNs and web portals.

Passwords are a weak form of authentication because access is protected only by a single factor — a secret
word or phrase selected by the user. If this password is discovered by the wrong person, the security of the
entire system is compromised. Multifactor authentication provides stronger protection by requiring two or more
unique factors to verify a user’s identity. Authentication factors in a multifactor systemmay include:

l Something the user knows (a password, passphrase, or PIN)

l Something the user has (a hardware token, laptop computer, or mobile phone)

l Something the user does (specific actions or a pattern of behavior)

The RSA SecurID Access Base Edition license, Enterprise Edition license, and Premium Edition license include
both Authentication Manager and the Cloud Authentication Service. The Cloud Authentication Service supports
multiple forms of authentication, such as mobile-optimized push notification (Approve), device biometrics, and
standards-based FIDO tokens.

Integrating Authentication Manager and the Cloud Authentication Service
Integrating Authentication Manager with the Cloud Authentication Service offers opportunities to expand the
resources you protect and the authentication methods you make available to users:

l Users with RSA SecurID tokens can access SaaS and on-premises web applications and RADIUS clients
protected by the Cloud Authentication Service. For more information, see "Enable RSA SecurID Token
Users to Access Resources Protected by the Cloud Authentication Service" on RSA Link at
https://community.rsa.com/docs/DOC-84681.

l Authentication Manager can accept tokencodes generated by the RSA SecurID Authenticate app to
provide strong authentication and convenient single sign-on to protected resources. Users install the
RSA SecurID Authenticate app on a supported device to generate tokencodes. For more information, see
"Enable Cloud Authentication Service Users to access Resources Protected by RSA SecurID" on RSA Link
at https://community.rsa.com/docs/DOC-84670.

l If you have an RSA Authentication Manager RADIUS deployment, expand the authentication methods
available to users by moving to RADIUS for the Cloud Authentication Service. This path involves
configuring a RADIUS client in the Cloud Authentication Service to protect the resources that are
currently protected by RADIUS in Authentication Manager. For instructions, see "RADIUS for the Cloud
Authentication Service Overview" on RSA Link at https://community.rsa.com/docs/DOC-75832.

To deploy the Cloud Authentication Service, contact your RSA Sales representative.

Additional Authentication Methods
In addition, Authentication Manager provides the following choices for strong authentication:

l RSA SecurID tokens. Hardware and software tokens provide tokencodes that enable users to
authenticate and access resources protected by Authentication Manager and the Cloud Authentication
Service.

14 Chapter 1: RSA Authentication Manager Overview
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A tokencode is a pseudorandom number, usually six digits in length. Tokencodes are time-based,
changing at regular intervals. To gain access to protected resources, a user enters a personal
identification number (SecurID PIN) + the number displayed on the token (tokencode). The combination
of the SecurID PIN and the tokencode is called a passcode.

The user is granted access only if Authentication Manager validates the passcode. Otherwise, the user is
denied access. Authentication Manager also supports pinless SecurID authentication, in which case a
SecurID PIN is not required.

l Risk-based authentication (RBA). Strengthens RSA SecurID authentication and traditional
password-based authentication by discreetly analyzing user behavior and the device from which a user
authenticates to identify potentially risky or fraudulent authentication attempts. When RBA is used to
protect a network resource, the system determines the assurance level of each authentication attempt
based on the user’s profile, authentication device, and authentication history.

l On-demand authentication (ODA). Delivers a one-time tokencode to a user by way of e-mail or Short
Message Service (SMS). This tokencode, combined with a PIN known only by the user, enables strong
two-factor authentication without the need for a physical token or dedicated authentication device. You
can use ODA as a standalone authentication method or as an identity confirmation method for RBA.

Authentication Manager is scalable and can authenticate up to one million users. It is interoperable with a wide
variety of applications. For a list of supported applications, go to www.rsaready.com.

Key Components for RSA Authentication Manager

An RSA Authentication Manager deployment may have the following components:

Primary Instance below

Replica Instance on the next page

RSA Authentication Manager Identity Sources on page 48

RSA Authentication Agents on page 18

Risk-Based Authentication for a Web-Based Resource on page 19

RSA RADIUS Overview on page 82

Web Tier on page 20

RSA Self-Service Overview on page 21

SMS plug-ins. For more information, see the Help topic “On-Demand Authentication.”

Load Balancer on page 22

RSA supports and certifies many third-party products for integration with RSA SecurID, risk-based
authentication (RBA), on-demand authentication (ODA), or Short Message Service (SMS). For a list of supported
products, go to http://www.rsaready.com and search for Authentication Manager. Each certification has a step-
by-step implementation guide for setting up the solution.

Primary Instance

The primary instance is the initial Authentication Manager system that you deploy. Once you deploy a primary

Chapter 1: RSA Authentication Manager Overview 15
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instance, you can add replica instances. It is possible to promote a replica instance to replace the primary
instance in maintenance or disaster recovery situations.

The primary instance is the only system in the deployment that allows you to perform all Authentication Manager
administrative tasks. Some administrative tasks can be performed on a replica instance, for example, replica
promotion and log file collection.

The main functions of the primary instance include the following:

l Authenticating users.

l Enabling administration of Authentication Manager data stored in the internal database. You can perform
tasks such as importing and assigning SecurID tokens, enabling risk-based authentication (RBA),
adding LDAP identity sources, configuring self-service, generating replica packages, and generating
agent configuration files and node secrets.

l Replicating changes due to administration and authentication activities.

l Hosting the primary RSA RADIUS server.

l Handling self-service requests.

l Maintaining the most up-to-date Authentication Manager database.

Replica Instance

A replica instance provides deployment-level redundancy of the primary instance. You can view, but not update,
administrative data on a replica instance.

A replica instance provides the following benefits:

l Real-time mirror of all user and system data

l Failover authentication if the primary instance becomes unresponsive

l Improved performance by load balancing authentication requests to multiple instances

l Ability to deploy a replica instance at a remote location

l Ability to recover administrative capabilities through replica promotion if the primary instance becomes
unresponsive

Although a replica instance is optional, RSA recommends that you deploy both a primary and a replica instance.
The RSA SecurID Access Base Edition license includes permission to deploy a replica instance. The Enterprise
Edition license and the Premium Edition license both include permission to deploy up to 15 replica instances.

RSA Authentication Manager Identity Sources

An identity source is a repository that contains user and user group data. Each user and user group in a
deployment is associated with an identity source.

Authentication Manager supports the following as identity sources:
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l An LDAP directory

Authentication Manager supports the following directories as identity sources:

l Microsoft Active Directory 2008 R2

l Microsoft Active Directory 2012

l Microsoft Active Directory 2012 R2

l Microsoft Active Directory Lightweight Directory Services 2012 R2

l Microsoft Active Directory 2016

l Sun Java System Directory Server 7.0

l Oracle Directory Server Enterprise Edition 11g

l OpenLDAP 2.4.40

In Active Directory, you can add a Global Catalog as an identity source, when some or all of the Active
Directory servers in the Active Directory forest are used as identity sources. In such a case, you can use
the Global Catalog for runtime activities, such as looking up and identifying users and resolving group
membership within the Active Directory forest. You cannot use a Global Catalog identity source to
perform administrative tasks.

Note: Authentication Manager supports Active Directory Lightweight Directory Services (LDS) servers if
the same server does not also have an Active Directory Domain Controller role. If a server has an Active
Directory Domain Controller role, select that identity source type when connecting the identity source to
Authentication Manager.

l The Authentication Manager internal database

Data from an LDAP Directory
Authentication Manager has read-only access to all LDAP directory identity sources. After a directory is
integrated with Authentication Manager, you can use the Security Console to do the following:

l View (but not add or modify) user and user group data that resides in the directory.

l Perform Authentication Manager administrative tasks. For example, enable or disable the use of on-
demand authentication (ODA) and risk-based authentication (RBA), or assign tokens or user aliasesto
individual users who reside in the directory.

You must use the LDAP directory native user interface to modify data in a directory.

Data from the Internal Database
Authentication Manager provides an internal database where you can create users and user groups. For users
and user groups in the internal database, administrators can use the Security Console to do the following:

l Add, modify, and view user and user group data.

l Enable or disable Authentication Manager functions, such as ODA and RBA, for individual users,
including users whose accounts are in an LDAP directory.

The following information is stored only in the internal database:

Chapter 1: RSA Authentication Manager Overview 17
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l Data that is specific to Authentication Manager, such as policies for administrative roles, and records for
authentication agents and SecurID authenticators

l Data that links Authentication Manager with LDAP directory user and user group records

RSA Authentication Agents

Authentication agents are software applications that securely pass user authentication requests to and from
RSA Authentication Manager. Authentication agents are installed on each machine, such as a domain server,
web server, or a personal computer, that you protect with Authentication Manager.

For example, agent software residing on a web server intercepts all user requests for access to protected web
pages. When a user attempts to access a protected URL, the agent requests the User ID and passcode and
passes the User ID and passcode to the Authentication Manager for authentication. If the authentication is
successful, the user is granted access to protected web pages.

Different types of authentication agents protect different types of resources. For example, to protect an Apache
Web server, you need the current version of RSA Authentication Agent for Web for Apache.

Note: Risk-based authentication (RBA) only works with web-based authentication agents.

Some authentication agents include support for the REST protocol. The following table compares the
authentication agents that use the REST protocol to other authentication agents.

REST Protocol Authentication Agents Other Authentication Agents

To use the authentication agent, you must have
configured the REST service in Authentication
Manager. You can then add the authentication agent.
For instructions, see the Help topic "Configure the
RSA SecurID Authentication API for Authentication
Agents."

To deploy an authentication agent that uses the
UDP protocol, you must generate the
RSA Authentication Manager configuration file ,
sdconf.rec, and copy it to each machine on which the
agent is installed. You must also add an agent record
for each installed agent. For instructions, see the Help
topic "Deploying an Authentication Agent."

One authentication agent record in Authentication
Manager can represent more than one installed agent.

For example, you can install and configure the
RSA Authentication Agent 8.0 for PAM on hundreds of
servers, and then add the PAM agent one time in
Authentication Manager. In this example, you can edit
one authentication agent record to configure multiple
installed agents.

Each installed agent has an authentication agent record
in Authentication Manager. If you install one hundred
agents, then you need to add one hundred
authentication agent records.

A logical name can be used to identify authentication
agent records, and a fully qualified hostname or
IP address is not required.

More than one installed agent can share the same
logical name, and each agent might have a different
hostname and IP address.

More than one agent can be installed on the same
machine with a shared hostname and IP address, but

In Authentication Manager, the authentication agents
are identified with their hostname and IP address. Two
agents are installed on the samemachine would share
the same authentication agent record in Authentication
Manager.

18 Chapter 1: RSA Authentication Manager Overview
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REST Protocol Authentication Agents Other Authentication Agents

these agents can either share the same logical name or
use different logical names.

Authentication Manager agent reporting can provide
additional details, such as information about the
machine on which each authentication agent is
installed, how many installed agents exist for each
authentication agent record, and a unique identifier for
each installed agent.

Authentication Manager can report some details on the
agent.

A unique identifier is provided for each installed agent.
An agent might have one record in Authentication
Manager, but the agent can be installed on multiple
machines with a unique identifier for each installation.

If only one authentication agent is installed on a
machine, then the hostname or IP address identifies
the agent.

Instead of a node secret, Transport Layer Security
(TLS) is used to protect the channel. The
authentication agent must be configured with the
internal, trusted CA certificate of the deployment.

Node secrets are required for agents that use the
UDP protocol.

The node secret is a shared secret known only to the
authentication agent and Authentication Manager.
Authentication agents use the node secret to encrypt
authentication requests that they send to
Authentication Manager. Authentication Manager
automatically creates and sends the node secret to the
agent in response to the first successful authentication
on the agent.

Obtaining RSA Authentication Agents
RSA authentication agent software is available on the RSA website at https://www.rsa.com/en-
us/products/rsa-securid-suite/rsa-securid-access/securid-authentication-agents.html and on RSA Link at
https://community.rsa.com/docs/DOC-40601#agents.

You may also purchase products that contain embedded RSA authentication agent software. The software is
embedded in a number of products, such as remote access servers, firewalls, and web servers. For more
information, go to the RSA Ready Partner website at www.rsaready.com.

On the RSA Ready Partner website, locate the RSA Implementation Guide for Authentication Managerfor your
agent. Save it to your desktop or a local drive that you can access during the integration process.

Note: Only certified partner solutions have an implementation guide. For other agents that are certified as RSA
SecurID Ready, you can create a custom implementation.

Risk-Based Authentication for a Web-Based Resource

Risk-based authentication (RBA) protects access to web-based resources and applications. Deploying RBA
requires integrating the resource with RSA Authentication Manager. Authentication Manager provides a
template to facilitate the integration process. Once integrated, the web-based resource automatically redirects
users to Authentication Manager, which does either of the following:
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l Authenticates the user and returns proof of authentication to the resource

l When the risk level is high, prompts the user to provide further credentials, such as the correct answers
to pre-configured security questions, before returning proof of authentication.

The web-based resource presents the proof of authentication to Authentication Manager for verification and
allows the user access to the resource.

RSA RADIUS Overview

You can use RSA RADIUS with RSA Authentication Manager to directly authenticate users attempting to access
network resources through RADIUS-enabled devices. A RADIUS server receives remote user access requests
from RADIUS clients, for example, a VPN. The RADIUS server forwards the access requests to
RSA Authentication Manager for validation. Authentication Manager sends accept or reject messages to the
RADIUS server, which forwards the messages to the requesting RADIUS clients.

RADIUS is automatically installed and configured during the Authentication Manager installation. After
installation, RADIUS is configured to run on the same instance with Authentication Manager.

You use the Operations Console to configure RSA RADIUS and manage settings that must be made on individual
instances running RSA RADIUS.

You can use the Security Console to complete most tasks associated with managing RADIUS day-to-day
operations.

Through the Security Console, you can manage the following objects:

l RADIUS servers. Server that receives users' access requests from RADIUS clients and forwards them
to Authentication Manager for validation. A RADIUS server also forwards accept or reject messages from
Authentication Manager to the requesting clients.

l RADIUS clients. RADIUS-enabled device at the network perimeter that enforces access control for
users attempting to access network resources.

l RADIUS profiles. Named collection of checklist and return list attributes that specify session
requirements for a user requesting remote network access.

l RADIUS user attributes. RADIUS attributes that you assign to a user or trusted user outside of a
profile.

l RADIUS accounting. Usage statistics of the RADIUS servers and clients for billing or auditing
purposes.

l RADIUS replication. RSA RADIUS sends changes that occur as a result of RADIUS activity to the
RADIUS replica servers automatically, but you can manually cause the system to replicate as well.

Web Tier

A web tier is a platform installed in the DMZ that provides services to remote users without providing them with
direct access to your private network. The web tier receives and manages inbound internet traffic before it
enters your private network.
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Authentication Manager includes risk-based authentication (RBA), dynamic seed provisioning, and the Self-
Service Console, which may be needed by users outside of the corporate network. If the network includes a
DMZ, you can use a web tier to deploy these services in the DMZ.

Note: On-demand authentication and SecurID do not require a web tier, even with a DMZ, when they are
deployed as standalone authentication methods.

Deploying Authentication Manager applications and services in a web tier in the DMZ offers the following
benefits:

l Protects your internal network from any unfiltered internet traffic from the Self-Service Console and RBA
users. Web-tier servers receive and manage inbound internet traffic before it enters your private
network.

l Allows you to customize the RBA logon pages and the Self-Service Console.

l Allows you to replace the default certificates with custom certificates that you request from a certificate
authority.

l Improves system performance by removing some processing tasks from the back-end server.

A deployment can have up to 16 web tiers.

RSA Self-Service Overview

RSA Self-Service automates the authenticator deployment process and provides a Self-Service Console. The
Self-Service Console is a web-based interface that you configure to provide a variety of services to
Authentication Manager users.

RSA Self-Service includes the following components:

Self-Service. A configurable console where users can manage many day-to-day tasks related to
authentication, token, and user accounts without calling the Help Desk. Self-Service can reduce the call volume
to your Help Desk and aid in providing 24-hour support for your users.

Provisioning. A web-based workflow system for the rapid deployment and lifecycle management of RSA
SecurID authenticators. Users can performmany of the steps in the authenticator deployment process, and the
system automates the workflow. Provisioning can reduce administrative overhead associated with deploying
authenticators, especially in large-scale deployments.

RSA recommends installing the Self-Service Console on a secure server on a web tier in the DMZ. This
installation offers the convenience of Self-Service to remote users, while protecting your internal resources.
Self-Service configuration menus are integrated into the RSA Security Console. You can customize the Self-
Service Console, for example to display your logo, and the Self-Service features that it displays.

The tasks that users can perform from the Self-Service Console depend on the options that you enable and
whether the user’s data is stored in an internal or external identity source.

By default the Self-Service Console allows users to make requests to be added to the system after answering a
set of security questions. Additionally, you can configure Authentication Manager to allow users to perform the
following tasks on the Self-Service Console:
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l Request an RSA SecurID token

l Manage their RSA SecurID PIN

l Configure security questions for identity confirmation

l Update their profile information, for example, a mobile phone number or e-mail address

l Change their Self-Service Console passwords

l Clear the risk-based authentication (RBA) device history to unregister devices

l Change e-mail address or phone number for on-demand authentication (ODA)

l Manage their ODA PIN

l View user group membership

Note: Users can only modify data that is stored in the internal database. Users cannot use the Self-Service
Console to modify data that is stored in an LDAP directory, except when a password change is forced.

For more information, see the Help topic "Self-Service Settings."

Load Balancer

If your deployment includes more than one web tier, you can add a third-party load balancer. The web-tier
deployment can be used with a load balancer or you can use round robin DNS.

Adding a load balancer to your deployment provides the following benefits:

l The load balancer distributes authentication and RBA requests between the primary and the replica web
tiers.

l The load balancer can be configured to forward Self-Service Console requests coming through the
HTTPS port to the web tier or the primary instance hosting the Self-Service Console. If the primary
instance is not functioning and a replica instance is promoted to take its place, users can continue to use
the same URL for the Self-Service Console.

l The load balancer can verify the availability of each web tier.

l The load balancer provides failover if one of the Authentication Manager instances or web tiers
experiences downtime.

RSA SecurID Authentication Process

The RSA SecurID authentication process involves the interaction of three distinct products:

l RSA SecurID authenticators, also known as tokens, which generate one-time authentication credentials
for a user.

l RSA Authentication Agents, which are installed on client devices and send authentication requests to the
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Authentication Manager.

l RSA Authentication Manager, which processes the authentication requests and allows or denies access
based on the validity of the authentication credentials sent from the authentication agent.

To authenticate a user with SecurID, Authentication Manager needs, at a minimum, the following information:

Element Information

User
record

Contains a User ID and other personal information about the user (for example, first name, last name,
group associations, if any). The user record can come from either an LDAP directory server or the
Authentication Manager internal database.

Agent
record

Lists the name of the machine where the agent is installed. This record in the internal database
identifies the agent to Authentication Manager and enables Authentication Manager to respond to
authentication requests from the agent.

Token
record

Enables Authentication Manager to generate the same tokencode that appears on a user’s RSA
SecurID token.

SecurID
PIN

Used with the tokencode to form the passcode.

The Role of RSA Authentication Manager in SecurID Authentication
RSA Authentication Manager software, authentication agents, and RSA SecurID tokens work together to
authenticate user identity. RSA SecurID patented time synchronization ensures that the tokencode displayed by
a user’s token is the same code that the RSA Authentication Manager software has generated for that moment.
Both the token and the Authentication Manager generate the tokencode based on the following:

l The token’s unique identifier (also called a “seed”).

l The current time according to the token’s internal clock, and the time set for the Authentication Manager
system.

To determine whether an authentication attempt is valid, the RSA Authentication Manager compares the
tokencode it generates with the tokencode the user enters. If the tokencodes do not match or if the wrong PIN is
entered, the user is denied access.

RSA SecurID Authentication Examples
Authentication Manager software is scalable and can authenticate large numbers of users. It is interoperable
with network, remote access, wireless, VPN, Internet, and application products. The following table describes
key examples.

Product or
Application

Description

VPN Access RSA SecurID provides secure authentication when used in combination with a VPN.

Remote dial-in RSA SecurID operates with remote dial-in servers, such as RADIUS.

Web access RSA SecurID protects access to web pages.

Wireless Networking Authentication Manager includes an 802.1- compliant RADIUS server.

Secure access to
Microsoft Windows

Authentication Manager can be used to control access to Microsoft Windows
environments both online and offline.

Network hardware
devices

Authentication Manager can be used to control desktop access to devices enabled for
SecurID, such as routers, firewalls, and switches.
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RSA SecurID Tokens

RSA SecurID tokens offer RSA SecurID two-factor authentication. An RSA SecurID token is a hardware device or
software-based security token that generates a 6-digit or 8-digit pseudorandom number, or tokencode, at
regular intervals. When the tokencode is combined with a personal identification number (PIN), the result is
called a passcode. Users enter passcode values, along with other security information, to verify their identity to
resources protected by Authentication Manager.

Requiring these two factors, the tokencode and the PIN, is known as two-factor authentication:

l Something you have (the token)

l Something you know (the PIN)

If Authentication Manager validates the passcode, the user is granted access. Otherwise, the user is denied
access. (To protect against the use of stolen passcodes, Authentication Manager checks that a passcode has not
been used in any previous authentication attempt.)

There are two kinds of SecurID tokens, hardware tokens and software tokens:

l Hardware tokens generate tokencodes using a built-in clock and the token’s factory-encoded random
key, known as the “seed.” Hardware tokens come in several models, such as key fobs and PINPads.

l Software tokens consist of two components that are installed separately, an application specific to the
intended device platform and a token seed record. Software token applications generate tokencodes on
the device and offer the same passcode functionality as hardware tokens. Devices include smart phones,
computers, and tablets.

Each shipment of tokens includes token seed records that you must import into Authentication Manager. Each
token seed record corresponds to an individual RSA SecurID token, and is used by Authentication Manager to
generate the correct tokencode when a SecurID authentication request is received from an authentication agent.

Authentication Manager logs the serial numbers of SecurID tokens used to authenticate. By default,
Authentication Manager logs the serial number in the clear, but you can mask the serial numbers of tokens
when logging to syslog or using SNMP if you want to avoid transmitting and recording the serial number in the
clear. RSA recommends masking token serial numbers for added security.

You can assign up to three RSA SecurID tokens to each authorized user on a protected system.

All tokens require similar administrative tasks. Following deployment, you can performmany token-related
administrative tasks with the User Dashboard in the Security Console. For more information, see the Help topic
"User Dashboard."

For deployments that have an Active Directory identity source, you can also manage hardware and software
tokens with the RSA Token Management snap-in for the Microsoft Management Console (MMC). The RSA Token
Management snap-in extends the context menus, property pages, control bars, and toolbars in the Active
Directory Users and Computers snap-in. RSA SecurID Access Authenticator Tokencodes are not managed by the
RSA Token Management snap-in.

By default, RSA provides hardware and software tokens that require a PIN and strongly recommends that you
use PINs for all tokens. PINs provide the second factor in RSA SecurID two-factor authentication. RSA
Authentication Manager also supports authentication with tokens that do not require an RSA SecurID PIN. The
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user can authenticate with the current tokencode only. In such a case, an alternative second factor, for
example, a user’s network password, is used.

For more information on how to assign and deploy hardware and software tokens, see Deploying
RSA SecurID Tokens on page 71.

RSA SecurID Hardware Tokens
RSA SecurID hardware authenticators are available in a variety of convenient form factors.

l RSA SecurID 800 Hybrid Authenticator

The RSA SecurID Authenticator SecurID 800 is both an RSA SecurID authenticator and a USB smart card
(USB token) with a built-in reader. The two sets of electronics operate independently of each other.

When disconnected, the SecurID 800 generates and displays tokencodes used in RSA SecurID
authentication. When connected to a computer, the token serves two functions:

l For RSA SecurID authentication, users obtain their tokencodes through the supporting
middleware installed on their desktop instead of reading the number off the token.

l With the token’s smart card capabilities, users can store credentials, including multiple X.509
digital certificates, which enable authentication, digital signature, and file-encryption
applications, and Windows logon accounts.

l RSA SecurID 700 Authenticator

This hardware device easily connects to any key ring. The user simply reads the changing display
(typically every 60 seconds) and uses it as part of a dynamic and always-changing password.

l RSA SecurID 520 Authenticator

With this device, the user enters the PIN on a numeric keypad to display the passcode. RSA no longer
sells this token.

l RSA SecurID 200 Authenticator

This hardware token generates and displays a new tokencode at a predefined time interval, typically
every 60 seconds. RSA no longer sells this token.

RSA SecurID Software Tokens
RSA SecurID tokens are available in a software form-factor that you can install into an RSA SecurID software
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token application on a client workstation or a mobile device.

The RSA Authentication Manager provides a centralized administration interface for issuing RSA SecurID
software tokens to the supported device types. You can add information to software tokens such as device type,
device serial number, or token nickname using token extension fields.

For more information about the software token, see the documentation that accompanies individual RSA SecurID
software token products.

On-Demand Authentication

On-demand authentication (ODA) is a service that allows users to receive on-demand tokencodes delivered by
text message or e-mail. A tokencode is a randomly generated six- or eight-digit number. You can use ODA to
protect resources, such as an SSL-VPN, thin client, or web portal.

ODA strengthens network security by requiring users to present two factors:

l Something only the user knows (a PIN)

l Something the user has (a tokencode)

ODA is easy to deploy because it does not require extra hardware, such as physical tokens. Employees already
have and use mobile phones and e-mail accounts.

On-demand tokencodes can be used only once and expire after a specified time period, enhancing their
security.

ODA relies on Short Message Service (SMS) or e-mail to deliver the tokencode. If you choose SMS,
Authentication Manager sends the tokencode to SMS indirectly through an intermediary. You can customize SMS
delivery to use an SMS modem (not included) or a third-party aggregation service.

When a user logs on to an agent with a valid PIN, the system sends a tokencode to the user by either text
message or e-mail. The user is prompted for the tokencode to gain access to the protected resource.

If you use ODA as a primary authentication method, you must install the RSA Authentication Agent software on
the resource that you want to protect.

Note: To use SMS delivery, you must establish a relationship with an SMS provider, and integrate SMS with
RSA Authentication Manager. For a list of supported SMS providers, go to
https://community.rsa.com/community/products/rsa-ready/, and enter sms rsa securid access in the search
field.

On-Demand Authentication User Logon Example
When used as the sole authentication method, on-demand authentication (ODA) is especially suited for people
who authenticate infrequently and from a variety of locations, or for people who need network access for a short
time only, such as contractors. The following steps show how a user typically uses ODA to access a company
web portal:

1. The user opens a browser window and accesses the company web portal.

2. When prompted, the user enters a User ID and PIN.

A one-time tokencode is sent to the user’s mobile phone or e-mail account.

26 Chapter 1: RSA Authentication Manager Overview

https://community.rsa.com/community/products/rsa-ready/


RSA Authentication Manager 8.3 Administrator's Guide

3. The user enters the tokencode into the browser.

4. The user gains access to the protected resource.

Risk-Based Authentication

Risk-based authentication (RBA) identifies potentially risky or fraudulent authentication attempts by silently
analyzing user behavior and the device of origin. RBA strengthens RSA SecurID authentication and traditional
password-based authentication. If the assessed risk is unacceptable, the user is challenged to further confirm
his or her identity by using one of the following methods:

l On-demand authentication (ODA). The user must correctly enter a PIN and a one-time tokencode that is
sent to a preconfigured mobile phone number or e-mail account.

l Security questions. The user must correctly answer one or more security questions. Correct answers to
questions can be configured on the Self-Service Console or during authentication when silent collection
is enabled.

RSA Authentication Manager contains a risk engine that intelligently accumulates and assesses knowledge about
each user’s device and behavior over time. When the user attempts to authenticate, the risk engine refers to the
collected data to evaluate the risk. The risk engine then assigns an assurance level such as high, medium, or
low to the user's authentication attempt. RBA compares this to the minimum acceptable level of assurance that
you have configured. If the risk level is higher than the minimum assurance level, the user is prompted to
confirm his or her identity by answering security questions or using ODA.

Risk-Based Authentication Prevents Data Loss from Stolen Passwords
RBA allows users who are accustomed to authenticating with passwords to continue doing so with little or no
impact on their daily tasks. At the same time, RBA protects your company if passwords are stolen.

For example, consider John, a sales representative who regularly accesses the corporate SSL-VPN from his
home office. John typically authenticates with just a user name and password using the same laptop every day.
Suppose an unauthorized person steals John’s password and attempts to log on to the SSL-VPN from a different
machine and location. RBA detects that the attacker is using an unrecognized device and challenges the attacker
to confirm his identity by answering security questions. When the attacker fails the challenge, he is denied
access.

Users who are accustomed to using passwords for authentication can continue to do so while RBA works in the
background to protect sensitive company resources. The authentication experience is interrupted only if a
user’s behavior is considered unusual.

In most cases, the typical user simply enters a password, as shown in the following steps:

1. The user opens a browser window and accesses the company web portal.

2. The user enters a password.

3. The user gains access to the protected resource.

After the password is entered, Authentication Manager analyzes the user’s risk level to determine if the user’s
behavior and device are found to deviate from past attempts. Users who are considered suspicious or high risk
are prompted to confirm their identity by performing these steps:
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1. If the user is configured for more than one identity confirmation method, the user is prompted to choose
either on-demand authentication (ODA) or security questions.

2. If the user selects ODA, the user enters a PIN. Authentication Manager Express sends a tokencode to the
user by e-mail or SMS. The user enters the tokencode and is authenticated.

If the user selects security questions, the user is prompted to answer predefined questions. If
successful, the user is authenticated.

How Risk-Based Authentication Works
Risk-based authentication (RBA) intelligently assesses authentication risk for each user and accumulates
knowledge about each user’s device and behavior over time to determine if an authentication attempt is
legitimate. RBA has the following features:

l Data Collection. RBA requires a learning period during which it builds up a profile of user devices and
user behavior. After the initial learning period has expired, RBA continues to learn from the behavior of
the user population and regularly customizes its risk model to adjust its definitions of “normal” and
“abnormal” for your deployment.

l Device Registration. The first time a user successfully authenticates from a device, RBA records
characteristics about the device in the user’s device history and thus registers the device to the user. A
registered device is one that Authentication Manager Express recognizes and that the user has
previously used for authentication.

l Device Matching. During authentication, RBA examines the characteristics of the user’s laptop or
desktop computer and compares them with a list of previously used devices, in an attempt to find a close
match.

l Assurance Level. RBA uses the device characteristics and user behavior to calculate an assurance level,
which is the likelihood that the access attempt is being made by a legitimate user. When the user
attempts to authenticate, RBA refers to its collected data to evaluate the risk and then assigns an
assurance level such as high, medium, or low to the user's authentication attempt.
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About the Security Console

Authentication Manager includes an administrative user interface called the Security Console.

The following figure shows the Home page of the Security Console.

You use the Security Console for most day-to-day administrative activities, and for some setup and
configuration tasks. For example, you use the Security Console to:

l Add and manage users and user groups

l Add and manage administrators

l Assign and manage RSA SecurID tokens

l Enable and disable users for risk-based authentication or on-demand authentication

l Add and manage security policies

l Add and manage authentication agents

l Designate which network resources you want to protect

During Authentication Manager Quick Setup, you define the User ID and password for the Security Console
Super Admin account. The Super Admin permissions mean that this account can perform all tasks within
Authentication Manager.

You also specify the initial User ID and password for the RSA Operations Console during Quick Setup. If you
change the User ID or password for either the Security Console or the Operations Console in the future, the User
ID and password for the other Console remains unchanged. These are separate accounts.

Log On to the Security Console

If this is the first logon after Authentication Manager Quick Setup, use the User ID and password provided
during setup. If this is not the first logon, enter the credentials required by the Security Console.

You must log on to the Security Console in order to complete administrative tasks.
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Note: Do not use the back button for your Internet browser to return to previously visited Console pages.
Instead, use the Security Console navigation menus and buttons to navigate.

Procedure

To log on to the Security Console, open a supported web browser, and enter one of the following URLs:

https://fully qualified domain name

https://fully qualified domain name:/sc

https://fully qualified domain name:7004/console-ims

If the Security Console is protected with RSA SecurID, the SecurID PIN is not case sensitive.

Security Console Protection

By default, an administrator can use an RSA password or an LDAP password to access the Security Console. To
use an LDAP password for this purpose, the administrator’s identity source must be an LDAP directory server.

For additional security, you can configure Authentication Manager to require administrators to present an RSA
SecurID passcode before they can access the Security Console.

You can change the default settings by configuring one or more of the following authentication methods:

l RSA password

l LDAP password

l RSA SecurID passcode

Presenting a SecurID passcode before being allowed access ensures that the Security Console is protected by
the same two-factor authentication that protects your network resources. If the Security Console is protected
with a SecurID passcode, the SecurID PIN is not case sensitive.

When you first enable a new Security Console authentication method, RSA recommends that you also continue to
allow administrators to authenticate with the previous method for a period of time. This gives you time to ensure
that all administrators can authenticate with the new method before you discontinue the previous method.

Configure Security Console Authentication Methods

Use this procedure to configure the authentication method an administrator must use to access the Security
Console. For example, you can add security by requiring administrators to present an RSA SecurID passcode
before they can access the Security Console.

Procedure

1. In the Security Console, click Setup > System Settings.

2. Under Console & Session Settings, click Security Console Authentication Methods.

3. In the Console Authentication field, enter the authentication method(s) that administrators must use
to log on to the Security Console. If you enter multiple authentication methods, use an available operator
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to create a valid expression. For example:

l To require an RSA password or LDAP password, enter RSA_Password/LDAP_Password.

l To require both an RSA SecurID passcode and LDAP password, enter SecurID_Native+LDAP_
Password.

l To require an RSA password, enter RSA_Password.

l To require an LDAP password, enter LDAP_Password.

l To require an RSA SecurID passcode, enter SecurID_Native.

If you enter an authentication method that is stronger than the current method, you are logged off and
must authenticate with the new credential. For instance, if the original method was RSA_
Password/LDAP_Password and you enter (RSA_Password/LDAP_Password)+SecurID_Native,
you are logged off from the Security Console and must authenticate with an RSA Password or an LDAP
Password, and an SecurID passcode. If you enter a method that is not stronger than the current method,
the change only affects new authentication attempts.

4. (Optional) For Non-Unique User IDs, select Identical User IDs may exist in more than one
identity source if you want to allow the same User ID to exist in more than one identity source. This
can be useful if you have multiple identity sources that contain names for different types of users.

Suppose that you have one identity source for employees and one for clients. This option allows identical
User IDs that exist in both identity sources to be managed by the system, for example, if you have an
employee with the User ID jsmith and a customer with the User ID jsmith.

5. (Optional) For LDAP Password, select Enable LDAP Password authentication method to enable
the LDAP password as an authentication method.

6. Click Save.

7. Select Yes, update authentication methods.

8. Click Update Authentication Methods.

Security Domain Overview

Security domains represent areas of administrative responsibility. All Authentication Manager objects are
managed by, and belong to, a security domain. Security domains allow you to:

l Organize and manage users.

l Enforce system policies.

l Limit the scope of administrators’ control by limiting the security domains to which they have access.

When you set up Authentication Manager a top-level security domain is automatically created. You cannot edit
the name of the top-level security domain. By default, an installation of Authentication Manager supports up to
1,000 security domains.

User Organization and Management
When you create a security domain, it is nested within a parent security domain. You can nest the security
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domains to create an administrative hierarchy. Organizing users in security domains also helps you find users
and assign them tokens or add them to user groups. For example, you can search for all users in the Boston
security domain and then assign a token to each member. Each user can exist in only one security domain.

By default, all users from an external LDAP identity source are added to the top-level security domain. You can
use the Security Console to move these users to a lower-level security domain manually or you can configure
domain mapping to add these users to a specific security domain. Make sure your mappings are in place before
you manage users, so that you do not have to move users between security domains later. For more information,
see the Help topic "Move Users Between Security Domains."

Users created in the internal database using the Security Console are created in the security domain to which
the administrator has access.

Policy Enforcement
Authentication Manager uses security domains to enforce system policies. Policies control various aspects of a
user’s interaction with Authentication Manager, such as password lifetime, length, format, frequency of
change, and number of unsuccessful authentication attempts. Authentication Manager enforces authentication
policies at the security domain level, so consider grouping users subject to the same policies together in the
same domain. For information on the policies that are assigned to security domains, see the Help topic
"RSA Authentication Manager Policies."

Authentication Manager provides a default of each policy type and assigns them to each new security domain.
You can accept the default policies or create custom policies. If you designate a custom policy as the default,
that policy will be used for all new security domains and for all existing security domains that are configured to
use the existing default policy.

Lower-level security domain do not inherit policies from upper-level security domains. New security domains
are assigned the default policy regardless of which policy is assigned to security domains above them in the
hierarchy. For example, if the top-level security domain is assigned a custom policy, lower-level security
domains are still assigned the default policy.

Scope of Administrator’s Control
By default, all SecurID tokens are managed in the top-level security domain. You can use the Security Console to
transfer tokens from the top-level security domain to other security domains within the deployment.

Know the following about security domains:

l Security domains are organized in a hierarchy.

l Security domains are often created to mirror the departmental structure or the geographic locations of
an organization.

For example, you can create separate security domains for each department, such as Finance, Research and
Development (R&D), and Human Resources (HR), and then move users and user groups from each department
into the corresponding security domain. To manage users in a given security domain, an administrator must
have permission to manage that security domain.

In addition to making it easier to manager users, security domains allow you to limit the scope of an
administrator’s permissions. For example, suppose you have security domains named Boston, New York, and
San Jose. When you set the administrative scope for your administrative roles, you might choose to limit the role
to only the Boston security domain. This means that the administrator assigned that role only has permission to
manage the Boston security domain, and not the New York and San Jose security domains.

An arrangement such as this allows you greater control over administrators. You can limit administrators by
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department, geographic location, or in any other way that you choose. Hierarchies also give administrators more
flexible control over users and their access rights and restrictions.

Add a Security Domain

A security domain defines an area of management responsibility, typically corresponding to a company’s
internal business units, departments, and so on. A security domain represents a single unit in an organizational
hierarchy. You build the hierarchy by creating relationships between security domains. You can create up to
1,000 security domains.

Before you begin

l Learn about the custom and default policies available. For more information, see the Help topic "RSA
Authentication Manager Policies."

l Follow these guidelines:

l To use the default policy, select Always Use Default from the drop-down list. The default
policy is automatically applied to the security domain.

l To use a custom policy, select a policy name from the drop-down list. This policy applies to that
security domain until you explicitly change it.

l When you apply a policy that is also the default policy, that policy remains assigned to the
security domain even if you change the default policy. To use the default policy, you must
explicitly specify Always Use Default.

Procedure

1. In the Security Console, click Administration > Security Domains > Add New.

2. In the Security Domain Name field, enter a unique name. Do not exceed 100 characters.

3. From the Parent drop-down list, select the parent security domain of the new security domain. The
parent security domain is the security domain in which you want the new security domain to exist.

4. From the Password Policy drop-down list, select the password policy of the new security domain.
Password policies enforce rules such as the required length of passwords, characters, and restricted
words.

5. From the Lockout Policy drop-down list, select the lockout policy that you want to assign to the new
security domain. Lockout policies lock out users after a designated number of consecutive unsuccessful
logon attempts within a specified time period. Locked out users cannot authenticate.

6. From the Self-Service Troubleshooting Policy drop-down list, select a policy for the new security
domain. This policy controls how users log on to the Self-Service Console if they cannot authenticate
using primary methods such as passwords or passcodes.

7. From the Risk-Based Authentication (RBA) Policy drop-down list, select a policy for the new
security domain. RBA policies include the minimum assurance level that is required for logon and the
identity confirmation methods that are allowed when an authentication attempt does not meet the
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minimum assurance level.

8. From the SecurID Token Policy drop-down list, assign a SecurID token policy to the security domain.
Token policies determine RSA SecurID PIN lifetime and format, and fixed passcode lifetime and format.
The token policy also determines how to handle users or unauthorized people who enter a series of
incorrect passcodes.

9. From theOffline Authentication Policy drop-down list, select an offline authentication policy for the
security domain. Offline authentication policies define how users authenticate when they are not
connected to the network.

10. (Optional) From theWorkflow Policies drop-down list, select a workflow policy for the security
domain. Workflow policies specify who receives e-mail, workflow definitions, the number of approval
and distribution steps, and e-mail notifications for requests made through the Self-Service Console.

11. From the Risk-Based Authentication (RBA) Message Policy drop-down list, select a policy for the
new security domain. This policy defines the message that users receive when they are challenged to
configure their identity confirmation method.

12. Click Save.

Administrative Role Overview

Administrators manage all aspects of your deployment, such as users, tokens, and security domains. Each
administrator is assigned an administrative role that has its own set of administrative privileges and areas of
responsibility.

Administrative roles control what an administrator can manage. When an administrative role is assigned to a
user, the user becomes an administrator.

Types of Administrative Roles
There are two types of administrative roles:

l Predefined roles.Authentication Manager provides predefined roles. You can assign predefined roles
in their default form, or you can edit the permissions for each role.

For example, if you do not want administrators with the Help Desk role to view authentication agents, you
can use the Security Console to remove that permission from the role.

l Custom roles. You can create custom roles with different privileges and areas of administrative
responsibility, depending on your organization’s needs.

For example, suppose your organizational hierarchy is divided into three security domains: HR, R&D,
and Finance. Because financial data is sensitive, you might create a custom administrator who can run
and view finance reports in the Finance security domain.

Administrative Role Assignment
After you have decided which roles you need for your deployment, and added any custom roles you require, you
can assign the roles to administrators.

Know the following about assigning administrative roles:
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l You can assign administrative roles to any user in your identity source. You will probably only assign
administrative roles to members of your information technology (IT) organization and possibly a few
other trusted individuals in your organization.

l When you assign a role to a user, the user becomes an Authentication Manager administrator and can
use the Security Console to administer the deployment.

l When you assign a role to an administrator, the administrator is then able to perform the administrative
actions specified by the role in the security domains specified by the scope of the role.

l You can only assign administrative roles with privileges equal to or less than those of your own role. That
is, you cannot assign privileges that you do not have. For example, if your administrative role only allows
you to add, edit, and delete users, and create and assign administrative roles, you cannot assign a role
that enables users to receive on-demand tokencodes.

l You cannot edit an administrative role that has more permissions than your role.

l You can assign more than one role to an administrator. When you do this, the administrator can only
perform administrative actions in a security domain that is included in the scope of the role that grants
the permission.

For example, suppose an administrator has one role that grants him permission to manage users in the
San Jose security domain, and another role that grants him permission to manage authenticators in the
New York security domain. In the Security Console, the administrator is allowed to manage users in the
San Jose security domain, but not the New York security domain, so users in the New York security
domain are not visible to the administrator. The same rule applies to authenticators. The administrator
can manage and view authenticators in the New York security domain only.

l Be sure to assign roles that grant only enough permissions and include a scope just broad enough to
accomplish their tasks. Avoid granting administrative roles to administrators who do not need them.

For example, if an administrator’s job only requires him to administer users in the Boston security
domain, avoid including the San Jose and New York security domains in the scope of his role.

Administrative Role Components
An administrative role has two components:

l Permissions based on the function of the role

l The Scope (security domains and identity sources) in which the permissions can be applied

Permissions
The permissions in an administrative role determine the actions that an administrator can take on objects such
as users, user groups, security domains, and policies. Be sure to assign permissions that allow administrators
to manage all of the objects that are needed to accomplish their assigned tasks, but do not assign permissions
that are not necessary.

You can modify the permissions to manage the following areas:

l Role basics

l Security domain administration
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l Delegated administration

l Users

l User groups

l Reports

l RSA SecurID tokens

l User authentication attributes

l Authentication agents

l Trusted realms

l RADIUS

l On-demand tokencodes

l Provision requests

The following permissions are available for all objects in your deployment:

l All. Perform any administrative action on the object.

l Delete. Delete an object.

l Add. Add an object.

l Edit. View and edit an object, but not to add or delete.

l View. View an object, but not to add, edit, or delete.

You can expand or reduce the scope of an administrator’s role by modifying permissions. For example, assume
that you are the Super Admin for FocalView Software Company. The administrator in your Boston office has a
role that limits him to assigning and managing authenticators. You want the administrator to also manage
agents. You can modify the administrator’s current role instead of creating a new one.

These actions give the administrator permission within the Boston security domain and any of Boston’s lower-
level security domains, if applicable. If the administrative scope only includes the Boston security domain, the
administrator can only manage the objects, users, authenticators, and agents, for example, belonging to that
domain.

Suppose that multiple administrators have the role that manages authenticators. If you modify the role so that
one of the administrators can also manage agents, all administrators with that role can also manage agents. In
this case, you may want to create a new role for the one administrator whomanages both authenticators and
agents.

Another option is to create a second role that allows agent management and then assign the role to the
administrator. In this case, the administrator would have two assigned roles.

For example, if an administrator’s only task is assigning tokens to users, you would probably assign the
following permissions to the role:
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l View users

l View tokens

l Assign tokens to users

l Issue assigned software tokens

l Replace assigned tokens

l Import tokens (optional)

l Enable and disable tokens (optional)

The optional permissions above slightly expand the administrative role to complement the stated task of
assigning tokens to users. You would not, however, assign the permissions to add and delete users,
resynchronize tokens, or manage emergency offline authentication, as they are not related to the stated task of
assigning tokens to users.

Permissions Required to Create Administrative Roles and Delegate Per-
missions
An administrator who creates a new administrative role must have the following permissions associated with
their role:

l Permission to create administrative roles.

l The same permissions that he or she wants to add to the new administrative role.

l Permission to delegate the permissions granted to his or her role. This is determined by the Permission
Delegation setting for the role assigned to the administrator who is creating the new role.

l Permission to manage the security domain that is associated with the new role.

When you assign permissions to a role, make sure the administrator has all the permissions necessary to
perform assigned tasks. For example:

l An administrator who assigns tokens to user must have permission to view and assign tokens, and view
users.

l An administrator who resets user passwords must have permission to reset passwords and view user
records.

l An administrator who assigns administrative roles to users must have permission to assign roles and
view user records.

l An administrator who assigns users to user groups must have permission to assign users to user
groups and view user records.

You can delegate permissions to other administrators if your role permits you to create or assign existing roles
to other users.

For instructions on selecting Permission Delegation, see the Help topic "Duplicate an Administrative Role."

Permission Limits for Managing Identity Attribute Definitions
You can limit what permissions an administrative role grants to manage specific custom-defined identity
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attribute definitions. For any identity attribute definition, an administrative role can grant Modify, View, and
None permissions.

For more information, see User Attributes on page 66.

You can set permissions for specific identity attribute definitions on the Permissions page when you add or edit
an administrative role.

For more information, see the Help topics "Duplicate an Administrative Role" and "Edit Permissions for an
Administrative Role." 

Scope
The scope of an administrative role determines in what security domains an administrator may manage objects
and from what identity sources an administrator may manage users and user groups.

For more information, see the Help topic "Security Domains."

Be sure to assign a scope broad enough so that the administrator can access the necessary security domains
and identity sources. However, avoid assigning a scope that grants access to security domains and identity
sources where the administrator has no responsibilities.

Also, avoid creating situations in which an administrator can view and manage a certain user group, but cannot
at least view all the users in that user group. This happens when a user group from a security domain within the
administrator’s scope contains users from a security domain outside the administrator’s scope. When the
administrator views the user group members, he or she only sees the members from the security domain within
his or her scope. This creates a situation in which administrators may take action on a group, for example,
granting a group access to a restricted agent, without being aware of all the users affected. This can result in
users being granted privileges that they should not have.

To avoid this situation, follow these guidelines:

l Allow all administrators to at least have view permission on all users in all security domains. This
ensures that there are no cases where administrators are unaware of any members of a group they are
administering.

l Make sure that a user group and all members of the user group are in the same security domain. This
ensures that administrators who have permissions to view user groups and to view users are able to see
all member users.

l If you want the administrator to run reports on the viewable information, grant the appropriate
permission. Some reports require more than view permission.

Know the following about scoping administrative roles:

l When the scope of an administrative role is defined most broadly, the role can manage the security
domain where the role definition was saved and all of the lower-level security domains beneath it.

l An administrative role that manages an upper-level security domain always manages the lower-level
security domains beneath it.

l You can limit the scope of an administrative role to specific security domains, as long as those security
domains are at or below the security domain that is associated with the role. An administrative role can
only manage down the security domain hierarchy, never up.

l The security domain where you save the administrative role impacts the scope of the role. For example,
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suppose the top-level security domain is Boston, and the lower-level security domains are named New
York and San Jose. If you save an administrative role to the New York security domain, administrators
with that role can only manage objects in the New York security domain and in lower-level security
domains within the New York security domain. Administrators with that role cannot manage objects in
the Boston or San Jose security domains.

You can save the Super Admin role in the top-level security domain, and then save all other
administrative roles in a lower-level security domain. This prevents lower-level administrators, for
example, Help Desk Administrators, from editing the Super Admin’s password and then using the Super
Admin’s password to access the Security Console.

Scope Example
For example, consider the following hierarchy.

l An administrative role saved in the top-level security domain can be scoped to manage any security
domain in the deployment. For example, it can manage only security domain F, or every security domain.

l An administrative role saved in security domain A can be defined to manage security domain A and all
the lower-level security domains below it.

l An administrative role saved in security domain C can be defined to manage E, or both C and E.

l An administrative role saved in security domain E can be defined to manage only security domain E.

An administrative role can be defined so that it manages only users or user groups within a particular
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administrative scope whomatch certain criteria. These are called attribute-based roles. For example, if you have
defined an identity attribute definition for location, an administrative role can manage all users in security
domain A and down the hierarchy (C, D, E, and F).

You can also create a role that only allows an administrator to edit specified custom user identity attribute
definitions. You configure permissions to a specific identity attribute definition as part of the role’s permissions.

For a given attribute, the role can specify one of the following access permissions:

l None

l Read-Only

l Modify

Add an Administrative Role

An administrative role is a collection of permissions that can be assigned to an administrator. A role determines
what level of control the administrator has over users, user groups, and so on.

You can add administrative roles to your deployment, and assign these roles to users. If you assign multiple
administrative roles to a user, the permissions are combined.

Before you begin

To create an administrative role, you must have an administrative role that:

l Grants permission to create administrative roles.

l Includes the permissions he or she wants to add to the new administrative role.

l Allows the administrator to delegate the permissions granted to his or her role. This is determined by the
Permission Delegation setting for the role assigned to the administrator who is creating the role.

Procedure

1. In the Security Console, click Administration > Administrative Roles > Add New.

2. In the Administrative Role Name field, enter a name for the new administrative role.

3. (Optional) If you want to allow administrators to delegate their role permissions to other administrators,
select Permission Delegation.

4. In the Security Domain Scope tree, select the security domains in which the new administrative role
grants permissions.

By default, selecting a security domain automatically includes the subdomains. You can clear the
Automatically include subdomains checkbox, and only assign the administrative role to the security
domains that you select.

5. In the Identity Source Scope field, select the identity sources where you want this administrative role
to grant permissions.

6. ClickNext.
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7. Assign general permissions to the administrative role.

8. (Optional) To restrict attributes, in the User Attribute Restriction field, selectMay only access
specific attributes. An Attributes drop-down menu appears. SelectModify, View, or None for each
attribute. If you select None, the attribute is hidden.

The value in this field must be consistent with the value specified in the Entry Type field on the Add an
Identity Attribute Definition page. If the attribute definition is read-only, do not select Modify for the User
Attribute Restriction. If the attribute definition is required, do not specify View or None in the User
Attribute Restriction. If you do, you cannot add the role.

9. ClickNext.

10. Assign authentication permissions to the administrative role.

11. ClickNext.

12. Assign self-service permissions to the administrative role.

13. ClickNext.

14. Use the Security Domain drop-down menu to select the security domain that is associated with the
administrative role.

15. Review the summary of the administrative role, and click Save.

Assign an Administrative Role

You can assign an administrative role to a user so that the user can perform specified actions in a designated
security domain. A user can have more than one administrative role.

Follow these guidelines:

l You can only assign and add administrative roles with the same or a narrower scope, and that have
equal or fewer permissions to your own administrative role.

l You can assign administrative roles to a single user at a time or to multiple users at the same time.

If a password is required to access the Security Console, administrators use the password assigned to them in
their user record.

Procedure

1. In the Security Console, click Administration > Administrative Roles > Manage Existing.

2. Use the search fields to find the administrative role that you want to assign.

3. Click the administrative role that you want to assign.

4. From the context menu, click Assign More.

5. Use the search fields to find the user that you want to assign to the administrative role.
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User searches are case sensitive.

6. Select the user that you want to assign to the administrative role, and click Assign to Role.

View Available Permissions of an Administrator

Under some configurations, a lower-privileged administrator, for example, an administrator assigned the
default Help Desk Administrator role, may be able to modify the account of a higher-privileged administrator. To
audit the permissions assigned to administrators and verify that lower-privileged administrators do not have
permissions that allow them to modify the accounts of higher-privileged administrators, use the following
procedure.

Before you begin

You must be a Super Admin.

Procedure

1. In the Security Console, click Identity > Users.

2. Use the search fields to find Administrators.

3. Click the name of the administrator and select Available Permissions from the context menu.

The user's assigned administrative roles are displayed. For each role, the following information displays:

Security Domain. The security domain of the administrators who are allowed to manage the assigned
role.

Security Domain Scope. The scope of the administrator's role, i.e., where the administrator can
perform the tasks for this administrative role.

Identity Source Scope. The identity sources the administrator may access, if her administrative role
includes managing users or user groups.

Permission Delegation. Whether the assigned administrator can create new administrative roles that
include this role's permissions.

Administrative Tasks and Permissions. The permissions the administrator has to modify objects in
the system, for example, permission to add users, or just view them.

After you finish

If you find that an administrator has scope or permissions that give more privileges than appropriate, you can
do the following:

l Add or remove roles from the set of roles assigned to the administrator. For more information, see
Assign an Administrative Role on the previous page.

l Edit one or more of the administrator’s roles to change the scope, set of permissions or both that role
includes. This affects all administrators assigned the role. For more information, see the Help topic "Edit
an Administrative Role."

l Create a new role having the correct scope and the exact set of permissions required, and assign it to
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the administrator. You can create a new role or duplicate an existing role and modify it. For more
information, see Add an Administrative Role on page 41.

Administrative Role Scope and Permissions

The pre-defined administrative roles configured during Authentication Manager setup have scope over the top-
level security domain by default. As a result, an administrator who is assigned to a pre-defined role can modify
the account of a Super Admin, because the initial Super Admin account resides in the top-level security domain
as well. This is because the top-level security domain is the only security domain in the deployment when
Authentication Manager is initially set up.

Before assigning a pre-defined role to an administrator, consider whether you want to maintain the default
behavior, or if you want to restrict the scope of the administrators assigned these roles to a lower-level security
domain that does not include Super Admins or other higher-privileged administrators. There may be situations
in which you want a lower-privileged administrator to modify the account of a higher-privileged administrator.

For existing deployments, you can use the Security Console to audit the permissions available to an
administrator. For instructions, see View Available Permissions of an Administrator on the previous page.

If you do not want to use the default scope of the pre-defined administrative roles, you can avoid unintentionally
granting additional privileges to an administrator by doing one of the following:

l Make sure that the scope of the administrator does not include the following:
l A security domain that contains the user account or token of a higher-privileged administrator.

l The security domain that contains the administrator’s own token so that the administrator cannot
modify his own token or other credentials to provide additional privileges to his account.

l The administrator’s own security domain so that the administrator cannot modify his own
account.

l Create separate security domains to enforce your intended administrative scopes. For example, create
one for Super Admins, one for other administrators, and one for users with no administrative role.
Reduce the scope of the lower-privileged administrators to the security domains of users with no
administrative role.
Configure Authentication Manager according the following model:

l Create a distinct security domain for Super Admins.

l Place all other administrators, including those who have permission to edit users or
authentication credentials, in lower-level domains.

l Place all other users in another security domain.

l Assign the appropriate role and scope to administrators. Make the lower-privileged
administrator’s scope include only the security domain over which the administrator has
authority. For example, make sure that the Help Desk administrator has scope only for the
security domain of end users, and not for his own security domain or the security domain of the
Super Admin. For instructions, see the Help topic “Change the Scope of an Administrative Role.”

If you do want to allow administrators to manage the accounts of higher-privileged administrators, there are a
number of ways you can configure your system to do this.

l Make sure that the lower-privileged administrator does not have permission to edit the following account
settings of the higher-privileged administrator, by removing permissions from the lower level account to
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edit authentication data of the higher level account, such as:
l The credential that is required to authenticate to the Security Console, for example, the user
password of a Super Admin

l Security questions

l LDAP password

l RSA Password

l Assigned SecurID tokens

l The ability to administer other users, including the ability to clear PINs, assign SecurID tokens
and enable on-demand authentication

Note: Make sure that the administrative role assigned to the administrator does not include tasks that are not
required for the administrator to perform his job. For more information, see the Help topic “Edit Permissions for
an Administrative Role.”

l If you do not use the Self-Service Console or risk-based authentication in your deployment, do the
following:

l Remove the Reset Password permission from the Help Desk administrator who is helping end
users.

l Assign the Assign Token and Reset Password permissions to an administrator other than the
Help Desk administrator.

l Configure Authentication Manager to require a combination of authentication credentials. If
Authentication Manager requires multiple credentials, for example an on-demand tokencode and a
password, at least one of which the lower-privileged administrator does not have permission to edit, the
lower-privileged administrator cannot fully control the higher-privileged administrator’s authentication
credentials and authenticate to the Security Console or Operations Console as the higher level
administrator.
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RSA Authentication Manager Identity Sources

An identity source is a repository that contains user and user group data. Each user and user group in a
deployment is associated with an identity source.

Authentication Manager supports the following as identity sources:

l An LDAP directory

Authentication Manager supports the following directories as identity sources:

l Microsoft Active Directory 2008 R2

l Microsoft Active Directory 2012

l Microsoft Active Directory 2012 R2

l Microsoft Active Directory Lightweight Directory Services 2012 R2

l Microsoft Active Directory 2016

l Sun Java System Directory Server 7.0

l Oracle Directory Server Enterprise Edition 11g

l OpenLDAP 2.4.40

In Active Directory, you can add a Global Catalog as an identity source, when some or all of the Active
Directory servers in the Active Directory forest are used as identity sources. In such a case, you can use
the Global Catalog for runtime activities, such as looking up and identifying users and resolving group
membership within the Active Directory forest. You cannot use a Global Catalog identity source to
perform administrative tasks.

Note: Authentication Manager supports Active Directory Lightweight Directory Services (LDS) servers if
the same server does not also have an Active Directory Domain Controller role. If a server has an Active
Directory Domain Controller role, select that identity source type when connecting the identity source to
Authentication Manager.

l The Authentication Manager internal database

Data from an LDAP Directory
Authentication Manager has read-only access to all LDAP directory identity sources. After a directory is
integrated with Authentication Manager, you can use the Security Console to do the following:

l View (but not add or modify) user and user group data that resides in the directory.

l Perform Authentication Manager administrative tasks. For example, enable or disable the use of on-
demand authentication (ODA) and risk-based authentication (RBA), or assign tokens or user aliasesto
individual users who reside in the directory.

You must use the LDAP directory native user interface to modify data in a directory.

Data from the Internal Database
Authentication Manager provides an internal database where you can create users and user groups. For users
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and user groups in the internal database, administrators can use the Security Console to do the following:

l Add, modify, and view user and user group data.

l Enable or disable Authentication Manager functions, such as ODA and RBA, for individual users,
including users whose accounts are in an LDAP directory.

The following information is stored only in the internal database:

l Data that is specific to Authentication Manager, such as policies for administrative roles, and records for
authentication agents and SecurID authenticators

l Data that links Authentication Manager with LDAP directory user and user group records

Identity Source Data Flow
The following figure shows how data elements (LDAP attributes and Authentication Manager attributes) may be
distributed across external identity sources and the internal database. The figure also shows connections
between Authentication Manager and LDAP external identity sources.

1. Authentication Manager communicates with the LDAP directory by using the LDAP administrator user
name and password.
If the administrator account is set to read/write access, end users may update their own passwords,
responding directly to password renewal prompts received through Authentication Manager Express. If
access is read-only, the users must contact their administrator for password updates.

2. The internal database contains a reference to every user’s distinguished name and unique identifier to
locate user records in the LDAP directory. It also contains user attributes defining properties that are
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specific to Authentication Manager, such as an on-demand PIN, security questions, and a user account
enabled or disabled parameter.

3. Your directory servers may already contain typical LDAP user records and attributes. Authentication
Manager can work with more than one directory server.

Identity Source Properties
You specify identity source properties when you add or edit an identity source. The Operations Console
organizes the identity source properties in categories.

l Identity Source Basics below

l Directory Connection - Primary and Replica below

l Directory Settings on the facing page

l Active Directory Options on page 52

l Directory Configuration - User Tracking Attributes on page 52

l Directory Configuration - Users on page 53

l Directory Configuration - User Groups on page 53

Identity Source Basics

Identity Source Name. Unique name for the identity source. This name is displayed in the Security Console to
identify the identity source.

Type. The type of identity source. For example, an LDAP identity source type can be Microsoft Active Directory,
Microsoft Active Directory Lightweight Directory Services, Oracle Directory Server, Sun Java System Directory
Server, or OpenLDAP. After an identity source is added to the deployment, you cannot change the identity
source type. For the supported list of identity sources, see the Help topic "View the Identity Sources in Your
Deployment."

Notes. You can use up to 255 characters of text to add a note about the identity source.

Directory Connection - Primary and Replica

Directory URL. The URL of the new identity source. If you use the standard SSL-LDAP port 636, specify the
value as ldaps://hostname/. For all other ports, you must specify the port number, for example,
ldaps://hostname:port/.

Note: An SSL connection is required for password management.

For Active Directory, the Global Catalog can have the same directory URL as another identity source that is not a
Global Catalog.

Directory Failover URL. (Optional) The failover directory server is used if the connection with the primary
directory server fails. The failover directory server must be a mirror of the primary directory server.

If you want to permit users to change their passwords during authentication, the LDAP directory administrator
account must have write privilege for user records in the identity source. If you do not permit password
changes, the directory administrator account does not need write privileges.

Directory User ID. The LDAP directory administrator's User ID.

For example, you might enter cn=Administrator,cn=Users,dc=domain,dc=com or Administrator@domain.com.
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Directory Password. The LDAP directory administrator's password.

Make sure that this password is kept up-to-date. If this password expires, the connection fails.

Directory Settings

Use directory settings to narrow the scope of an identity source so that only a subset of the identity source is
used. For more information, see Identity Source Scope on page 54.

If you narrow the scope of an identity source, you must schedule a cleanup job to remove references to
unresolvable users and user groups from the internal database. For more information, see the Help topic
"Schedule a Cleanup Job."

User Base DN. The base DN for directory user definitions. For example, for Active Directory, you might enter
cn=Users, dc=domainName, dc=com.

User Group Base DN. The base DN for directory user group definitions. For example, for Active Directory, you
might enter ou=Groups, dc=domain, dc=com.

It is important to follow these practices:

l Do not configure multiple identity sources with overlapping scope. If you have multiple identity sources
that point to the same User Base DN or User Group Base DN, ensure that the User Search Filter and User
Group Search Filter are configured so that each user and user group appears only in one identity source.
Improper configuration may result in unresolvable users and authentication problems.

l If an attribute value contains a comma or an equal sign, you must escape these characters with a
backslash. For example, if the attribute ou has the value of A=B, Inc, you must write this out as
ou=A\=B\, Inc. If you do not escape these characters in an attribute value, the connection to the identity
source fails. This only applies to commas or equal signs used in an attribute value. Do not escape
commas separating elements of a distinguished name, for example, cn=Joe Smith, ou=Sales, or equal
signs between a moniker and its attribute value, for example, ou=Sales.

l The default organizational unit “Groups” does not exist in the default Active Directory installation. Make
sure you specify a valid container for the User Group Base DN.

Search Results Time-out. Limits how long a search will continue. If searches for users or groups are timing
out on the directory server, either extend this time, or narrow individual search results. For example, instead of
Last Name = *, use Last Name = G*.

User Account Enabled State. Specify where RSA Authentication Manager looks for the enabled/disabled state
of user accounts.

l Select Directory to look in the external identity source only.

If the user account is disabled in the external identity source, the user cannot authenticate. The ability of
the user to authenticate is based solely on the User Account Enabled State in the external identity
source.

l Select Directory and Internal Database to look in the internal database in addition to the external
identity source.

The user account must be enabled in both the internal database and the external identity source for the
user to authenticate. If the user account is disabled in either the internal database or the external
identity source, the user cannot authenticate.
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Validate Map Against Schema. Validates identity attribute definition mappings to the directory schema when
identity attribute definitions are created or modified.

Note: Do not turn on schema validation for an OpenLDAP directory identity source.

Active Directory Options

Global Catalog. Select this if the identity source is an Active Directory Global Catalog.

User Authentication. Select one of the following as the source for user authentication:

l Authenticate users to this identity source. Select this option if the identity source is not associated
with a Global Catalog. If no Global Catalogs are configured as identity sources, this option is selected
automatically.

l Authenticate users to a global catalog. Select this option if the identity source is associated with a
Global Catalog, and select a Global Catalog from the drop-down menu.

Directory Configuration - User Tracking Attributes

User ID. Select one of the following to map the User ID:

l Maps to. Select this option to map the User ID to a specified attribute.

l Uses the same mapping as E-mail. Select this option to map the User ID to the e-mail attribute. If
you choose this option, the User ID and e-mail fields have the same value. The e-mail attribute must
already be defined in the directory.

When you change the User ID mapping, make sure that the new field is unique for all users and does not
overlap with the old field. This prevents administrative data from being associated with the wrong user records
for some users. For example, if the old mapping has the User ID “jdoe,” the new mapping should not contain the
User ID “jdoe.” To ensure a smooth transition from the old User ID mapping to the new, you need to clean up
unresolvable users to update the internal user records with the new User IDs. Perform this task immediately
after you change the mapping. For more information, see the Help topic "Schedule a Cleanup Job."

Unique Identifier. A unique identifier to help the Security Console find users whose DNs have changed.

The following table lists the recommended default value for the Unique Identifier for each supported LDAP
directory identity source.

LDAP Directory Identity Source Unique Identifier Default Value

Microsoft Active Directory ObjectGUID

Sun Java System Directory Server nsUniqueID

Oracle Directory Server nsUniqueID

OpenLDAP entryUUID

You must specify the Unique Identifier before you move or rename LDAP directory users who are viewed or
managed through the Security Console. Otherwise, the system creates a duplicate record for the users that you
move or rename, and disassociates them from data the system has stored for them.

Enter an attribute from your directory that meets these requirements:

l The attribute must contain unique data for each user. For example, an employee ID number or badge
number that is unique for each user in the deployment.

l The attribute must contain data for each user. The value cannot be empty.
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l The attribute value cannot change. If the value for a user changes, Authentication Manager cannot track
the user. You cannot map any other fields to the attribute that you map to the Unique Identifier.

l The attribute name can contain up to 64 characters.

l The attribute value can contain up to 42 characters.

Note: RSA does not recommend using the default value if you are using third-party directory management tools
that handle moving users from one DN to another by deleting the users and adding them back to the directory.

Directory Configuration - Users

First Name. The directory attribute that maps to the first name attribute. By default, First Namemaps to
“givenName.”

Middle Name. The directory attribute that maps to the middle name attribute. By default, Middle Namemaps to
“initials.”

Last Name. The directory attribute that maps to the last name attribute. By default, Last Namemaps to “sn.”

E-mail. The directory attribute that maps to the e-mail attribute. By default, E-mail maps to “mail.”

Certificate DN. Reserved for future use. By default, it is mapped to “comment.” Do not map certificate to
critical fields, such as “cn” or “sAMAccountName.”

Password. The directory attribute that maps to the password attribute. By default, Password maps to
“unicodePwd.”

Search Filter. The filter that specifies how user entries are distinguished in the LDAP directory, such as a filter
on the user object class. Any valid LDAP filter for user entries is allowed, for example,
(objectclass=inetOrgPerson).

Search Scope. The scope of user searches in the LDAP tree.

Object Classes. The object class of users in the identity source that are managed using the Security Console,
for example, user,organizationalPerson,person.

Directory Configuration - User Groups

User Group Name. The directory attribute that maps to the user group name attribute. For example, the User
Group Namemight map to cn.

Search Filter. An LDAP filter that returns only group entries, such as a filter on the user group object class, for
example, (objectclass=group).

Search Scope. The scope of user group searches in the LDAP tree.

Object Classes. The object class of user groups that are created or updated using the Security Console.

Membership Attribute. The attribute that contains the DNs of all the users and user groups that are members
of a user group.

Use MemberOf Attribute. Enables the system to resolve membership queries by using the value specified for
the MemberOf attribute.

Note: For an OpenLDAP directory identity source, do not select the User MemberOf Attribute.

MemberOf Attribute. The attribute of users and user groups that contains the DNs of the user groups to
which they belong.
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Identity Source Scope
Identity source scope determines the subset of users and user groups in your LDAP directory that can be
managed within the identity source.

Identity Source Scope Settings

When you add an identity source, you determine its scope, including the base DNs, the search filters, and the
search scope (single level vs. all levels).

Setting Description

User Base DN Directory location where Authentication Manager searches for users.

User Group Base
DN

Location in your LDAP directory where Authentication Manager Express searches for groups.

User Search
Filter and User
Group Search
Filter

An LDAP filter that returns only user or group entries, such as a filter on the user group
object class, for example, (objectclass=groupOfUniqueNames).

User Search
Scope and Group
Search Scope

Scope of user and user group searches in the LDAP tree.

User Object
Classes and
Group Object
Classes

Object class of users and user groups that are accessed by Authentication Manager. Any
custom attributes that are used in the mapping fields must be part of one of the object
classes. For more information, see Custom Attribute Mapping on page 64.

Note: Do not configure multiple identity sources with overlapping scope. If you have multiple identity sources
that point to the same User Base DN or User Group Base DN, verify that you correctly configured the User
Search Filter and User Group Search Filter to include each user in only one identity source. Improper
configuration may result in unresolvable users and authentication problems.

Identity Source Scope Change Requirements

You can make the scope of an identity source broader or narrower. If you narrow the scope of an identity
source, some users and user groups may become unresolvable and unable to authenticate. Unresolvable users
are users that Authentication Manager can no longer find in the LDAP directory that was designated as their
identity source.

After you narrow the scope you need to run the scheduled cleanup job to delete references to unresolvable
users and user groups from the internal database. For instructions, see the Help topic "Scheduling Cleanup for
Unresolvable Users and User Groups."

When you run the scheduled cleanup job, you need to disable the Grace Period, the Cleanup Limit, or both if
they are set, and re-enable those settings after this single cleanup runs.

You do not need to perform a scheduled cleanup after broadening the scope of the identity source.

Active Directory Identity Sources that are not Global Catalogs
In Active Directory, identity sources that are not Global Catalogs are used for administrative operations, such as
enabling users for on-demand authentication and risk-based authentication. If you are not using a Global
Catalog, this type of identity source is also used for finding and authenticating users. This type of identity
source also maps to a domain controller.
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If you want to administer Active Directory domain users in Authentication Manager, you must add an identity
source for each domain that contains users who will authenticate with Authentication Manager.

For example, if an Active Directory forest has three domains and one Global Catalog, and you want to
authenticate users in two of the domains, you must add an identity source for each of the two domains.

Note: Authentication Manager supports up to 30 identity sources that are not Global Catalogs per deployment.
This limit does not include using the internal database as an identity source.

An identity source that is not a Global Catalog can use group membership data from all three types of Active
Directory security groups: Universal Security, Global, and Domain Local. Authentication Manager does not
support distribution groups of any kind for restricted agent access.

Support for Group-to-Group Membership in Active Directory

To support group-to-group membership in Active Directory, you must set the domain functional level to
Windows 2003 or 2008. For more information about how to raise the domain functional level, go to
http://support.microsoft.com/kb/322692.

Note: The default organizational unit “Groups” does not exist in the default Active Directory installation. Make
sure you specify a valid container for the User Group Base DN when adding the identity source.

Active Directory Global Catalog Identity Sources
If you have an Active Directory forest, and you configure multiple identity sources within it, you can optionally
configure an Active Directory Global Catalog as an identity source that the other Active Directory identity sources
can use for finding and authenticating users, and resolving group membership within the forest. You need to:

l Add each Global Catalog to Authentication Manager as a separate identity source.

l Map the identity source to the Global Catalog port on the domain controller that hosts the Global Catalog.

RSA Authentication Manager does not use Global Catalogs for administrative operations, such as changing
users’ passwords. Administrative actions are only performed against non-Global Catalog identity sources.

Deployment Requirements for Global Catalogs

These requirements apply only to deployments that use restricted authentication agents.

To use a Global Catalog as an identity source, your deployment must meet all of the following requirements:

l All groups granted access to a restricted authentication agent must be Windows Universal Security
groups.

l When you view the Active Directory groups from the Security Console, all types of groups (Universal
Security, Domain Local, and Global) are displayed, but only Universal Security groups may be
successfully used with restricted agents through a Global Catalog.

l All domains in the forest must run Windows 2008 R2 or Windows 2012 R2.

Only the Windows administrator can change the group type in Active Directory.

Note: If you select a group from the list of Active Directory groups in order to activate users on restricted
agents, make sure you select a Universal Security group. If you use any other type of group, the user cannot
authenticate.

Data Replication for Global Catalogs

When you use the Active Directory Global Catalog as an identity source, individual Active Directory domain
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controllers replicate domain changes to the Global Catalog. For this type of deployment, you must integrate the
following with Authentication Manager:

l The Global Catalog. If your forest has more than one Global Catalog, you can use one for failover. You do
not need to create an identity source for the second Global Catalog. Instead, you can specify it as a
failover URL when you create the identity source for the first Global Catalog.

l All domain controllers that contain users and user groups that you want to reference from Authentication
Manager. Add each domain as an identity source.

For example, suppose that GC1 is the Global Catalog identity source for user authentication, and AD1, AD2, and
AD3 replicate a subset of their data to GC1. You must map each Active Directory to an identity source. After
integration is complete, Authentication Manager accesses GC1 for authentication requests and AD1, AD2, and
AD3 for administration, such as updating the user password.

Global Catalog Deployment Example with Four Identity Sources

The following figure shows a forest composed of three domains, each consisting of one domain controller, and a
single Global Catalog. In this example, you must enable at least four identity sources in Authentication Manager.

l Three identity sources for domain controllers, possibly with failover domain controllers

l One identity source for a Global Catalog, possibly with a failover Global Catalog server

56 Chapter 3: Integrating LDAP Directories



RSA Authentication Manager 8.3 Administrator's Guide

Configure the Active Directory Connection Time-Out
In some situations, the default LDAP connection time-out is not long enough for Authentication Manager to
establish a connection to the LDAP directory. If you need to adjust the length of time that Authentication
Manager waits to establish the connection, use the Operations Console to edit the identity source and change
the value in the Search Results Time-out field.

Integrating an LDAP Directory as an Identity Source

You can integrate LDAP directory servers as identity sources in Authentication Manager without modifying the
directory schema. You perform the integration by adding identity sources, linking the identity source to
Authentication Manager, and mapping identity attribute definitions to attribute names in the LDAP directory.

Follow these guidelines:

l You must have LDAP connection information and detailed knowledge of your LDAP schema.

l You must configure an identity source for each directory that contains users who will authenticate with
Authentication Manager.
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l You can configure one identity source for each LDAP directory server.

l The primary and replica instances should not use the same directory server for regular use, but they
may share the same failover directory server. If both instances use the same directory server, a system
or network outage for those systems may cause authentication to fail.

l If you have not configured a replica instance, but plan to in the future, you need to update the replica
instance identity source connection information after you configure the replica instance.

The following high-level steps describe how to integrate an LDAP directory server as an identity source:

1. Set up SSL connections using the Operations Console. See Identity Source SSL Certificates on page 62.
This step is required if you allow users to change their passwords from Authentication Manager.

2. (Optional) Review your password policy, and make adjustments if necessary. See Password Policy for
Active Directory on page 64. This step is required only if you allow users to change their passwords from
Authentication Manager.

3. If the directory server is Active Directory, verify if your domain functional level supports group-to-group
membership. Check the System control panel on the domain controller, and see Support for Group-to-
Group Membership in Active Directory on page 55.

4. Verify that the directory server hostname is a valid DNS name. Make sure:
l The hostname is resolvable for both forward and reverse lookups.

l The directory server can be reached from the Authentication Manager server.

5. Add the identity source, using the Operations Console. Make sure you configure the following:
l The identity source name

l The LDAP connection, including the directory URL, backup directory URL, directory User ID, and
directory password

l Attribute mapping

l (Optional) Global Catalog (Active Directory only)

6. (Optional) You can define custom user attributes that are specific to your organization. For instructions,
see the Security Console Help topic “Add Identity Attribute Definitions.”

l (Optional) Map the custom attributes that you previously defined from the LDAP directory to the
identity source. If you choose to map custom attributes to the external identity source,
Authentication Manager can read the attribute values from your directory.

l For instructions, see Custom Attribute Mapping on page 64.

7. Use the Security Console to link the identity source to the system. See Link an Identity Source to the
System on page 60.

8. Verify that the identity source was added successfully.See Verify the LDAP Directory Identity Source on
page 61.

Note: To disable or delete an identity source, it must be unlinked from the system. For instructions, see the
Help topic “Unlink Identity Sources from the System.” For instructions about deleting the identity source, see
the Help topic “Remove an Identity Source.”

Add an Identity Source
To use an existing LDAP directory with RSA Authentication Manager, use the Operations Console to add the
directory as a new identity source.

A deployment can have up to thirty identity sources. If you are using Active Directory, Global Catalogs
configured as identity sources do not count against this limit.
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Before you begin

l You must be a Super Admin.

l This procedure requires you to make informed decisions about the information that you enter. For more
information about the identity source properties in this procedure, see Identity Source Properties on
page 50.

l For full functionality, establish an SSL connection between Authentication Manager and the identity
source. For more information, see Identity Source SSL Certificates on page 62.

l Before adding an OpenLDAP directory identity source, review the required settings. For more
information, see OpenLDAP Attribute Requirements on page 70.

Note: Depending on the network or firewall configuration, you might not be able to validate the connection
information from the primary server.

Procedure

1. Log on to the Operations Console on the primary instance.

2. Click Deployment Configuration > Identity Sources > Add New.

3. When prompted, enter your Super Admin User ID and password.

4. In the Identity Source Basics section, specify:

l Identity Source Name. The name of the identity source that is displayed in the Security
Console.

l Type. The type of the identity source that you are adding.

l Notes. Information about the identity source.

5. In theDirectory Connection - Primary section, do the following:

l Enter the requested information in the following fields. For detailed information, see Identity
Source Properties on page 50.

l Directory URL

l Directory Failover URL

l Directory User ID

l Directory Password

l Click Test Connection to ensure that the primary instance can connect to the specified
directory. If the test fails, make sure that you have correctly imported the certificate for this
identity source.

6. If you have a replica instance, complete the fields in theDirectory Connection - Replica section, and
click Validate Connection Information to verify that the primary instance can connect to the identity
source. If the attempt fails, do the following:

Chapter 3: Integrating LDAP Directories 59



RSA Authentication Manager 8.3 Administrator's Guide

a. Verify that you entered the correct settings.

b. If the settings are correct, make sure the primary instance is able to connect to the identity
source.

c. If the primary instance is able to connect to the identity source, make sure no other network
issues are causing the connection failure.

d. After you make any necessary changes, click Validate Connection Information again.

7. ClickNext.

8. Provide the requested information for each of the following sections on the Add Identity Source - Map
page. For detailed information, see Identity Source Properties on page 50.

l Directory Settings

l (Optional) Active Directory Options

l Directory Configuration - User Tracking Attributes

l Directory Configuration - Users

l Directory Configuration - Users Groups

9. Click Save.

After you finish

l Use the Security Console to link the new identity source to the system.

l If you are logged on to the Security Console, you must log off and log back on to view the new identity
source.

Link an Identity Source to the System
You must link all LDAP directory identity sources to the system. After linking, all users in the identity source can
be viewed and managed through the Security Console. Users are visible in the top-level security domain by
default, but you can move them to other security domains as necessary. Additionally, you can configure the
system to place users from the identity source into a specific security domain automatically. For more
information, see the Help topic "Default Security Domain Mappings."

Before you begin

l You must be a Super Admin.

l If you link an Active Directory Global Catalog, you must also link each identity source that replicates user
data to that Global Catalog. For example, if identity sources IS1 and IS2 replicate information to Global
Catalog GC1, and you link GC1 as an identity source, you must also link IS1 and IS2 to the system.

Procedure

1. In the Security Console, click Setup> Identity Sources > Link Identity Source to System.

2. From the list of available identity sources, select the identity source that you want to link , and click the

60 Chapter 3: Integrating LDAP Directories



RSA Authentication Manager 8.3 Administrator's Guide

right arrow.

3. Click Save.

Verify the LDAP Directory Identity Source
To verify that you have successfully added and linked an identity source, you can view the users and groups
from that identity source through the Security Console.

Procedure

1. In the Security Console, click Identity > Users >Manage Existing.

2. Use the search fields to find the appropriate identity source, and click Search

3. View the list of users from the LDAP directory identity source.

Failover Servers
You can specify failover directory servers when you use the Operations Console to add an identity source. If the
primary directory server stops responding, the deployment automatically connects to the failover server.

Follow these guidelines when configuring a failover directory server:

l Provide the failover URL in the Directory Failover URL field when you add an identity source. For
instructions, see Custom Attribute Mapping on page 64.

l The failover directory server must be a replica of the primary directory server.

l The primary and replica instances should not use the same physical server. If no failover is provided and
both servers use the same domain server, users cannot authenticate if that domain server becomes
unavailable.

l Each failover URL should point to a different physical directory server.

Failover Active Directory Servers

For an Active Directory identity source, the failover server should not be a Global Catalog.

Deployment Example with Failover Directory Servers

The following example configuration eliminates any single-point-of-failure if one of the two available directory
servers become unavailable. In this case, each directory server is in the same domain and provides a replicated
copy of the same LDAP data.
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Securing the Communications Path

RSA recommends that you use Secure Sockets Layer (SSL) to encrypt data in transit between Authentication
Manager and the directory.

You must configure SSL for each directory server you plan to use with Authentication Manager. For more
information, see Identity Source SSL Certificates below.

For Active Directory there are additional considerations for password policies and group membership support.
For more information, see Password Policy for Active Directory on page 64 and Support for Group-to-Group
Membership in Active Directory on page 55.

Identity Source SSL Certificates
LDAP directory servers that are integrated with Authentication Manager are called identity sources. An identity
source contains all of the connection and mapping information that Authentication Manager needs to access
user and group data in an LDAP directory. Authentication Manager also provides an internal database that you
can use as an identity source.

When you integrate an LDAP directory server as an identity source, use an identity source secure sockets layer
(SSL) certificate to establish secure communication between the deployment and the external identity sources.
Set up SSL connections using the Operations Console. Setting up an SSL connection also enables you to allow
users to change their passwords from Authentication Manager.
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When establishing an SSL connection, the identity source presents a certificate that identifies the server (for
example, using the hostname). To accept the server certificate, either the certificate itself or its root certificate
must be trusted by the deployment. For an SSL certificate to be trusted, you must add it to the deployment.

Add an Identity Source SSL Certificate
A secure sockets layer (SSL) certificate establishes secure communication between the deployment and the
identity sources. You must add the identity source SSL certificate to the deployment as a trusted certificate.

Use the following procedure to add the identity source SSL certificate as a trusted certificate.

Before you begin

You must be a Super Admin.

Procedure

1. Import the SSL server certificate or the CA root certificate to the primary appliance. The certificate must
be in Distinguished Encoding Rules (.der) encoded format. Make sure you have access to these
certificates.

2. Log on to the Operations Console on the primary instance.

3. Click Deployment Configuration > Identity Sources > Identity Source Certificates > Add
New.

4. If prompted, enter your Super Admin User ID and password.

5. Enter a name for the new identity source certificate.

6. Browse to the directory where the SSL certificate is located. Certificates typically have .cer, .pem, or .der
file extensions.

7. Click Save.

Access to User Passwords in an LDAP Directory
For users who are stored in an LDAP directory, you can configure your system to allow both Authentication
Manager administrator’s and the users themselves to modify the user password.

An administrator can modify the password of users whose accounts are stored in an LDAP directory if the
identity source administration account has permission to write to user records in the LDAP directory. This
account is specified in the Directory User ID and Directory Password account fields on the Identity Source
Connections page in the Operations Console.

Users can change their passwords when prompted during authentication if the following conditions are met:

l The identity source administration account has permission to write to user records in the LDAP
directory.

l The directory is configured to permit the users to change their passwords.

Note: If you do not permit users to change their passwords during authentication, the identity source
administration account does not need permission to write to the LDAP directory.

l An LDAPS connection is configured between Authentication Manager and the LDAP directory. For
instructions on setting up an SSL connection, see Identity Source SSL Certificates on the previous page.
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l One of the following conditions applies:
l The user’s password has expired.

l An Authentication Manager administrator has edited the user’s user record to force a password
change by checking the Require the user to change password at next logon box.

l The LDAP directory is configured to require the user to reset the password the next time the user
authenticates.

If these conditions are not met, users’ attempts to change passwords will fail.

Password Policy for Active Directory
Active Directory has a default password policy that is more strict than the default RSA Authentication Manager
password policy. This can lead to errors such as “Will Not Perform” when adding and updating users.

To manage password policies with Active Directory identity sources, do one of the following:

l Make your Authentication Manager password policy password requirements more strict. For more
information, see the Help topic "Password Policy."

l Relax the complexity requirements in the Windows 2003, 2008, or 2008 R2 Group Policy Object Editor.
For more information, see your Active Directory documentation.

Note: The Authentication Manager default password policy is already stricter than the default password policy
of the Oracle Directory Server. Make sure that either Authentication Manager has a stricter password policy than
your identity source or Authentication Manager and your identity source have password policies that are equally
strict.

Custom Attribute Mapping

If you are using custom attributes, after adding the identity source, you need to explicitly map identity attribute
definitions to physical attribute names in an LDAP directory identity source schema.

All user fields must map to non-null fields. However, the User ID can be mapped to any unique attribute for a
user.

For complete mapping instructions, see the following topics:

Topic Description

User Attributes on
page 66

Overview of internal and default user attributes.

Add Identity Attribute
Categories on page 67

Instructions for grouping related identity attributes together in categories. When you
add identity attribute definitions, you assign each attribute to a category.

For example, Address can be an attribute category used to group together the fields
for Street, City, State, and Country.

The default category is Attributes.

Add an Identity Attribute
Definition on page 68

Instructions for mapping custom user attributes.

Identity Source User Attributes
To view LDAP data in the Security Console, you must map the Authentication Manager fields to corresponding
fields in the LDAP directory. These fields are called attributes. There are two types of user attributes:
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l Core attributes

l Custom attributes

Core Attributes

Core attributes include basic user attributes such as User ID, first name, and last name. You map these when
you use the Operations Console to create an identity source.

Mapping the fields in the directory to the fields in Authentication Manager allows you to use the Security Console
to view user and user group data stored in the directory. For example, when you create an identity source, you
map the Authentication Manager User ID field to the appropriate field in the LDAP directory. You map core
attributes when creating an identity source in the Operations Console.

All user fields must map to non-empty fields. For example, with Active Directory, User ID is mapped to
sAMAccountName by default, but it can be mapped to any unique non-empty attribute for a user.

If you have multiple identity sources, try to map your attributes consistently. For example, if you map User ID to
sAMAccountName in one identity source, do the same for your other identity sources.

Custom Attributes

In addition to the core attributes, you can define custom attributes, called identity attribute definitions, that
contain information tailored to your organization. You can map these custom attributes to fields in the LDAP
directory, allowing Authentication Manager to display these attribute values from the directory. You can use
custom attributes to provide support information to your Help Desk personnel.

The attribute definition indicates whether the value should be stored in the directory or in the internal database.
If stored in the directory, the field must already exist in the directory.

Use the Security Console to create and map custom attributes.

Unique Identifier Attribute
When you create an identity source and map the core attributes, you must map the Unique Identifier field. This
field helps Authentication Manager map internal database records to their corresponding LDAP Directory
records. Authentication Manager uses this field to find users whose distinguished name (DN) has changed. The
default Unique Identifier is one of the following:

l For Active Directory or Active Directory Lightweight Directory Services, the default attribute is
ObjectGUID.

l For Oracle Directory Server or Sun Java Directory Server, the default attribute is nsUniqueID.

l For OpenLDAP, the default attribute is entryUUID.

Map the Unique Identifier field on the Add New Identity Source page in the Operations Console. For more
information, see Add an Identity Source on page 58.

The Unique Identifier attribute must meet these requirements:

l The attribute must contain unique data for each user. For example, an employee ID number or badge
number that is unique for each user in your deployment.

l The attribute must contain data for each user. The value cannot be empty.

l The attribute value cannot change. If the value for a user changes, Authentication Manager cannot track
the user. You cannot map any other fields to the attribute that you map to the Unique Identifier.
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l The attribute namemust not exceed 64 characters.

l The attribute value must not exceed 42 characters.

Follow these guidelines when mapping unique identifiers:

l You must specify the Unique Identifier before you move or rename directory users who are viewed or
managed through the Security Console. Otherwise, the system creates a duplicate record for the users
that you move or rename, and disassociates them from data the system has stored for them.

l After you have mapped the Unique Identifier field, you cannot change it.

User Account Enabled State Attribute
Each identity source contains an attribute, called the User Account Enabled State, that indicates where
Authentication Manager looks to determine whether a user account is enabled or disabled. Authentication
Manager always checks the external directory of an LDAP identity source, but you can configure it to check the
setting in the internal database as well.

The Enabled attribute reports the enabled or disabled state of a user’s account in Authentication Manager, as
controlled in the Security Console. Unlike many other user attributes, you cannot alter the mapping of the
Enabled attribute.

When you use the Operations Console to create an LDAP identity source, you can control how Authentication
Manager determines whether a user is enabled for remote access. You can set the User Account Enabled State
in either of two ways:

When set to Directory, Authentication Manager consults the user’s enabled state in the LDAP directory only.

Use the Directory setting if you want LDAP alone to control whether a user is enabled in Authentication Manager.
Disabling a user account in Authentication Manager requires disabling the user account in the directory.

When set to Directory and Internal Database, Authentication Manager consults both the LDAP directory and the
Authentication Manager internal database to determine a user’s enabled state.

Use the Internal Database setting if you want to disable the user in Authentication Manager, but allow the user
to remain enabled in the LDAP. In this case, the user is not permitted to authenticate with Authentication
Manager for remote access, but the state of the user’s LDAP account does not change. For example, the user can
still log on to Windows because the Windows Domain account remains enabled.

For both settings, the user’s LDAP account must be enabled for the user to authenticate with Authentication
Manager.

User Attributes
User attributes include internal user attributes, default user attributes, and optional custom user attributes.
You can search, query, and report on all attribute values.

You can use attributes to delegate administrative tasks through role definition. For example, a role might allow
an administrator to manage all users with a specific job title, where job title is a user attribute. A role might also
allow an administrator to manage all users in a specific department, where department is a user attribute.

Internal user attributes are recorded in the internal database for searching and reporting purposes. You cannot
customize or modify system attribute values using the Security Console, but you may run searches or generate
reports that are based on or include system attribute values. For example, you can run a search or create a
custom report based on all users that were modified on a particular date.

Default user attributes are the core attributes for every user. They are:
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l Certificate DN

l Email

l First Name

l Middle Name

l Last Name (required)

l User ID (required)

l Password (required)

Modification of Attribute Values

You can modify default attribute values based on the type of identity source:

l LDAP directory identity source: Default attribute values are stored in the LDAP directory. You must
modify attribute values using the native LDAP directory administrative interface. Also, default user
attributes must be mapped correctly to attributes in the LDAP directory so that these attribute values can
be displayed in the Security Console and included in searches and reports.

l Internal database: All attributes and attribute values stored in the internal database can be modified
using the Security Console.

Custom User Attributes

You can define custom user attributes using identity attribute definitions. For example, you can create an
attribute called “Region” to identify where users are located. For more information, see Add an Identity Attribute
Definition on the next page.

When you create a identity attribute definition, you must decide where to store the attribute value. You can do
one of the following:

l Store the user attribute value with the user record. If you added the user through the Security Console,
the attribute value is stored in the internal database with the user record. For a user that exists in an
LDAP directory, the attribute value is stored only in the LDAP directory and is read-only in RSA
Authentication Manager.

l Store the user attribute value in the internal database for all users, including users that exist only in an
LDAP directory. An administrator with the appropriate permissions can edit attribute values using the
Security Console.

Add Identity Attribute Categories
Identity attribute categories group related identity attributes together. For example, Address can be an attribute
category used to group together the fields for Street, City, State, and Country. Other examples of attribute
categories include Current Job Information, Training History, and Employment History.

When you add identity attribute definitions, you assign each attribute to a category. The Edit User page displays
attributes grouped within these categories. If you do not assign an attribute to a category, the default category
is Attributes.
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Procedure

1. In the Security Console, click Identity > Identity Attribute Definitions > Identity Attribute
Categories.

2. In the Category List field, enter the name of a new identity attribute category.

3. Click Add.

4. Continue adding categories until you are finished.

Note: Use the Sort buttons (the up and down arrows) to order the list. The attribute categories display
on the Add User and Edit User pages in this order.

5. Click Save.

Add an Identity Attribute Definition
Identity attribute definitions are custom user attributes. When you add them to your deployment and map them
to external identity sources, the Security Console can retrieve identity attribute values from an external identity
source. For more information, see the Help topic "Edit Identity Source Attribute Mappings."

To use an identity attribute definition in an attribute-based role, you must enable the identity attribute definition
for use in administrative scope restrictions. You do this when you define the identity attribute definition for the
deployment.

Procedure

1. In the Security Console, click Identity > Identity Attribute Definitions > Add New.

2. In the Attribute Name field, enter a unique attribute name for the value mapped from the directory.
(This name appears in the Security Console on the Add New User and Edit User pages.) Do not exceed
255 characters.

3. (Optional) In the Category field, specify the category to which this attribute belongs. The drop-down
menu displays categories that are defined on the Identity Attribute Categories page. If you do not specify
a category, the default category is Attributes.

4. In the Entry Type field, indicate whether the new attribute field is Optional, Required, or Read-Only.
Optional and required attributes can be edited. If an attribute is required, you must enter a value for it
when you add the user in order to save the user's record.

Note: Your administrative role determines whether you can modify identity attributes. On the Add
New User and Edit User pages, you can edit attributes that your role permits you to modify, even if
the attribute is required. If you do not have permission to edit a required attribute, you cannot add
or edit the user.

5. From theData Type drop-down list, select the type of data that you want to store in the new attribute.

Note: Use the same data type as the LDAP directory schema. If the data type is not the same, the
Security Console cannot retrieve user records that include this attribute from the external identity
source, and the failure is recorded in the system log. To resolve this issue, delete the existing
identity attribute definition, and add a new one using the correct data type.

6. (Optional) In the Predefined List Entries fields, create a list of predefined values that administrators
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can use when adding or editing a user record. The values are displayed appear in a drop-down list on
the Add and Edit User pages.

For example, suppose that you add the attribute “Location” that represents the office location. If you
have locations in London, New York, and Madrid, you can add each of these locations as predefined
values.

To add a predefined value:

a. In the Value field, enter a predefined value for the identity attribute.

b. Click Add.

7. For the Attribute Storage option, select one of the following:

l Store this attribute in the same location as the user record (internal database or
external identity source) to store the user attribute value with the user record. For a user that
you created using the Security Console, the attribute value is stored in the internal database with
the user record. For a user that exists in the external identity source, for example, an LDAP
directory, the attribute value is stored only in the external identity source and is read-only in RSA
Authentication Manager.

l Always store this attribute in the internal database to store the user attribute value in the
internal database for all users. When you select this method, the attribute is stored in the
internal database, even for user records that exist only in the external identity source, for
example, an LDAP directory. An administrator with the appropriate permissions can edit attribute
values using the Security Console.

You cannot change the attribute storage configuration after the attribute is created.

8. (Optional) In the Tooltip field, specify the text for the rollover tooltip. Make sure that the text is
descriptive enough to help the administrator who is using the Add New User or Edit User pages. Do not
exceed 75 characters.

9. (Optional) To allow the attribute to have more than one value, selectMulti-Value. Boolean and Date
attributes cannot store more than one value.

10. For Use for Scope Restriction, select Use to define conditions on administrative user
management permissions if you want to use this attribute to restrict the scope of an administrative
role.

11. Under Identity Source Mapping, identify the field mapping configuration for each identity source in
your deployment.

l For Internal Database, specify the name of the attribute that will be created in the internal
database. The namemay include alphanumeric characters and underscores, for example,
MOBILE_NUMBER2.

l For each external identity source, specify the attribute name that exists in the external identity
source. You may leave the field blank if the attribute has no mapping in an external identity
source. When you save the attribute, RSA Authentication Manager validates the mapping.

12. Click Save.
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OpenLDAP Attribute Requirements

When you add an OpenLDAP directory identity source, the Operations Console automatically sets the required
configuration options shown in the following table. Do not change these default settings.

Configuration Options Required Setting

Validate identity attribute definition
mappings against directory schema

Disabled

Unique Identifier entryUUID

Enable the User MemberOf Attribute Disabled
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Importing, Assigning, and Distributing RSA SecurID Tokens

The following steps outline the tasks required to deploy RSA SecurID tokens.

Procedure

1. Import a Token Record File.

2. Assign Tokens to Users.

3. For software tokens, Add a Software Token Profile on page 74. Otherwise, continue to the next step.

4. Distribute the token. Choose one of the following:

l Distribute Multiple Software Tokens Using Dynamic Seed Provisioning (CT-KIP) on page 76

l Distribute One Software Token Using Dynamic Seed Provisioning on page 78

l Distribute software tokens using file-based provisioning. For instructions, see the Help.

l Distribute software tokens using Compressed Token Format (CTF). For instructions, see the
Help.

l Distribute hardware tokens:
l If users are located within close proximity, instruct the users to physically collect the
tokens.

l If your organization is large and geographically dispersed, distribute tokens by mail.

Import a Token Record File

RSA provides an XML file that contains the token records that your organization has purchased. Before you can
work with individual token records, you must import the token record XML file into Authentication Manager.

For hardware tokens, each token record in the file corresponds to a hardware token that your organization has
purchased.

For software tokens, token record data will eventually be transferred into a software token application. Each
token record contains the token seed and metadata such as the token serial number, expiration date, and the
tokencode length and interval.

If you import the same XML token record file twice, for example, because you accidentally deleted a token from
the database, when you re-import the XML token record file containing the deleted token, the other tokens will
be duplicates. You can choose to handle duplicates in one of two ways:

l Ignore duplicate tokens. All tokens are imported except for duplicates.

l Overwrite duplicate tokens. In this case, most duplicates are overwritten. The following exceptions are
ignored and not overwritten:

l Tokens assigned to administrators.

l Tokens that the current administrator does not have permission to view, for example, if they are
outside his or her administrative scope.

l Tokens that have been replaced or that have replaced another token.
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Before you begin

l Decide which security domain will own the imported tokens. The security domain must be in the
administrative scope of the administrator who will deploy and manage the tokens.

l Your administrative role must permit you to manage tokens.

Procedure

1. In the Security Console, click Authentication > SecurID Tokens > Import Tokens Job > Add
New.

2. Enter a name for the import job. The job is saved with this name so that you can review the details of the
job later. The namemust be from 1 to 128 characters. The characters & %> < are not allowed.

3. From the Security Domain drop-down menu, select the security domain into which you want to import
the tokens. The tokens are managed by administrators whose scope includes this security domain. By
default, tokens are imported into the top-level security domain.

4. Browse to select the token files that you want to import.

5. In the File Password field, enter a password if the file is password protected.

6. Use the Import Options radio buttons to specify handling for duplicate tokens.

If you have extended the lifetimes of software tokens, select Ignore all duplicate tokens to keep the
extended token expiration dates.

Note: Overwriting tokens that have extended lifetimes or tokens that were used to extend token
lifetimes restores the original token expiration dates. The overwriting option also restores duplicate
tokens that were deleted because they were used to extend another token’s lifetime.

To view a list of extended lifetime software tokens, in the Security Console, click Authentication >
SecurID Tokens > Manage Existing. The Extension Token column lists the serial numbers of the
tokens that were used to extend other tokens.

7. Click Submit Job.

Assign Tokens to Users

Assigning a token associates the token with a specific user. You must assign a token to a user before the user
can authenticate. You can assign a maximum of three tokens to each user.

RSA recommends that you do not assign more than one hardware token to a user as this may increase the
likelihood that users will report a lost or stolen token. Some software token applications may not allow multiple
tokens. For platform-specific information on token limitations, see the RSA SecurID software token
documentation.

Before you begin

l Import the token records from the token record file to the internal database. For more information, see
Import a Token Record File on the previous page.
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l Make sure a user record exists in Authentication Manager for each user to whom you want to assign a
token.

Procedure

1. In the Security Console, click Identity > Users > Manage Existing.

2. Use the search fields to find the users to whom you want to assign tokens.

3. From the search results, click the user(s) to whom you want to assign tokens.

4. From the context menu, under SecurID Tokens, click Assign More.

5. From the list of available RSA SecurID tokens on the Assign to Users page, select the checkboxes for the
tokens that you want to assign. Record which tokens you assign so you can deliver them later.

6. Click Assign.

After you finish

Add a Software Token Profile below

Add a Software Token Profile

Software token profiles specify software token configuration and distribution options. You must configure a
software token profile for each platform to which you plan to distribute software tokens.

Before you begin

You must be a Super Admin.

Procedure

1. In the Security Console, click Authentication > Software Token Profiles > Add New.

2. Enter the Profile Name. Try to include the device type or distribution method in the profile name. For
example, “Android_CT_KIP.”

3. Do one of the following:

l To choose an existing device type, select one from theDevice Type drop-down list.

l To load a new device type, click Import New Device Definition File, browse to the device
definition file, and click Submit.

4. Complete the specific fields for the device type. You may have to configure these settings:

a. In the Tokencode Duration field, select the duration for the tokencode display.

b. In the Tokencode Length field, select the number of digits in the tokencode.

c. Select the Authentication Type. The following authentication types are available:
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l PINPad-style. The user must enter a PIN in the software token application to generate the
passcode.

l Fob-style. The user must enter the PIN, followed by the tokencode when logging on to the
resource protected by SecurID.

l Tokencode. The user enters a tokencode. No PIN is required.

d. Select theDelivery Method. You can distribute the software token file in one of three ways:

l Dynamic Seed Provisioning. Uses the Cryptographic Token-Key Initialization Protocol
(CT-KIP). You can use this method only for CT-KIP-capable SecurID software tokens. A
CT-KIP-capable SecurID software token is always a 128-bit token. There are two ways to
provision software tokens with CT-KIP:

l CT-KIP URL and activation code. The user can import the token using a CT-KIP URL
and activation code. The token can be delivered through a link that incorporates the CT-
KIP URL with the activation code.

l QR Code. The user can import the token by scanning a QR Code in the Self-Service
Console (using a QR Code-capable RSA SecurID Token application). For sites that deploy
the Self-Service Console, this method is recommended for higher security because the
URL and activation code does need to be sent in e-mail, and the user must authenticate to
the Self-Service Console before scanning the QR Code.

Note: The QR Code option is available only for devices that are QR Code-capable. Scan
QR Code is not supported in the RSA SecurID app on iOS 6. To download the required
software, go to https://www.emc.com/security/rsa-securid/rsa-securid-software-
tokens.htm. However, the Self-Service Console can be customized to allow users to
request email delivery of CT-KIP URL if they cannot scan a QR Code.

l Compressed Token Format (CTF) Provisioning. Authentication Manager generates a
URL, which you deliver to the user’s device. This URL contains the encoded token
information needed by the software application. Use this method only with CTF-capable
SecurID software tokens. CTF provisioning is not available to 64-bit tokens.

l File-based Provisioning. Authentication Manager generates a software token
distribution file (.sdtid), which is added to a .zip file for download. This software token
distribution file contains the shared secret (“seed”) used by the SecurID algorithm, and
other metadata such as expiration date, serial number, and number of digits in the
tokencode.

e. In theDevice Specific Attributes section, do one of the following:

l If you want to bind all software tokens intended for this device type to the device class,
leave the default value (classGUID) in theDeviceSerialNumber field.

l If the users have RSA SecurID Software Token 2.1 or later for Android or RSA SecurID
Software Token 2.2 or later for iOS, you can either clear the device ID or leave the default
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setting. RSA Authentication Manager uses dynamic seed provisioning to verify the device
class and obtain device-specific IDs from the user devices. Each device-specific ID binds
the software token to a specific device.

l For other software tokens, if you do not want to bind all software tokens intended for this
device type to the device class, you can clear theDeviceSerialNumber field or leave the
default value. Then, when you distribute the token, you can replace the default value with
a device-specific ID.

Note: RSA recommends using a device-specific ID for a QR Code-enabled profile.

f. Enter a nickname if you want all tokens that you deliver to have the same nickname (for example,
your company name). You can set a nickname for a specific token when you distribute the token.

5. Click Save.

After you finish

Deliver the token to the user using the selected method. For instructions, see one of the following:

l Distribute Multiple Software Tokens Using Dynamic Seed Provisioning (CT-KIP) below

l Distribute One Software Token Using Dynamic Seed Provisioning on page 78

l Distribute software tokens using file-based provisioning. For instructions, see the Help.

l Distribute software tokens using Compressed Token Format (CTF). For instructions, see the Help.

Distribute Multiple Software Tokens Using Dynamic Seed
Provisioning (CT-KIP)

Dynamic seed provisioning uses the CT-KIP protocol to generate token data without the need for a token file.
There are two ways to provision software tokens with CT-KIP:

l Using a URL link to the CT-KIP server and the CT-KIP activation code.

l Using a QR Code that encapsulates the CT-KIP URL and activation code. This method is recommended for
higher security because the URL and activation code does not need to be sent in e-mail, and the user
must authenticate to the Self-Service Console before scanning the QR Code.

Note: The Scan QR Code option is not supported in the RSA SecurID app on iOS 6. However, the Self-
Service Console can be customized to allow users to request email delivery of CT-KIP URL if they cannot
scan a QR Code.

Authentication Manager generates custom CT-KIP URLs or QR Codes for mobile platform device types, such as
Android and iPhone.

Before you begin

l If you are distributing the tokens using a CT-KIP URL link and activation codes, consider that RSA
Authentication Manager does not encrypt e-mail. For a more secure delivery option, you can do the
following:
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l Provide the information offline, such as by calling the users on the telephone.

l Copy the information into e-mail that you encrypt.

l Use a Simple Mail Transfer Protocol (SMTP) e-mail encryption gateway if the end-user device
supports encrypted e-mail.

l Distribute the tokens using QR Code because no e-mail is involved.

l Instruct users to install the software token application on their devices. For installation instructions, see
the documentation for the software token application.

l Assign Tokens to Users on page 73

l Add a Software Token Profile on page 74. Your Super Admin must add a software token profile.

l RSA recommends that you replace the default certificates in Authentication Manager with trusted
certificates. If you do not replace the default certificates, end users are prompted to accept untrusted
certificates before proceeding. If you want to use dynamic seed provisioning with CT-KIP, you must have
a trusted certificate on the Authentication Manager server or web-tiers.

Note: When you redistribute tokens using this method, any existing users of these tokens may no longer be
able to authenticate. Users must import the new token data before they can authenticate.

Procedure

1. In the Security Console, click Authentication > SecurID Tokens > Distribute Software Tokens in
Bulk > Generate Dynamic Seed Provisioning Credentials.

2. In the Job Name field, enter a name for the job, or accept the default name. The job is saved with this
name so that you can review the details of the job later. The namemust be a unique name from 1 to 128
characters.

3. From the Software Token Profile drop-down list, select a software token profile with dynamic seed
provisioning as the delivery method.

4. In theDeviceSerialNumber field, do one of the following:

l To bind (restrict) the distributed software tokens to a device class, leave the default setting. For
example, if you select a software token profile for Android devices, the default setting restricts
the software tokens to any Android device that is supported by the RSA SecurID Software Token
app.

l If the users have RSA SecurID Software Token 2.1 or later for Android or RSA SecurID Software
Token 2.2 or later for iOS, you can either clear the device ID or leave the default setting. RSA
Authentication Manager uses dynamic seed provisioning to verify the device class and obtain
device-specific IDs from the user devices. Each device-specific ID binds the software token to a
specific device.

5. Enter a nickname or leave theNickname field blank.

6. ClickNext.

7. Enter the software token selection criteria to find the tokens that you want to distribute. For example,
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enter the range of serial numbers for the tokens that you want to distribute.

8. ClickNext.

9. Review the distribution summary and click Submit Job.

10. Click the Completed tab to view completed jobs.

11. Click the job with which you want to work.

12. From the context menu, click Download Output File.

13. Save the output file to your machine.

14. Open the output file.

Note: When you download the output file, some spreadsheet applications will remove the leading
zeroes from the activation codes. To import activation codes successfully, open the file in an application
that does not remove any characters, such as a text editor, to copy the activation code accurately.

After you finish

For delivery using the CT-KIP URL and activation code, do the following:

1. In the output file, copy the activation codes and CT-KIP URL and safely deliver them to the users.

2. Instruct users on how to import tokens.

For delivery using QR Code, provide users with the following instructions:

1. Install the RSA SecurID Software Token application, version 2.0 or higher, on their mobile device.

2. Log on to the Self-Service Console from a device other than the one on which the RSA SecurID app is
installed.

3. On the My Account page, click Activate your token under My Authenticators, and then follow
instructions to activate the RSA SecurID software token.

Note: If you configured activation codes to expire, advise users to import tokens before the expiration time. If
the activation codes expire before they are used, you must redistribute the tokens, and provide the CT-KIP URL
and new activation codes to users. Or, in the case of QR code delivery, ask users to log in to the Self-Service
Console and scan the QR Code again.

Distribute One Software Token Using Dynamic Seed Provisioning

Dynamic seed provisioning uses the CT-KIP protocol to generate token data without the need for a token file.
There are two ways to provision software tokens with CT-KIP:

l Using a URL link to the CT-KIP server and the CT-KIP activation code.

l Using a QR Code that encapsulates the CT-KIP URL and activation code. This method is recommended for
higher security because the URL and activation code does not need to be sent in e-mail, and the user
must authenticate to the Self-Service Console before scanning the QR Code.
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Note: The Scan QR Code option is not supported in the RSA SecurID app on iOS 6. However, the Self-
Service Console can be customized to allow users to request email delivery of CT-KIP URL if they cannot
scan a QR Code .

Authentication Manager generates custom CT-KIP URLs or QR Codes for mobile platform device types, such as
Android and iPhone.

Before you begin

l If you are distributing the token using a CT-KIP URL link and activation code, consider that RSA
Authentication Manager does not encrypt e-mail. For a more secure delivery option, you can do the
following:

l Provide the information offline, such as by calling the user on the telephone.

l Copy the information into an e-mail that you encrypt.

l Use a Simple Mail Transfer Protocol (SMTP) e-mail encryption gateway.

l Distribute the token using a QR Code because no e-mail is involved.

l Instruct users to install the RSA Software Token application on their devices. For installation
instructions, see the documentation for the software token application.

l Add a Software Token Profile on page 74

l Assign Tokens to Users on page 73

RSA recommends that you replace the default certificates in Authentication Manager with trusted certificates.
Otherwise, end users are prompted to accept untrusted certificates before proceeding. Certain mobile device
platforms only support an SSL certificate with a server that has a trusted certificate installed. To use dynamic
seed provisioning with CT-KIP, you must have a trusted certificate on your Authentication Manager server or
web tiers.

Procedure

1. In the Security Console, click Authentication > SecurID Tokens > Manage Existing.

2. Use the search fields to find the software token that you want to distribute.

3. From the search results, click the software token that you want to distribute.

4. From the context menu, click Distribute.

5. From the Select Token Profile drop-down list, select a software token profile with one of the following
delivery methods:

l Dynamic Seed Provisioning (using URL)

l Dynamic Seed Provisioning (using QR Code)

6. In theDeviceSerialNumber field, do one of the following:

l To bind the token to the device class, leave the default setting.

For example, if you select a software token profile for Android devices, the default setting
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restricts the software tokens to any Android device that is supported by the RSA SecurID
Software Token app.

l To bind the token to a specific user device, clear the field and enter the device ID you obtained
from the user. RSA recommends using a device-specific ID for a QR Code-enabled profile.

If the user has RSA SecurID Software Token 2.1 or later for Android or RSA SecurID Software
Token 2.2 or later for iOS, you can either clear the device ID or leave the default setting. RSA
Authentication Manager uses dynamic seed provisioning to verify the device class and obtain a
device-specific ID from the user device.

7. Enter a nickname or leave theNickname field blank.

8. From the CT-KIP Activation Code drop-down list, select an activation code for the software token. For
QR Code delivery, the activation code is system-generated and cannot be changed.

9. Click Save and Distribute.

After you finish

For delivery using CT-KIP URL and activation code, RSA Authentication Manager displays the URL link of the CT-
KIP server and the unique, one-time token activation code. Do the following:

1. Copy the activation code and CT-KIP URL and safely deliver them to the user.

2. Instruct the user on how to import the token.

For delivery using QR Code, provide the user with the following instructions:

1. Install the RSA SecurID Software Token application, version 2.0 or higher, on the mobile device.

2. Log on to the Self-Service Console from a device other than the one on which the RSA SecurID app is
installed.

3. In theMy Authenticators section of the My Accounts page, click Activate Your Token.

4. Follow instructions in the Activate Your Token window to activate the token.

Note: If you configured the activation code to expire, advise the user to import the token before the expiration
time. If the activation code expires before it is used, you must redistribute the token, and provide the CT-KIP
URL and the new activation code to the user. Or, in the case of QR Code delivery, ask the user to log in to the
Self-Service Console and scan the QR Code again.
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RSA RADIUS Overview

You can use RSA RADIUS with RSA Authentication Manager to directly authenticate users attempting to access
network resources through RADIUS-enabled devices. A RADIUS server receives remote user access requests
from RADIUS clients, for example, a VPN. The RADIUS server forwards the access requests to
RSA Authentication Manager for validation. Authentication Manager sends accept or reject messages to the
RADIUS server, which forwards the messages to the requesting RADIUS clients.

RADIUS is automatically installed and configured during the Authentication Manager installation. After
installation, RADIUS is configured to run on the same instance with Authentication Manager.

You can use the Security Console to complete most tasks associated with managing RADIUS day-to-day
operations.

Through the Security Console, you can manage the following objects:

l View the RADIUS servers in your deployment, and the IP address and replication status of each RADIUS
server.

l Manage RADIUS clients and RADIUS client agents.

l Manage RADIUS profiles, including assigning profiles to users, user groups and agents, and specifying
a default profile.

l Manage RADIUS user attributes and custom attributes.

l View RADIUS server and RADIUS client statistics.

l Initiate replication to the replica RADIUS servers.

l Configure periodic replication to the replica RADIUS servers.

You use the Operations Console to configure RSA RADIUS and manage settings that must be made on individual
instances running RSA RADIUS and for non-routine maintenance of the RADIUS servers. You perform the
following tasks using the Operations Console:

l View the RADIUS servers in your deployment, and the IP address and replication status of each RADIUS
server.

l Manage the certificates used by RSA RADIUS, including the RADIUS server certificate and the trusted
root certificates for Extensible Authentication Protocol-Tunneled Transport Layer Security (EAP-TTLS)
authentications.

l Manage RADIUS server files, including RADIUS dictionary files and configuration files.

When using the Operations Console to modify RADIUS servers, the following restrictions apply:

l Changes made to one RADIUS server are not replicated to the other RADIUS servers in your deployment,
except for changes made to the following:

l root certificates

l peapauth.aut
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l ttlsauth.aut

l You must restart the RADIUS server for the changes to take effect.

RSA RADIUS Authentication Process
In a RADIUS-protected network, the authentication process works as follows:

1. The user provides authentication information to a RADIUS client.

2. The RADIUS client sends an “Access-Request” to server, which could include the following:

l User ID

l User password (encrypted)

l Client ID

l Port ID

3. RSA RADIUS validates the client using a shared secret. If no secret exists, the request is ignored.

4. RSA RADIUS checks requirements that must be met for the user to access the resource. The
requirements are known as RADIUS attributes and may include the following:

l Password

l Clients through which the user can access a resource

l Ports on which the user can access

5. RSA RADIUS forwards the request to Authentication Manager.

6. Authentication Manager allows or denies the request.

7. RSA RADIUS sends one of three responses:

l Access-Accept. RSA RADIUS allows access and returns a set of RADIUS attributes to the client.

l Access-Challenge. RSA RADIUS issues a challenge to which the user must respond, for example,
with a passcode.

l Access-Reject. The conditions are not met so access is denied.

RADIUS clients control user access at the network perimeter. RADIUS clients, which can be VPN servers,
wireless access points, or Network Access Servers connected to dial-in modems, interact with RSA RADIUS for
user authentication and to establish appropriate access control parameters. When authentication succeeds,
RSA RADIUS returns a set of attributes to RADIUS clients for session control.

The following figure shows how an RSA RADIUS server runs as a service on an Authentication Manager instance.
The RADIUS service handles the requests from the clients and communicates with the Authentication Manager,
which processes the authentications and grants or denies access to the user.
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RADIUS Network Topology
Firewalls typically separate the VPN server from the RADIUS server and the Internet. In most cases, multiple
RADIUS replica servers are configured with a primary server for load balancing and failover. Additional RADIUS
clients may also be configured, for example, as multiple wireless access points in strategic locations throughout
a site. These details are somewhat hidden from administrators because most routine administration is applied to
a primary server that replicates some of those changes to replica servers.

Some administration operations that are performed less frequently require administrators to know about replica
servers for failover, disaster recovery, and other systemmaintenance purposes.

Remote users with direct Internet connections can access network resources using a RADIUS-enabled VPN
server. Remote users without direct Internet connections can connect using telephone lines and dial-in modems
connected to a RADIUS-enabled network access server. Wireless users can access the network over RADIUS-
enabled wireless access points.

For all of these access methods, RADIUS provides the following capabilities:

l Fine-grained access controls that allow administrators to tightly manage individual user access,
restricting users to a specific network access device, session length, IP address or range, or other
restriction.

l Comprehensive and flexible accounting that allows administrators to tailor event log data to meet specific
needs, whether in support of Sarbanes-Oxley or any other auditing requirement. You can save your log
data to a flat file.

Communication Between RADIUS Servers and Clients
Communication between the RADIUS server and Authentication Manager always uses HTTPS. Communication
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between RADIUS servers and clients always uses the RADIUS protocol. Authentication Manager uses the
security features available in the RADIUS protocol, namely, sensitive fields are encrypted with a shared secret.

A shared secret is a text string that serves as a password between hosts. RADIUS servers use the following
types of shared secrets:

l RADIUS shared secret. Used to secure communication between a RADIUS server and a RADIUS client.

l Accounting secret. (This is not shown in the following figure) Used to secure accounting traffic
passed between the RADIUS primary server and a RADIUS client. The RADIUS server uses the
accounting secret of the RADIUS client. If no accounting secret exists on the client, the RADIUS server
uses the RADIUS shared secret of the client.

l Replication secret. Used to secure communication between a RADIUS primary server and a RADIUS
replica server. This secret is generated during installation of the Authentication Manager. You cannot
manage this secret.

l Node secret. Used to secure communication between a RADIUS server and an Authentication Manager
server. The RADIUS primary and all replicas use the node secret. This secret is generated during
installation of the Authentication Manager. You cannot manage this secret.

You can configure the RADIUS shared secret and the accounting shared secrets through the Security Console.
After the RADIUS shared secret is created, you must set the secret in the RADIUS client using the RADIUS
client’s administrative interface.

View RADIUS Servers

You can view a list of all RADIUS servers in RSA Authentication Manager. For example, you might view the list of
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all servers to quickly determine the number of RADIUS replica servers in Authentication Manager.

You can view the list of all RADIUS servers and the following properties of each:

l Type. Primary or Replica.

l IP Address. IP address that RADIUS clients and other RADIUS servers use to communicate with this
server. This is the same IP address used by Authentication Manager.

l Replication Status. The state of RADIUS data on a RADIUS server. For more information, see the Help
topic "RADIUS Replication Status."

Procedure

In the Security Console, click RADIUS > RADIUS Servers.

RADIUS Data Replication
RADIUS synchronizes data on the RADIUS replica servers with the data on the RADIUS primary server. The
primary server detects when an administrator changes RADIUS data through the Security Console and sends all
RADIUS data that can be replicated to the replica servers. If no changes have been made, data is not replicated.

The RADIUS primary server does not replicate RADIUS configuration files or RADIUS dictionary files. Each
RADIUS server has its own set of these files. When you make changes to the files of the RADIUS primary server,
you must make the same changes to the files of each RADIUS replica server in your deployment.

You must log on to the Operations Console on the RADIUS server you want to modify to view and edit the RADIUS
configuration files. For more information about the configuration files, see the RSA Authentication Manager
RADIUS Reference Guide. For more information about the dictionary files, see the documentation for your
RADIUS device.

You use either of twomethods to replicate RADIUS data:

l Configure periodic replication

l Initiate replication

By default, the deployment is configured to use periodic replication.

Configure Periodic Replication Method

Periodic replication is the default method. When this is enabled, the RADIUS primary server performs these
steps:

1. Searches for changes to the RADIUS data on the primary server every 15 minutes.

2. Replicates any changes to each RADIUS replica server.

3. Verifies that each RSA RADIUS replica server has the latest data.

If an RSA RADIUS replica server fails to update after replication, the RADIUS primary server logs a message to
the system log and to the Authentication Manager Critical System Event Notification system, which can be
configured to send e-mail to designated personnel. The failure notification can take up to 15 minutes to be
logged and sent.

Note: There is no failure notification when you disable periodic replication.
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Initiate Replication Method

The initiate replication method requires that administrators use the Security Console to start replicating RADIUS
data to the RADIUS replica servers. You can use this method regardless of whether periodic replication is
enabled or RADIUS data has been changed. If a RADIUS replica server is offline for a period of time and
therefore not up-to-date, once the RADIUS server is available, initiating replication sends the latest RADIUS data
to all RADIUS replica servers in the deployment.

Out-of-Date RADIUS Replica Servers

Data on a RADIUS replica server becomes out-of-date when the RADIUS replica server is unavailable for an
extended period of time, for example, it is offline or the RADIUS primary server cannot connect to the replica due
to a network issue.

A replica server that is unavailable cannot receive data from the RADIUS primary server. However, once the
RADIUS replica server becomes available, it checks for missed updates once per hour and initiates replication
when it finds more up-to-date data.

If the RADIUS data changes before the hour interval, the RADIUS replica server can still receive the updates
through the replication method you configured.

Configure RSA RADIUS to Use System-Generated PINs
RSA RADIUS does not allow system-generated PINs by default. If you choose to allow system-generated PINs,
authentication will fail unless you change the RADIUS configuration file, securid.ini, on each RADIUS server to
allow system-generated PINs, and then restart RADIUS.

Before you begin

You must be a Super Admin.

Procedure

1. Log on to the Operations Console on the RSA Authentication Manager instance hosting the RADIUS
server.

2. Click Deployment Configuration > RADIUS Servers.

3. If prompted, enter your Super Admin User ID and password.

4. Select the server hosted on this instance, and clickManage Server Files from the context menu.

5. In the Configuration Files tab, select the securid.ini file, and click Edit from the context menu.

6. Find the following line:

AllowSytemPins = 0

The 0 indicates that system-generated PINs are not allowed. To allow system-generated PINS, change
the setting to the following:

AllowSystemPins = 1

The 1 indicates that system-generated PINs are allowed.

7. Click Save and Restart RADIUS.

8. Restart the RADIUS server for the changes to take effect.
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Restart a RADIUS Server
RSA RADIUS servers start automatically when the RSA Authentication Manager starts. You need to restart the
RADIUS server in the following situations:

l After changing the port assignments on a RADIUS server.

l After making changes to RADIUS server files (.ini, .dct, or .aut).

l After replacing the RADIUS server certificate.

l If the RADIUS server stops.

Before you begin

You must be a Super Admin.

Procedure

1. In the Operations Console that is on the RSA Authentication Manager instance hosting the RADIUS
server, click Deployment Configuration > RADIUS Servers.

2. If prompted, enter your Security Console User ID and password, and clickOK.

3. Click the RADIUS server that you want to restart, and select Restart Server from the context menu.

4. In the Restart RADIUS Server page, under Confirmation, select Yes, restart RADIUS Server, and click
Restart Server.

RADIUS Clients

A RADIUS client is a RADIUS-enabled device at the network perimeter that enforces access control for users
attempting to access network resources.

A RADIUS client can be one of the following:

l VPN server

l Wireless access point

l Network access server supporting dial-in modems

l Dial-in modem

A RADIUS client sends a user’s access request to the RADIUS server. The RADIUS server forwards the request
to RSA Authentication Manager for validation.

If Authentication Manager validates the access request, the RADIUS client accepts the user’s request for
network access. Otherwise, the RADIUS client rejects the user’s request for network access.

You can configure RADIUS clients with or without an assigned authentication agent. The difference between the
twomethods is in the level of access control and logging you want to have.

l RADIUS client with an agent. Adding an agent to a RADIUS client allows Authentication Manager to
determine which RADIUS client is used for authentication and to save this information in log files.
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When you add a RADIUS client, you have the option to create an associated agent. If you manually
configure an agent with the same hostname and IP address as the RADIUS client, the agent is
automatically recognized as a RADIUS client agent.

For more information, see Add a RADIUS Client below.

l RADIUS client without an agent. Without an assigned RADIUS client agent, Authentication Manager
cannot track which RADIUS client sends authentication requests and you cannot assign a profile to the
client. The RADIUS server simply confirms that the shared secret from the RADIUS client matches the
shared secret stored in RSA RADIUS, and then forwards the request without any client information to
Authentication Manager.

All authentication requests appear to be coming from the RADIUS server through its assigned
authentication agent. While using this method, if you add an agent to a RADIUS client in the Security
Console, Authentication Manager does not associate the agent with the client, so it does not apply any of
the agent properties that you specify to the client.

To allow the system to authenticate users from clients with no assigned agent, you must set the SecurID.ini
file parameter CheckUserAllowedByClient to 0. By default, this parameter is set to 1, which allows the system to
authenticate users from clients with an assigned agent. For more information, see the RSA Authentication
Manager RADIUS Reference Guide.

If you need to add a large number of RADIUS clients to Authentication Manager, you might not want to assign
agents to RADIUS clients. For example, you are an ISP administrator and need to add and configure one
thousand network access servers with the RSA RADIUS server. Instead of adding an agent to each RADIUS
client, you select ANY RADIUS client, and enter the same shared secret for each RADIUS client. When an ANY
client sends a network request to its associated RADIUS server, the RADIUS server confirms the shared secret
and forwards the request without any client information to Authentication Manager.

Add a RADIUS Client
You must add a RADIUS client to the deployment for each RADIUS device that is configured to use RSA SecurID
as its authentication method. The RADIUS client sends authentication requests to the RSA RADIUS server, which
then forwards the request to RSA Authentication Manager.

If you want to use risk-based authentication (RBA), RBA must be enabled for the agent associated with the
RADIUS client.

Before you begin

(Optional) Before you can add a RADIUS client with an IPv6 address, you must create IPv6 network settings on
each primary and replica instance in your deployment. For instructions, see the Help topic "Create IPv6 Network
Settings on a Primary or Replica Instance."

Procedure

1. In the Security Console, click RADIUS > RADIUS Clients > Add New.

2. In the Client Name field, enter the name of the client, for example, VPN-London. If you are creating the
<ANY> client in step 3, do not enter a name.

The name can contain letters, digits, hyphens (–), and underlines(_). Spaces, tabs, @ signs, most
symbols, and non-printable characters are not allowed. This field is limited to 50 characters.
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After you save the client, you cannot change its name. If you want to rename the client, you must delete
it and then add a new client with the new name.

3. (Optional) Select the ANY Client checkbox if you do not want to track which RADIUS client sends
authentication requests (for example, because you want to quickly add many RADIUS clients).
Authentication requests using the shared secret specified for the <ANY> client are processed
regardless of the originating client’s IP address.

You cannot enter an IP address if you select ANY Client because the IP address is not applicable. Go to
step 5.

If you select this option, you also need to disable proxy authentication so that the RADIUS server does
not authenticate on behalf of this RADIUS client. For more information, see RADIUS Clients.

4. In the IP Address Type field, select the RADIUS client IP address type that is required by your agents.

l If this is an IPv4 RADIUS client, do the following:

a. Select IPv4.

b. In the IPv4 Address field, enter the IPv4 address of the RADIUS client, for example,
111.222.33.44.

l If this is an IPv6 RADIUS client, do the following:

a. Select IPv6.

b. In the IPv6 Address field, enter the IPv6 address of the RADIUS client, for example,
2001:0db8:85a3:0000:0000:8a2e:0370:7335.

In addition to the IPv6 address that you enter, Authentication Manager automatically creates an
IPv4 address for the RADIUS client. This IPv4 address begins with the number “255,” and it is
not used for communication with agents. Authentication Manager uses this number to identify
the RADIUS client.

5. In theMake/Model drop-down list, select the type of RADIUS client. If you are unsure of the make and
model of the RADIUS client, select Standard Radius.

The RADIUS server uses the make and model to determine which dictionary of RADIUS attributes to use
when communicating with this client.

6. In the Shared Secret field, enter the authentication shared secret (case-sensitive password) that you
specified during the RADIUS client installation and configuration.

The RADIUS client uses the same shared secret when communicating with the RADIUS primary server or
RADIUS replica server.

7. If you want to use a different shared secret (other than the one specified in step 6) for accounting
transactions between the RADIUS client and RADIUS server, select Accounting.

In the Accounting Shared Secret field, enter the accounting shared secret that you entered during
the RADIUS client installation and configuration. The RADIUS client uses the same shared secret when
communicating with the RADIUS primary server or RADIUS replica server.

8. Select Client Status to specify how many seconds the RADIUS server maintains the client connection
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without receiving a keepalive packet from the RADIUS client.

In the Inactivity Time field, enter the number of seconds. Enter a slightly higher value than the
keepalive value specified in the RADIUS client configuration. If you choose a time frame that is too short,
the server might close valid connections. For more information, see the RADIUS client documentation.

9. In theNotes field, enter any notes for this client, for example, “Located at London site.”

10. To save your changes, do one of the following:

l Click Save and Create Associated RSA Agent. This choice allows Authentication Manager to
determine which RADIUS agent is used for authentication and to log this information. This option
is required if you want to use risk-based authentication (RBA).

l Click Save only if you have disabled proxied authentication (by setting the securid.ini file
parameter CheckUserAllowedByClient to 0). In this case, you cannot assign a profile to this
client, and all authentications appear to Authentication Manager as though they are coming from
the RADIUS server.

After you finish

l If you created an associated RSA agent for this RADIUS client, you must configure the agent.

l Once configured, replication takes place every 15 minutes. If you want to manually initiate replication to
notify the RADIUS replica servers about this new client, see the Help topic "Initiate Replication to
RADIUS Replica Servers."

EAP-POTP Settings
Extensible Authentication Protocol (EAP) is an authentication framework that supports multiple authentication
methods. This allows RADIUS to support new authentication methods without requiring any changes to the
RADIUS protocol or RADIUS servers. EAP-POTP defines the method for one-time password (RSA SecurID)
authentication and provides the following capabilities within RSA RADIUS:

l End-to-end protection of one-time password

l Mutual authentication

l Session key derivation for 802.1x (wireless)

l Support for token exception cases (for example, New PIN or Next Token code)

l Fast session resumption if a wireless connection is lost

EAP-POTP settings define basic parameters for keying material (and keys) protecting one-time passwords used
for authentication.

The default values balance security (cryptographic strength) with system responsiveness and are considered
satisfactory for most environments. You may increase or decrease EAP-POTP default values. However, even
slight changes to values used for key generation may cause a large change in response time during
authentication. EAP-POTP settings affect the entire deployment.

Note: RSA RADIUS does not support the Filter-ID attribute when using EAP authentication methods.
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EAP-TTLS Configuration
You can configure the RSA RADIUS server to handle Extensible Authentication Protocol-Tunneled Transport
Layer Security (EAP-TTLS) authentications. RSA RADIUS requires the following certificates to handle
authentication requests made using the EAP-TTLS protocol:

l A server certificate for each RADIUS server, which is used by a RADIUS client to verify the identity of the
RADIUS server. A server certificate is installed on each RADIUS server by default.

l A trusted root certificates, which is used by a RADIUS server to verify the identity of a RADIUS client.
Root certificates are not installed on the RADIUS server by default.

Replace a RADIUS Server Certificate
A RADIUS server certificate is presented to a RADIUS client by RSA RADIUS so that the client can verify the
identity of the RADIUS server. You can use the Operations Console to replace the existing server certificate of a
RADIUS Server with a different certificate. For example, you might prefer to assign a certificate that has your
organization as its trusted root signer. RSA RADIUS does not replicate the server certificate. You must access
each RADIUS server directly and perform the following procedure.

Before you begin

l You must be a Super Admin.

l Make sure you have a keystore (.pfx) file that contains the new server certificate and the associated
private key. This file should be in PKCS #12 file format and contain the replacement certificate and
private key only. If the keystore contains more than one certificate, the wrong certificate may be used as
the replacement server certificate.

l Add a trusted root certificate to the system. Add the certificate used to sign the replacement server
certificate. The signing certificate must be in DER format and have a .der extension. If the replacement
certificate is self-signed, you do not need to add the signing certificate.For instructions, see Add a
Trusted Root Certificate on the facing page.

Procedure

1. On the primary instance Operations Console, click Deployment Configuration > RADIUS Servers.

2. If prompted, enter your Security Console User ID and password, and clickOK.

3. Click the RADIUS server whose certificate you want to replace, and selectManage EAP Certificates
from the context menu.

4. In the Manage EAP Certificates page, click the Server Certificate tab.

5. Under Replace Server Certificate, click Browse to locate the keystore file containing the replacement
certificate and associated private key.

You must select a keystore that is in PKCS #12 certificate store format, with a .pfx suffix.

6. Enter the password for the keystore file containing the replacement certificate in the Keystore
Password field.

7. Click Save & Restart RADIUS Server.
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The RADIUS server must restart for the change to take effect.

8. Repeat this procedure for each RSA RADIUS server in the deployment.

Add a Trusted Root Certificate
A trusted root certificate is used by a RADIUS server to verify the identity of a RADIUS client. Use the Operations
Console to add trusted root certificates for RSA RADIUS. By default, RSA RADIUS contains no trusted root
certificates. You can add as many certificates as you need. You need to add a trusted root certificate on the
primary instance only. RSA RADIUS replicates trusted root certificates to all RSA RADIUS servers in the
deployment.

Before you begin

l You must be a Super Admin.

l Verify that the certificate meets the following requirements:

l certificate is in DER format.

l certificate file has a .der extension.

Procedure

1. Log on to the Operations Console on the Authentication Manager primary instance.

2. Click Deployment Configuration > RADIUS Servers.

3. If prompted, enter your Super Admin User ID and password.

4. Select the primary RADIUS server, and clickManage EAP Certificates from the context menu.

5. In the Manage EAP Certificates page, click the Trusted Root Certificates tab.

6. Click Browse to locate and select the certificate that you want to add.

7. Click Add to add the certificate to the server.

8. When you are finished adding trusted root certificates, click Done.

RADIUS Profiles

A RADIUS profile is a named collection of attributes that specify session requirements for users authenticating
using RADIUS. When you create or update a profile, you can add, remove, or modify attributes and their values
within checklists and return lists.

Profiles support easy administration of groups of users. An administrator creates a profile with a checklist and a
return list of attributes suitable for a specific group of users, and then assigns the profile to relevant user
identities defined within Authentication Manager. Available checklist and return list attributes appear in the
Security Console in the drop-down list on the management pages for creating and updating profiles.

Profiles are synchronized across all RSA RADIUS servers in the deployment. The profile names reside on
Authentication Manager so that they can be centrally managed from the Security Console. RSA RADIUS, when
shipped, contains no profiles. You create profiles using the Security Console.
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RADIUS Attributes
RSA RADIUS provides more flexibility in controlling system behavior during authentication through the use of
single-value and multiple-value attributes and orderable multiple-value attributes.

l Single-Value and Multiple-Value Attributes

Attributes can be single-value or multiple-value. Single-value attributes appear only once in the
checklist or return list.Multiple-value attributes may appear several times. If an attribute appears more
than once in the checklist, this means that any one of the values is valid. For example, you can set up a
checklist to include multiple telephone numbers for the attribute Calling-Station-ID. Because all of the
telephone numbers are valid, a user trying to dial in to your network can call from any of the designated
telephone numbers and still authenticate successfully.

If an attribute appears more than once in the return list, each value of the attribute is sent as part of the
response packet. For example, to enable both IP and IPX header compression for a user, the Framed-
Compression attribute must appear twice in the return list: once with the value VJ-TCP-IP-header-
compression and once with the value IPX-header-compression.

l Orderable Multiple-Value Attributes

Certain multiple-value return list attributes are also orderable, which means that the attribute can
appear more than once in a RADIUS response, and the order in which the attributes appear is important.
For example, the Reply-Message attribute allows text messages to be sent back to the user for display. A
multiline message is sent by including this attribute multiple times in the return list, with each line of the
message in its proper sequence.

RADIUS Checklist
The RADIUS checklist is the set of attributes that must be sent from a RADIUS client to a RADIUS server as part
of an authentication request. If a required attribute is not present, the request is rejected. For example, the
checklist attribute, NAS-IP-Address, specifies the IP address of a RADIUS client that the user is allowed to use.
If this attribute is not in the access request, the request is rejected.

The RADIUS server examines authentication requests from RADIUS clients to confirm that attributes and values
defined in a profile as checklist attributes are contained in the authentication request.

By default, a RADIUS client sends all available attributes and values with authentication requests. If a RADIUS
client is configured to not send some attribute and that attribute is defined as a checklist attribute, the
authentication request fails. See the RADIUS client device documentation for procedures on how to configure a
RADIUS client.

You can assign an attribute to the checklist by adding the attribute to a RADIUS profile and then assigning the
profile to a user or agent.

RADIUS Return List
The RADIUS return list is the set of attributes that a RADIUS server returns to a RADIUS client when a user is
authenticated. Return list attributes provide additional parameters, such as VLAN assignment or IP address
assignment, that the RADIUS client needs to connect the user. When authentication succeeds, RADIUS sends
return list attributes to the RADIUS client along with the Access-Accept message for use in setting session
parameters for that user.

You can add an attribute to the return list in two ways:
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l Add the attribute to the return list in a profile and assign the profile to a user or agent. For more
information, see Add a RADIUS Profile below and RADIUS Profile Associations on the next page.

l Assign a user attribute, either a standard user attribute or a custom user attribute, to a user directly.
For more information, see RADIUS User Attributes on page 99.

Note: The purpose and use of specific attributes is described in the documentation for particular RADIUS client
devices and is outside the scope of this guide.

Default Profile
RSA RADIUS supports a default profile. When a RADIUS user authenticates and has no assigned profile, the user
receives the attributes and values that are defined in the default profile, if one is specified.

There is no default RADIUS profile specified during installation. Administrators must create the default profile
and specify it as the default. Once you have added one or more RADIUS profiles to Authentication Manager, you
can specify the default profile on the System Settings page in the Security Console. However, you can also
specify a default profile in the securid.ini RADIUS configuration file. The default profile specified in
Authentication Manager always overrides any default profile specified in the securid.ini file.

Administrators can add, remove, or modify attributes and their values within checklists and return lists for the
default profile in the samemanner as for regular profiles.

For more information on setting a default RADIUS profile, see the Help topic "Configure RADIUS Settings."

Dictionary Files to Customize Attributes
RSA RADIUS provides standard RADIUS attributes defined in dictionary files provided with the server. These
standard attributes are sufficient to support most major brands of RADIUS client devices. If you purchase a new
or specialized RADIUS client device, that device may also have its own dictionary file that contains client-specific
attributes. You can install that dictionary file on each of the RADIUS servers so that new or changed RADIUS
client attributes are available for inclusion in profiles.

In some rare cases, attribute names in RADIUS may differ from attribute names used by a particular RADIUS
client. The Operations Console allows administrators to modify attributes defined in dictionary files.

Add a RADIUS Profile
A RADIUS profile is a named collection of attributes that specify session requirements for a user requesting
remote network access. Attributes are contained in a checklist or return list.

You can add a profile to create a collection of checklist and return list attributes that you want to assign to users,
user aliases, trusted users, or agents.

Procedure

1. In the Security Console, click RADIUS > RADIUS Profiles > Add New.

2. In the Profile Name field, enter a unique name that identifies the purpose for this profile, for example,
SALES.

After you save the profile, you cannot change its name. If you want to rename the profile, you must
delete it and then add a new profile with the new name.

3. In theNotes field, enter any notes for this profile, for example, Use this profile for all employees in
Sales.
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4. In Return List Attributes, do one of the following:

l If you want to add an attribute, select each return list attribute, enter its corresponding value for
this profile, and click Add. For more information about the attributes and their values, see the
RADIUS client documentation.

l If you want to remove an attribute, select the attribute from the list box, and click Remove.

l If you want to update an attribute, select the attribute from the list, enter the updated value in
the field, and click Update. If you enter a multivalued return list attribute (marked with an M)
that is orderable (marked with an O), click Up or Down to specify the necessary order for the
attribute and its value.

l If you do not want to specify a particular value, but want to make sure that the attribute value in
the RADIUS request is echoed to the client in the RADIUS response, select Echo for the attribute.

5. In Checklist Attributes, do one of the following:

l If you want to add an attribute, select each checklist attribute, enter its corresponding value for
this profile, and click Add. For more information about the attributes and their values, see the
RADIUS client documentation.

l If you want to remove an attribute, select the attribute from the list box, and click Remove.

l If a RADIUS client does not send one of these attributes (for example, Port-Limit), and you select
Default for the attribute (for example, Port-Limit), the RADIUS server still processes the
authentication request. If a RADIUS client does not send one of these attributes, and you do not
select Default for the attribute, the RADIUS server rejects the authentication request.

6. Click Save.

7. To notify the RADIUS replica servers about this new profile, initiate replication to the replica servers.
Once configured, replication takes place every 15 minutes. For instructions, see the Help topic, "Initiate
Replication to RADIUS Replica Servers."

RADIUS Profile Associations
You can associate RADIUS profiles with users and agents in your deployment by assigning a profile to them.
When you assign a profile to a user or agent, the RADIUS server uses the checklist and return list contained in
the profile whenever the user or agent attempts a RADIUS authentication. Assigning a profile designates the
checklist and return list contained in the profile as the set of attributes to be used when a RADIUS authentication
attempt is made.

An administrator can assign or unassign a profile to the following:

User. An account managed by the system that is usually a person, but may be a computer or a web service.

User Alias. Allows users to authenticate with their RSA SecurID tokens, but using User IDs other than their
own. For example, suppose you assign the alias “root” to certain administrators. The administrators can log on
using the User ID “root” and their own tokens.

Trusted User. A user from a different, trusted RSA Authentication Manager  deployment that can authenticate
to Authentication Manager through your deployment.

96 Chapter 5: Administering RSA RADIUS



RSA Authentication Manager 8.3 Administrator's Guide

Agent. A software application installed on a RADIUS client or server, which enables authentication with
Authentication Manager on the network server.

You can specify a default RADIUS profile that Authentication Manager assigns to a user's network request, if the
user and the agent (that the user sends the network request to) do not have an assigned RADIUS profile.

User Assignment

Users are defined within Authentication Manager and their association with the correct RSA SecurID token
record is maintained there. On the RADIUS pages in the Security Console, an administrator can associate a User
ID with a profile. This action applies the attributes of that profile to that user.

User Alias Assignment

User aliases allow a user to have multiple roles if necessary. For example, user Alice has a user identity Alice_
User and a user alias identity Alice_Admin. When Alice logs on as Alice_User, all of the attributes associated
with users are applied to her because her user identity is associated with a profile set up for users. When Alice_
Admin logs on, attributes more appropriate for administrators are applied to her because her user alias identity
is associated with a profile set up for administrators, for example, she can access IP addresses needed to
manage routers and VPN servers.

Trusted User Assignment

Within a trusted realm, users from another realmmay attempt to access resources using RSA RADIUS. How
RADIUS profiles are associated with these users depends on how these remote “trusted users” are defined in
the local realm.

A trusted user identity may be defined in Authentication Manager in advance, with a RADIUS profile associated
with that trusted user identity. That profile may be set up especially for trusted users giving them attributes
appropriate for trusted users. When that trusted user’s access request succeeds, RADIUS returns the
associated profile attributes to the RADIUS client device along with any assigned RADIUS user attributes.

If the trusted user identity is not set up in advance, the authentication agent on the RADIUS server creates a
trusted user account dynamically in Authentication Manager. In turn, Authentication Manager forwards the
authentication request to other trusted realms until a success or failure is returned. When the request is
successful, Authentication Manager adds the trusted user’s home realm to the trusted user identity (to speed
up future authentication requests) and returns a passcode accepted message to RADIUS.

If an agent profile is associated with the RADIUS client (the VPN server, wireless access point, or network
access servers supporting dial-in modems) used by the trusted user, the trusted user receives the attributes of
that profile. Otherwise, the user receives the default profile, if one is specified.

Authentication Agent Assignment

Assigning a profile to an authentication agent causes the attributes in the profile to be assigned to all users
authenticating using that specific RADIUS client device.

Profile Priority

To avoid conflicts in cases where a profile for users and a profile for an agent could both be applied to a user, for
example, you assign a RADIUS profile to a user, and the user requests network access from a RADIUS client with
an agent that has a different assigned profile. To prevent profile conflicts, specify the profile precedence.

Profile Assignment Example

The following figure shows how RADIUS applies profiles to users based on associations of profiles to users and
agents (RADIUS clients).
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l Jim is not explicitly associated with a profile. He authenticates through VPN2 that does have an explicitly
associated profile, so he gets the profile for VPN agents.

l Liz_Admin is explicitly associated with the profile for Administrators. She is authenticating through a
wireless access point that also has an explicitly associated profile. As both profiles could be applied to
Liz Admin, the precedence mechanism determines which profile is applied.

l Michelle does not have an associated profile. She is authenticating through VPN3 that also does not have
an explicitly associated profile for agents. RADIUS applies the default profile because no other profile
applies to Michelle.

Specify the Default RADIUS Profile
Specify the default RADIUS profile that the RADIUS server assigns to a user's network request, if the user and
the agent (that the user sends the network request to) do not have an assigned RADIUS profile.

Before you begin

You must be a Super Admin.
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Procedure

1. In the Security Console, click Setup > System Settings.

2. Under Advanced Settings, click RADIUS.

3. Select the profile from the Selected RADIUS Profile drop-down menu for Default RADIUS Profile.

4. Click Save.

RADIUS User Attributes

RSA RADIUS supports standard and custom RADIUS attributes.

l Standard. Attributes with fixed names and assigned ID numbers specified by the RADIUS protocol. For
more information, see the RADIUS client device documentation.

l Custom. Attributes defined by a RADIUS client manufacturer that are not included in the RADIUS
protocol. If you want to use these custom attributes, you define them through the Security Console, and
then assign them to a user or trusted user. The user alias of a user is also assigned these custom
attributes. For more information, see the Help topic "Edit a Custom RADIUS User Attribute Definition." 

If you have attributes that you want to assign to more than one user, user alias, trusted user, or agent, you can
create a profile with the attributes and assign the profile to the object.

If you want to assign specific standard or custom attributes to only one user or trusted user, you can assign
these RADIUS attributes to a user or trusted user outside of a RADIUS profile. RADIUS attributes that you assign
to a user or trusted user outside of a profile are called RADIUS user attributes. When you can assign RADIUS
user attributes to a user, any user alias of the user is also assigned the attributes. You cannot assign user
attributes to an agent. RSA Authentication Manager automatically assigns the attribute with its value to user
aliases associated with the user object.

You can define a RADIUS user attribute in two ways:

l Without an actual value

When this attribute is assigned to a user, the administrator can enter the value appropriate for that
user. For example, if the RADIUS user attribute is Callback Number, the administrator enters the user’s
callback phone number when he or she applies the attribute to the user. (RADIUS can use a callback
number to ensure that a user is calling from a specific phone number). RADIUS user attributes override
profile attributes with the same name.

l Mapped to data stored in an identity source

In this case, the attribute returns information that is already stored in an identity source, such as an
LDAP corporate identity database, avoiding the need to maintain attribute values in multiple places.

The RADIUS server sends RADIUS user attributes along with the profile return list attributes to a RADIUS client.
These assigned RADIUS user attributes override attributes assigned to the user or trusted user through
profiles.

You can also map a RADIUS user attribute definition to an identity source attribute. The RADIUS server applies
the value of the identity source attribute to the RADIUS user attribute definition. For example, you can map the
RADIUS Callback-ID attribute to the Phone Number attribute in the LDAP corporate database. If you do not map a
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RADIUS user attribute definition to an identity source attribute, when you assign the RADIUS attribute to the
user or trusted user, you must enter the attribute value.

User Attribute Assignment Example
The following figure shows the relationship of profile return list attributes and RADIUS user attributes when
user Alice authenticates using RADIUS. Alice is assigned RADIUS user attributes a and b (attribute c is assigned
to someone else). When Alice authenticates successfully, she gets all of the profile attributes and RADIUS user
attributes a and b. The value for RADIUS user attribute b is taken from an LDAP identity store.

Add a Custom RADIUS User Attribute Definition
RADIUS user attributes can be assigned to user outside of the user’s assigned RADIUS profile. For example, you
might want to add a callback telephone number attribute to later individually assign to users with their specific
telephone numbers.

A custom RADIUS user attribute can be either of the following:

l A new, non-standard RADIUS attribute (value of 64 to 255) that you add a to a RADIUS dictionary.

l A non-standard RADIUS attribute that exists in a RADIUS dictionary.

You can add a custom user attribute definition with or without an actual value, or map it to an attribute in an
LDAP directory.

Before you begin

l When the custom RADIUS attribute is a new attribute, make sure that it does not conflict with an existing
attribute in the dictionary. If the dictionary contains an attribute that uses the same name or number as
the attribute that you want to add, comment out the conflicting attribute.

l When you create a new custom attribute, for each RADIUS client type that uses the attribute, add a
RADIUS attribute definition to the RADIUS dictionary for that client type. You must add the attribute to
the dictionary on each RSA RADIUS server. For instructions, see the Help topic "Add a RADIUS Attribute
Definition to a Dictionary." 
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Procedure

1. In the Security Console, click RADIUS > RADIUS User Attribute Definitions > Add New.

2. In theNumber field, enter a number between 64 and 225.

3. In the Attribute Name field, enter a name that describes the function of the attribute.

Enter a name that is different from the standard RADIUS attribute names.

4. In theMap to Identity Attribute section, select whether to map the custom attribute to an identity
source attribute or to manually enter the attribute value, and do one of the following:

l If you select Yes, select the identity attribute to which you want to map the RADIUS attribute,
and enter any notes about this attribute mapping, for example, Mapped to telephone number in
HR database.

l If you select No, enter the default value and any notes about this attribute, for example, User's
office telephone number as of October 1, 2012.

5. Click Save.

After you finish

If you do not enter the value when you add the definition, you must enter the attribute value when you assign
the attribute to a user or trusted user. For more information, see Assign RADIUS User Attributes to Users below.

Assign RADIUS User Attributes to Users
You can assign standard or custom RADIUS attributes to a user. For example, you might assign the Callback-
Number attribute to a user with the value as the user's individual office telephone number. RSA Authentication
Manager automatically assigns the attribute with its value to user aliases associated with the user object.

If you assign a user to a RADIUS attribute both in a RADIUS profile and as a RADIUS user attribute, the RADIUS
server applies the value that you specify in the RADIUS user attribute definition.

Before you begin

Enable RADIUS user attributes. For more information, see the Help topic "Enable or Disable RADIUS User
Attributes."

Procedure

1. In the Security Console, click Identity > Users > Manage Existing.

2. Click the user to which you want to assign an attribute.

3. From the context menu, click Authentication Settings.

4. In RADIUS User Attributes, do one of the following:

l If you want to add an attribute, select the attribute that you want to assign to the user, enter the
value for the attribute in the Value field, and click Add.

l If you want to remove an attribute, select the attribute from the list, and click Remove.
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l If you want to update an attribute, select the attribute from the list, enter the value in the field,
and click Update.

A RADIUS user attribute can be mapped to an identity source attribute. For more information, see Map a
RADIUS User Attribute Definition to an Identity Source Attribute below.

5. Click Save.

Map a RADIUS User Attribute Definition to an Identity Source Attribute
You can map a RADIUS user attribute definition to an identity source attribute. For example, you can map the
RADIUS Callback-ID attribute to the Phone Number attribute in the corporate LDAP directory.

If you do not map a RADIUS user attribute definition to an identity source attribute, when you assign the RADIUS
attribute to the user, you must enter the attribute value.

Procedure

1. In the Security Console, click RADIUS > RADIUS User Attribute Definitions > Manage Existing.

2. Click Standard Attributes or Custom Attributes.

3. Click the attribute that you want to map.

4. From the context menu, click Edit.

5. In Map to an Identity Attribute, select Yes.

6. From the Select an Identity Attribute list, select the identity attribute for which you want to map the
RADIUS attribute.

7. Click Save.

RADIUS Server Authentication Statistics

Authentication statistics summarize the number of authentication acceptances and rejections, with summary
totals for each type of rejection or retry.

The following table describes the authentication statistics fields and the possible causes for some authentication
rejections.

Authentication
Statistic

Meaning

Transactions

Accepts
The current, average, and peak number of RADIUS transactions that resulted in an accept
response.

Rejects
The current, average, and peak number of RADIUS transactions that resulted in a reject
response. These are detailed in the Reject Details section.

Overall

Total
Transactions

The sum of the accept, reject, and silent discard totals.

Silent Discards
The number of requests in which the client could not be identified. This might occur if a
RADIUS client entry cannot be found for a device with the name, IP address, or both of a
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Authentication
Statistic

Meaning

device requesting authentication services.

Challenges The number of challenges received from RADIUS clients.

Reject Details

Dropped Packet
The number of RADIUS authentication packets dropped by RADIUS because the server was
flooded with more packets than it could handle.

Invalid Request

The number of invalid RADIUS requests made.

Possible Cause: A device is sending incorrectly formed packets to RADIUS. Either there is a
configuration error or the device does not conform to the RADIUS standard.

Failed
Authentication

The number of failed authentication requests, where the failure is due to invalid user name or
password.

Possible Cause: If all transactions are failing authentication, the problemmight be that the
shared secret entered into RADIUS does not match the shared secret entered on the client
device.

Failed on
Checklist

The number of requests that were authenticated but failed to meet the checklist
requirements.

Insufficient
Resources

The number of rejects due to a server resource problem.

Rejects Sent

Transactions
Retried

The number of requests for which one or more duplicates was received.

Total Retry
Packets

The number of duplicate packets received.

RADIUS Client Statistics

The Security Console displays statistics for the RSA RADIUS clients in RSA Authentication Manager. The
statistics contain authentication and accounting data for RADIUS clients.

The Security Console begins tracking the statistics after an administrator starts the RADIUS server that is
associated with the RADIUS client. When an administrator restarts the RADIUS server, the Security Console
clears the statistics and begins the tracking again. You can record statistics in RADIUS log files.

When displaying RADIUS client statistics, the Security Console allows you to choose from the following four
types:

l Accounting Request Diagnostics

l Account Request Types

l Authentication Request Diagnostics

l Summary

To view RADIUS client statistics, see the Help topic "Edit a Standard RADIUS User Attribute Definition." You can
can view subsets of authentication and accounting statistics.
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Authentication Statistics
Authentication confirms that valid users request network services. Authentication statistics include the
following.

Statistic Description

Authentication Request Diagnostics

Retry
packets

Number of duplicate messages sent by the client to its associated RADIUS server.

Invalid
secrets

Number of messages with invalid accounting secrets sent by the client to its associated RADIUS
server.

Challenges Number of challenges sent by the client to its associated RADIUS server.

Invalid
requests

Number of invalid RADIUS requests made by this RADIUS client. For example, the client is sending
incorrectly formed packets to the RADIUS server because there is a configuration error or the device
does not conform to the RADIUS standard.

Invalid
types

Number of invalid accounting types sent by the client to its associated RADIUS server. For example,
the client sends a RADIUS packet on the server accounting port that is not a RADIUS Accounting-
Request packet.

Dropped
Packets

Number of RADIUS accounting packets dropped by the RADIUS client because it received more
packets than it could handle.

Accounting Statistics
Accounting tracks the network resources used by users. Accounting statistics include the following.

Statistic Description

Accounting Request Diagnostics

Retry
packets

Number of duplicate packets sent by the client to its associated RADIUS server.

Invalid
secrets

Number of failed authentication requests sent by this client, where the failure is due to using an
invalid secret.

Invalid
requests

Number of invalid RADIUS requests that this client sent to its associated server. For example, the
client sends a request that does not parse properly.

Invalid
types

Number of invalid authentication types sent by the client to its associated RADIUS server. For
example, the client sends a request to the wrong port on the server.

Dropped
packets

Number of RADIUS authentication packets sent by the client to its associated RADIUS server that the
server drops for various reasons, such as a resource error.

Accounting Request Types

Starts Number of accounting start messages sent by the client to its associated RADIUS server.

Stops Number of accounting stop messages sent by the client to its associated RADIUS server.

Interim
requests

Number of interim accounting packets sent by the client to its associated RADIUS server.

Ons
Number of Accounting-On messages sent by the client to its associated RADIUS server when the
RADIUS client restarts.

Offs
Number of Accounting-Off messages sent by the client to its associated RADIUS server when the
RADIUS client shuts down.

Acks Number of acknowledgement messages that the associated RADIUS server sent to this client.
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Summary Statistics
Summary statistics include information about authentication and accounting requests, accepts and rejects.

Statistic Description

Auth
reqs

Total number of authentication requests sent by this client to its associated RADIUS server.

Accepts Number of accept messages that the client received from its associated RADIUS server.

Rejects Number of reject messages that the client received from its associated RADIUS server.

Acct
Reqs

Total number of accounting requests sent by the client to its associated RADIUS server.

Starts
Number of transactions handled by this client in which a dial-in connection was started following a
successful authentication.

Stops
Number of transactions handled by this client in which a dial-in connection was terminated by the
RADIUS client.

Accounting Attributes and Administrator Actions to Record
When users authenticate, RADIUS clients send attributes for each user authentication attempt. RADIUS servers
collect this information and can save as much or as little as needed for billing or monitoring purposes. The
server writes the information to a comma-delimited file suitable for inclusion in a spreadsheet or other
application.

RADIUS log files record administrator actions including authentications and any changes made using the
Security Console or Operations Console.

The following table describes the files that establish settings for accounting and logging. For more information
on modifying configuration files, see the RSA Authentication Manager RADIUS Reference Guide.

Filename Function

account.ini Controls how RADIUS accounting attributes are logged.

radius.ini
Controls (among other things) the types of messages that RADIUS records in the server log file and
the location of the log directory.

RADIUS Server Log Files

The server log file records RADIUS events, such as server startup or shutdown or user authentication or
rejection, as a series of messages in an ASCII text file. Each line of the server log file identifies the date and time
of the RADIUS event, followed by event details. You can open the current log file while RADIUS is running.

You can specify a maximum size for a server log file by entering a non-zero value for the LogfileMaxMBytes
setting in the [Configuration] section of the radius.ini file.

l If a maximum file size is set, the server log filename identifies the date and time it was opened
(YYYYMMDD_HHMM.log). When the current server log file approaches the specified number of
megabytes (1024 x 1024 bytes), the current log file is closed and a new one is opened. The closed file
will be slightly smaller than the specified maximum file size.

l If the maximum file size is set to 0 (or if the LogfileMaxMBytes setting is absent), the server log file size
is ignored, and log filenames are date stamped to identify when they were opened (YYYYMMDD.log).

Note: The size of the log file is checked once per minute, and the log file cannot roll over more than once a
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minute. The log file may exceed the specified maximum file size temporarily (for less than a minute) after it
passes the LogfileMaxMBytes threshold between size checks.

You can control the level of detail recorded in server log files by use of the LogLevel, LogAccept, LogReject, and
TraceLevel settings.

The LogLevel setting determines the level of detail given in the server log file. The LogLevel can be the number
0, 1, or 2, where 0 is the least amount of information, 1 is intermediate, and 2 is the most verbose. The LogLevel
setting is specified in the [Configuration] section of radius.ini and in the [Settings] sections of .aut files.

The LogAccept and LogReject flags allow you to turn on or off the logging of Access-Accept and Access-Reject
messages in the server log file. These flags are set in the [Configuration] section of radius.ini. A value of 1
causes these messages to be logged, and a value of 0 causes the messages to be omitted. An Accept or Reject is
logged only if LogAccept or LogReject, respectively, is enabled and the LogLevel is “verbose” enough for the
message to be recorded.

The TraceLevel setting specifies whether to log packets when they are received and being processed, and what
level of detail to recorded in the log.

Using the Accounting Log File
RADIUS accounting events are recorded in the accounting log file. Accounting events include START messages,
indicating the beginning of a connection; STOPmessages, indicating the termination of a connection, and
INTERIM messages, indicating that a connection is ongoing.

Accounting log files use comma-delimited, ASCII format, and are intended for import into a spreadsheet or
database program. Accounting log files are located in the RADIUS database directory by default. Accounting log
files are named yyyymmdd.ACT, where yyyy is the 4-digit year, mm is the month, and dd is the day on which
the log file was created.

The current log file can be opened while RADIUS is running.

Accounting Log File Format
The first six fields in every accounting log entry are provided by RADIUS for your convenience in reading and
sorting the file:

l Date. The date when the event occurred

l Time. The time when the event occurred

l RAS-Client. The name or IP address of the RADIUS client sending the accounting record

l Record-Type. START, STOP, INTERIM, ON, or OFF, the standard RADIUS accounting packet types

l Full-Name. The fully distinguished name of the user, based on the authentication performed by the
RADIUS server

l Auth-Type. A number that indicates the class of authentication performed:

10—SecurID User

11—SecurID Prefix

12—SecurID Suffix

By default, the standard RADIUS attributes follow the Auth-Type identifier. For more information, see Standard
RADIUS Accounting Attributes on page 108.
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You can edit the account.ini initialization file to add, remove, or reorder the standard RADIUS or vendor-
specific attributes that are logged. For more information, see the RSA Authentication Manager RADIUS Reference
Guide.

Accounting Log File Headings and Placeholders
The first line of the accounting log file is a file header that lists the attributes that have been enabled for logging
in the order in which they are logged. The following example of a first line shows the required headings in bold
italic, the standard RADIUS headings in bold, and the vendor-specific headings in regular text:

"Date","Time", "RAS-Client", "Record-Type", "Full-Name", "Auth-Type",

"User-Name", "NAS-Port", "Acct-Status-Type", "Acct-Delay-Time",

"Acct-Input-Octets", "Acct-Output-Octets", "Acct-Session-Id",

"Acct-Authentic","Acct-Session-Time", "Acct-Input-Packets", "Acct-Output-Packets",

"Acct-Termination-Cause", "Acct-Multi-Session-Id",

"Acct-Link-Count","Acc-Err-Message",

"Nautica-Acct-SessionId","Nautica-Acct-Direction",

"Nautica-Acct-CauseProtocol","Nautica-Acct-CauseSource",

"Telebit-Accounting-Info","Last-Number-Dialed-Out",

"Last-Number-Dialed-In-DNIS","Last-Callers-Number-ANI",

"Channel","Event-Id","Event-Date-Time", "Call-Start-Date-Time","Call-End-Date-Time",

"Default-DTE-Data-Rate","Initial-Rx-Link-Data-Rate",

"Final-Rx-Link-Data-Rate","Initial-Tx-Link-Data-Rate",

"Final-Tx-Link-Data-Rate","Sync-Async-Mode",

"Originate-Answer-Mode","Modulation-Type",

"Equalization-Type","Fallback-Enabled","Characters-Sent",

"Characters-Received","Blocks-Sent","Blocks-Received",

"Blocks-Resent","Retrains-Requested","Retrains-Granted",

"Line-Reversals","Number-Of-Characters-Lost",

"Number-of-Blers","Number-of-Link-Timeouts",

"Number-of-Fallbacks","Number-of-Upshifts",

"Number-of-Link-NAKs","Back-Channel-Data-Rate",

"Simplified-MNP-Levels","Simplified-V42bis-Usage", "PW_VPN_ID"

RSA RADIUS writes accounting events to the accounting log file. If an event recorded in the accounting log file
does not have data for every attribute, a comma placeholder marks the empty entry so that all entries remain
correctly aligned with their headings. For example, based on the “first line” of headings shown in the example
above, the following is a valid accounting log entry, in which the value of the Acct-Status-Type attribute is 7:

"12/23/1997","12:11:55","RRAS","Accounting-On",

,,,,7,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,
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Standard RADIUS Accounting Attributes

The following table lists the standard RADIUS accounting attributes defined in RFC 2866, “RADIUS Accounting.”

RADIUS
Accounting
Attributes

Description

User-Name Name of the user as received by the client.

NAS-Port Port number on the client device.

Acct-Status-
Type

A number that indicates the beginning or ending of the user service:

1—Start

2—Stop

3—Interim-Acct

7—Accounting-On

8—Accounting-Off

Acct-Delay-Time
Number of seconds the client has been trying to send this record, which can be subtracted
from the time of arrival on the server to find the approximate time of the event generating this
request.

Acct-Input-
Octets

Number of octets (bytes) received by the port over the connection. This is present only in
STOP records.

Acct-Output-
Octets

Number of octets (bytes) sent by the port over the connection. This is present only in STOP
records.

Acct-Session-Id Identifier used to match START and STOP records in a log file.

Acct-Authentic

Indicates how the user was authenticated by RADIUS, the network access device (local) or
another remote authentication protocol:

1—RADIUS

2—Local

3—Remote

Acct-Session-
Time

Elapsed time of connection in seconds. This is present only in STOP records.

Acct-Input-
Packets

Number of packets received by the port over the connection. This is present only in STOP
records.

Acct-Output-
Packets

Number of packets sent by the port over the connection. This is present only in STOP records.

Acct-
Termination-
Cause

Number that indicates how the session was terminated. This is present only in STOP records:

1—User Request

2—Lost Carrier

3—Lost Service

4—Idle Timeout
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RADIUS
Accounting
Attributes

Description

5—Session Timeout

6—Admin Reset

7—Admin Reboot

8—Port Error

9—NAS Error

10—NAS Request

11—NAS Reboot

12—Port Unneeded

13—Port Preempted

14—Port Suspended

15—Service Unavailable

16—Callback

17—User Error

18—Host Request

Acct-Multi-
Session-Id

Unique accounting identifier to make it easy to link together multiple related sessions in a log
file.

Acct-Link-Count
The count of links that are known to have been in a given multilink session at the time the
accounting record is generated.
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Deployment Maintenance

RSA Authentication Manager includes features that enable you to perform systemmaintenance and disaster
recovery. Both the hardware appliance and the virtual appliance support these features, with the exception of
Amazon Web Services snapshots, VMware snapshots, Hyper-V checkpoints, PING backups, and hardware
appliance system image installation.

This chapter discusses the following features:

Replica Instance Promotion. You can promote a replica instance for maintenance if the primary instance and
all of the replica instances in the deployment are online and functioning normally. For more information, see
Promotion for Maintenance on the facing page.

If the primary instance is not functional, then you can promote a replica instance for disaster recovery. For more
information, see Replica Instance Promotion for Disaster Recovery on page 135.

Performing Backups. Authentication Manager can back up your deployment with a manual, one-time backup,
or a scheduled regular backup for the days and times that you specify. RSA recommends that you use the
Operations Console to maintain a current backup of Authentication Manager to restore your deployment in a
production environment. For instructions, see Create a Backup Using Back Up Now on page 125 and Create a
Backup Using Schedule Backups on page 126.

Amazon Web Services (AWS) Snapshots. On an AWS virtual appliance, you can create a snapshot to
capture the state of a primary or replica instance at a particular point in time. Snapshots do not replace the
Authentication Manager backup feature. For more information, see Primary or Replica Instance Amazon Web
Services Snapshots on page 127.

VMware Snapshots. On a VMware virtual appliance, you can take a VMware snapshot to capture the state of a
primary or replica instance at a particular point in time. Snapshots do not replace the Authentication Manager
backup feature. For more information, see Primary or Replica Instance VMware Snapshots on page 128.

Hyper-V Checkpoints. On a Hyper-V virtual appliance, you can create a checkpoint to capture the state of a
primary or replica instance at a particular point in time. Checkpoints do not replace the Authentication Manager
backup feature. For more information, see Primary or Replica Instance Hyper-V Checkpoints on page 128.

Restoring a Hardware Appliance. If a malfunctioning hardware appliance cannot be recovered, restore the
backup image that you created when you first deployed the appliance. For more information, see “Using PING to
Back Up and Restore the RSA Authentication Manager 8.2, 8.2 SP1, or 8.3 Hardware Appliance” on RSA Link:
https://community.rsa.com/docs/DOC-41697.

If a backup image is not available, you can download and install the original hardware appliance system image.
For instructions, see Hardware Appliance System Image Installation on page 152.

Restoring the Web Tier. If the primary and replica instances are functioning normally, but the web tier stops
responding, you can restore the web tier. For instructions, see Restore Web Tier on page 148.

Repairing Trusted Realm Relationships. If you change the hostname on a primary instance, then you must
repair any previously existing trust relationships with other realms. For more information, see Trusted
Relationship Repair on page 148.

112 Chapter 6: System Maintenance and Disaster Recovery

https://community.rsa.com/docs/DOC-41697


RSA Authentication Manager 8.3 Administrator's Guide

Promotion for Maintenance

Promotion for maintenance promotes a replica instance to a primary instance while the original primary instance
is online and functioning. An Operations Console administrator can initiate promotion for maintenance from the
Operations Console of the replica instance that is to be promoted. After promotion, the original primary instance
is demoted to a replica instance.

To perform a promotion for maintenance, the primary instance and all replica instances must be online and
functioning. During this promotion process, authentication, administration, and self-service on the primary and
replica instance involved in promotion will be unavailable, but authentication remains available on additional
replicas in your deployment. After promotion, the original primary instance is demoted to a replica instance and
is automatically synchronized with the new primary instance. All additional replica instances are automatically
connected to the new primary instance.

If your deployment includes a web tier, you must restart services for each web tier after promotion. You must
also initiate RADIUS data replication to synchronize the RADIUS server on each replica instance with the RADIUS
server on the new primary instance.

For more information, see RADIUS Data Replication on page 86.

Note: If your primary instance is not functioning, use the disaster recovery method option.

Things to Consider
Before you promote a replica instance to a primary instance, consider the following:

l If you have only one replica instance in your deployment, deploying another replica instance prior to
promotion allows authentication to remain available during the promotion process.

l There are two ways to transfer and copy log data. If you choose to automatically transfer and copy log
data, consider archiving logs to an NFS to conserve time and disk space during promotion. If you choose
to manually transfer and copy log data, SSH must be enabled. In this case, you must copy and transfer
the backup file from the original primary instance to a location supported by the backup and restore
feature on the new primary instance. You must also import the logs using the Operations Console of the
new primary instance.

l Back up the data in your current primary and save the backup file to a location outside of the appliance,
such as a Network File System (NFS) or Windows shared folder.

l If you have enabled critical system notifications, you may receive notifications for replication events.

l Download completed reports using the Security Console on the primary instance. The report results will
not be available on the new primary instance after promotion. For more information, see the Help topic
"View a Completed Report."

l If there are any completed Users/Tokens export jobs, download the export data files using the Security
Console on the primary instance. The export data files will not be available on the new primary instance
after promotion. For more information, see the Help topic "Exporting and Importing Users and Tokens
Between Deployments."

l Using the Security Console on the primary instance, disable any scheduled jobs such as reports, log
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archival, unresolvable users cleanup that may be scheduled to run during the period of planned
promotion. If there are any scheduled jobs currently running, wait until they complete before beginning
a promotion for maintenance. Any jobs that are in progress during the promotion are automatically
cancelled. For more information, see the Help topics "Reports," "Archive Logs Using Schedule Log
Archival," and "Schedule a Cleanup Job."

Promote a Replica Instance Using Promotion for Maintenance
For maintenance purposes, you can promote a replica instance to a primary instance while the original primary
instance is online and functioning.

Before you begin

l Ensure that the replica instance being promoted can reach the primary and all other replica instances. 
The primary and all other replica instances must be able to reach the replica instance being promoted.
Ports 7072, 7002, 7022, 1812, and 1813 must be reachable from the replica.  For more information, see
“Securing Connections Between the Primary and Replica Instances” in Port Usage in the RSA
Authentication Manager Setup and Configuration Guide.

l Communicate to all other Operations Console administrators that you are going to promote the replica.

l In the Operations Console on the original primary instance, click Maintenance > Backup and Restore
> Progress Monitor to ensure that backup or restore jobs are not running on the original primary
instance.  If a backup or restore job is running, wait for it to complete before promoting the replica
instance. 

l Disable any scheduled backup jobs on the original primary instance. To disable a scheduled backup job,
go to Maintenance > Backup and Restore > Schedule Backups.

l If there are any completed reports, download report results using the Security Console of the original
primary instance. The report results will not be available on the new primary instance after promotion. 
For more information, see the Help topic "View a Completed Report."

l If there are any completed Users/Tokens export jobs, download the export data files using the Security
Console of the original primary instance. The export data files will not be available on the new primary
instance after promotion.  For more information, see the Help topic "Exporting and Importing Users and
Tokens Between Deployments."

l Using the Security Console on the primary instance, disable any scheduled jobs such as reports, log
archival, unresolvable users cleanup that may be scheduled to run during the period of planned
promotion. If there are any scheduled jobs currently running, wait until they complete before beginning
a promotion for maintenance. Any jobs that are in progress during the promotion are automatically
cancelled. For more information, see the Help topics "Reports," "Archive Logs Using Schedule Log
Archival, and "Schedule a Cleanup job."

Procedure

1. In the Operations Console, go toDeployment Configuration > Replica Promotion > For
Maintenance > Promote to Primary.

2. Select the radio button for the log transfer option you want to use.
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l If you choose the manual log transfer option, you must enter and confirm a log backup
password. After promotion, you must manually transfer and add logs to the new primary
instance using the same password.

l If you choose the automatic log transfer option, logs are copied and transferred during
promotion. Consider archiving log data to conserve time during promotion. To archive now, in
the Security Console, click Administration > Archive Audit Logs > Archive Now.

3. Verify the instance details and click Run Pre-Promotion Check.

4. After the pre-promotion checks are complete, review the status. Depending on the status, do one of the
following:

l If the pre-promotion check completed successfully and you choose to promote this instance,
select the Yes, Promote this instance checkbox and click Start Promotion.

The Progress Monitor displays. You can only view the progress of the promotion operation on the
replica instance that you are promoting.

l If one or more of the pre-promotion checks fail, do the following in this order:

l Review the Advanced Status View to determine the errors that occurred.

l After reviewing the Advanced Status View, click Close to exit the window.

l On the Pre-Promotion Checks page, click the Cancel button.

l Fix any issues that caused the failure and return to this procedure to retry the promotion.

5. After promotion completes, do one of the following:

l If promotion completes successfully, clickNext to view the mandatory next steps.

l If promotion completes with warnings, review the warnings and clickNext to view the
mandatory next steps.

l If promotion fails, complete the steps mentioned in the error message.

6. Review the Summary page and complete the Required Next Steps.

7. To save a copy of the required next steps, click Download Next Steps.

After you finish

View the Next Steps for Promotion for Maintenance below

View the Progress Monitor for Promotion for Maintenance on page 117

View the Next Steps for Promotion for Maintenance
After promotion completes, you can view the Next Steps on the new primary instance. You cannot view these
Next Steps on any other instance besides the promoted instance.

The Next Steps differ based on your promotion process and deployment.

RSA recommends that you download the Next Steps for future reference. If you restart services on the instance,
these steps are no longer available for viewing or downloading.
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Before you begin

Promote a Replica Instance Using Promotion for Maintenance on page 114

Procedure

1. In the Operations Console on the new primary instance, click Deployment Configuration >
Promotion > For Maintenance > Progress Monitor, and then clickNext.

2. Complete the next steps that display.

RSA recommends that you click Download Next Steps to save a copy of the steps for future reference.

The following next steps are always required after a promotion for maintenance:

Task Instructions

Restore RADIUS replication
on the new primary instance

In the Security Console on the new primary instance, go to RADIUS >

RADIUS Servers and click Initiate Replication to synchronize the
replica RADIUS servers with the new primary instance.

If your deployment includes
web tiers, restart services
for each web tier.

See the Help topic "Managing the Web-Tier Service."

Review the instance-specific
system settings for the new
primary instance and update
any setting as needed.

Note: The new primary
instance does not inherit
these settings from the
original primary instance.

In the Security Console, go to Setup> System Settings, and review the
settings that are configured by instance.

For example, you may want to review and update the following instance-
specific settings:

l SNMP

l SMTP

l Caching

l Logging

l Session Handling

Verify your dynamic seed
provisioning configuration

1. In the Security Console, go to Setup> System Settings, and
under Authentication Settings, click Tokens.

2. Review the dynamic seed provisioning settings. If the fully
qualified hostname of the demoted primary instance is used,
update the setting with the fully qualified hostname of the new
primary instance. For further instructions, see the Help topic
"Configure Token Settings."

Depending on the outcome of the promotion, additional steps may also display.

If any of the following scenarios apply to the promotion that you completed, you must perform the
corresponding task:

Scenario Task Action

You chose to manually Restore logs The log backup file is created on the original primary instance.
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Scenario Task Action

copy and transfer log
data after promotion

Using methods like FTP, transfer the backup file to a supported
backup location. For instructions on restoring from a backup,
see Restore from Backup on page 130.

Note: SSH must be enabled to access the local file system on
the instance. To enable SSH, go to the Operations Console for
the instance and click Administration > Operating System
Access.

One or more additional
replica instances could
not be updated to point
to new primary
instance

Enable
communication
with replica
instances

For each additional replica instance that could not be updated,
log on to the Operations Console of the replica instance, click
Administration> Network> Update Primary Hostname
and update the Primary Hostname field to that of the new
primary instance.

The original primary
instance cannot be
demoted

Reset and
configure the
original
primary
instance as a
replica

See Manually Reset the Original Primary Instance as a Replica
Instance on the next page.

The original primary
instance was demoted,
but services could not
be started successfully

Reuse the
original
primary
instance as a
replica
instance

Start services on the original primary instance and synchronize
with the new primary instance. For more information, see Start
and Synchronize the Original Primary Instance on page 119.

Synchronization of the
original primary
instance does not
succeed

Synchronize
original
primary
instance

See Synchronize a Replica Instance on page 123.

3. Verify the following settings on the new primary instance.

Task Reference

Make sure that the identity sources that you use are accessible
from the new primary instance.

See the Help topic "View the Identity
Sources in Your Deployment."

Review the backup schedule for the new primary instance. Make
sure that the new primary instance can communicate with the
backup location.

See Create a Backup Using Schedule
Backups on page 126.

Make sure that the link that is included in e-mail notifications for
Self-Service user account changes contains the correct URL for
the Self-Service Console.

See the Help topic "Configure E-mail
Notifications for Self-Service User
Account Changes."

View the Progress Monitor for Promotion for Maintenance
If you navigate away from the Promotion for Maintenance page or log out of the Operations Console during
promotion, you can still view the progress monitor. The progress monitor displays on the replica instance that
you are promoting.
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After promotion, the progress monitor information is still available on the promoted instance. However, if you
restart services on the new primary instance, you can no longer access this information.

Procedure

Do one of the following:

l To view the progress monitor during promotion, in the Operations Console on the replica instance being
promoted to primary, go toDeployment Configuration > Replica Promotion > For Maintenance
> Progress Monitor.

l To view the progress monitor after promotion, in the Operations Console on the new primary instance,
Deployment Configuration > Replica Promotion > For Maintenance > Progress Monitor.

Restore Administration on the Primary Instance
If promotion for maintenance was unsuccessful, use the following procedure to restore administration on the
original primary instance.

Before you begin

Restart all services on the original primary instance. For instructions, see Reboot the Appliance on page 121.

Procedure

1. In the Operations Console on the original primary instance, click Deployment Configuration >
Instances > Status Report.

2. Select the replica instance that did not promote from the list and click Delete.

3. Do one of the following:

l If the replica instance is deployed on a hardware appliance, you can install the original hardware
appliance system image. For instructions, see Hardware Appliance System Image Installation on
page 152.

l If the replica instance is deployed on a virtual appliance, you must delete the replica appliance
and deploy a new replica instance on a virtual appliance. For more information, see the RSA
Authentication Manager Setup and Configuration Guide.

4. Run Quick Setup to configure the instance as a replica. For more information, see the RSA Authentication
Manager Setup and Configuration Guide.

Manually Reset the Original Primary Instance as a Replica Instance
If you successfully promoted a replica instance to a primary instance for maintenance purposes, but you were
unable to demote the original primary instance to a replica instance, complete the following procedure to
manually configure the original primary instance as a replica instance.

Procedure

1. Do one of the following:

l If the original primary instance is deployed on a hardware appliance, shut down the appliance
and remove the machine from service.
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You can install the original hardware appliance system image. For instructions, see Hardware
Appliance System Image Installation on page 152.

l If the original primary instance is deployed on a virtual appliance, delete the old primary instance
virtual machine from the disk.

Use the VMware vSphere client, the Hyper-V System Center Virtual Machine Manager Console, or
the Hyper-V Manager. For instructions, see the vSphere or Hyper-V documentation.

Deploy a new virtual machine with the RSA Authentication Manager image.

2. Run Quick Setup to configure the instance as a replica. For more information, see the RSA Authentication
Manager Setup and Configuration Guide.

Start and Synchronize the Original Primary Instance
If services did not start and synchronization did not complete on your original primary after promotion for
maintenance, you must start the RSA Runtime Server (biztier) on the original primary instance and synchronize
this instance with the new primary instance. If the biztier service cannot be started, reset and configure the
appliance as a replica instance.

Procedure

1. Log on to the original primary instance using SSH with the User ID rsaadmin and the current operating
system password.

For instructions, see Log On to the Appliance Operating System with SSH on page 160.

2. Verify that the RSA Runtime Server (biztier) service is running. Do the following.

a. On the original primary instance, change the directory. Type:

cd /opt/rsa/am/server

and press ENTER.

b. Type the following command and press enter.

./rsaserv status biztier

3. If the biztier is not running, try to restart the service by typing the following command.

./rsaserv start biztier nodep

4. If the RSA Runtime Server (biztier) service does not start, reset the original primary instance and
configure it as a replica instance. For more information, see Manually Reset the Original Primary Instance
as a Replica Instance on the previous page.

5. If you can start the RSA Runtime Server, synchronize the original primary instance using Operations
Console of the new primary instance. In the Operations Console, select Deployment Configuration >
Instances > Status Report and click Sync to synchronize the original primary instance with the new
primary instance.
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Deployment Problem Troubleshooting

When a deployment is not working properly, it exhibits symptoms that help you troubleshoot what is wrong.
Once you determine the problem, you can choose the appropriate solution to restore the deployment.

Symptoms of Missing Data on the Primary or Replica Instance
When RSA Authentication Manager data is accidentally deleted, the following events occur:

l Some users can no longer authenticate because their records are missing.

l Policy settings no longer function as expected.

l Restricted agents no longer function as expected.

l Trusted realm authentication no longer functions as expected.

When the deployment shows symptoms of missing data, you can fix the problem by restoring data from a
backup. For more information, see Primary Instance Data Restoration on page 128.

Symptoms of an Unresponsive Primary Instance
When the primary instance stops responding, the following events occur:

l Any replica instances continue to process authentication requests, but overall authentication requests
take more time than usual.

l You cannot administer the deployment.

l Users in an LDAP directory who have moved to a different Distinguished Name (DN) or who have never
authenticated or been edited in RSA Authentication Manager cannot authenticate or be edited.

l If the deployment includes a replica instance, risk-based authentication (RBA) continues if the
deployment includes a load balancer. If not, RBA is unavailable until you promote the replica instance.

l If the deployment does not have a replica instance, authentication stops.

l A Help Desk solution does not work.

l Users who are locked out cannot be unlocked.

l The database on the primary instance is unavailable.

l The Self-Service Console is unavailable.

l The primary instance is not generating log files.

When the primary instance is unresponsive, you can fix the problem by restoring the primary instance. For
more information, see Primary Instance Restoration on page 132.

Symptoms of an Unresponsive Replica Instance
When the replica instance stops responding, the following events occur:

l The primary instance and any other replica instances continue to process authentication requests, but
authentication takes more time than usual.

l All database updates that occurred on the primary and were not yet propagated to the replica are
queued in the primary instance database server until the disk is full or the replica is removed or
recovered. Depending on the number of transactions queued in the primary instance, the systemmay
mark the replicaOut of Sync to prevent running out of disk space.

l The replica instance is not generating log files.
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When the replica instance is unresponsive, you can fix the problem by replacing the replica instance. For more
information, see Replacing a Replica Instance on page 144.

Symptoms of an Unresponsive Web Tier
When a web tier stops responding, the following events occur:

l The Self-Service Console is unavailable if the web tier is connected to the primary instance.

l In a non-replicated deployment, risk-based authentication (RBA) stops.

When the web tier is unresponsive, you can fix the problem by removing the current web tier and adding a new
web tier. For more information, see Restore Web Tier on page 148.

Symptoms of Replication Problems
When data replication between the primary instance and the replica instance stops working, an instance can
stop authenticating users because the allotted disk space is full. If critical event notification messages are
enabled, you receive a message when replication stops working.

You can fix the problem by synchronizing the replica instance with the primary instance. For more information,
see Synchronize a Replica Instance on page 123.

Deployment Problem Solutions

Deployment problems can often be solved by performing one or more of the following tasks:

Reboot the Appliance below

Check Replication Status on the next page

Synchronize a Replica Instance on page 123

Flush the Cache on page 123

Reboot the Appliance
You may need to reboot the appliance as part of a software update.

The reboot process can take approximately 10 minutes. When complete, you are redirected to the Operations
Console logon page.

Before you begin

You must be an Operations Console administrator.

Procedure

1. On the appliance instance that you want to reboot, launch and log on to the Operations Console.

2. ClickMaintenance > Reboot Appliance.

3. On the Reboot Appliance Confirmation page, select Yes, reboot the appliance, and click Reboot.

4. On the Reboot Appliance Progress page, wait until the reboot process is complete.

5. When the Operations Console logon page displays, log on to the Operations Console.
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Check Replication Status
You can view the Replication Status Report for each replica instance in the deployment and if necessary, delete
or synchronize a replica instance.

The deployment must contain at least one replica instance to display any replication status data.

On a primary instance, the Replication Status Report displays the following information:

l Disk Space Available. The free disk space available on the primary instance. Replication stops when
the free disk space is insufficient.

l Minimum Disk Space for Replication. The amount of free disk space on the primary instance that is
required for replication.

l Replication Status. The replication status between the primary instance and each replica instance in
the deployment.

On a replica instance, the Replication Status report displays the replication status between that replica
instance and the primary instance. For more information about each status, see Replication Status
below.

If you shut down a replica instance, you must wait approximately three minutes before restarting to see the
replication status. If you restart immediately and the process takes less than three minutes, you might not see
any messages in the System Activity Monitor. However, you can run a report to see the events.

If a replication error occurs, you can download log files to assist with troubleshooting. For more information, see
the Help topic "Download Troubleshooting Files."

Procedure

On the primary instance Operations Console, click Deployment Configuration > Instances > Status
Report.

Replication Status
The Replication Status Report displays the replication status for each replica instance in the deployment.

The following table describes each possible replication status. If you enable critical system notifications for
replication status, you receive an e-mail notification when the replication status changes. The status term used
for each critical notification message is provided in the description for each status.

Status Description

Attachment in Progress (only on the
primary instance)

The replica instance is currently attaching to the primary instance.

Critical notification: ATTACHING.

Attachment Unsuccessful
The replica instance did not attach successfully.

Critical notification: FAILED.

Instance Offline (only on the
primary instance)

The replica instance has stopped updating its status and might be shut
down or disconnected from the network.

Critical notification: OFFLINE.

Internal Replication Error
An error has occurred.

Critical notification: UNHEALTHY.

Normal Replication is occurring successfully.
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Status Description

Critical notification: HEALTHY.

Out of Sync

The replica instance is not synchronized with the primary instance and
must be manually synchronized.

Critical notification: OUT_OF_SYNC.

Synchronization in Progress

The replica instance is in the process of synchronizing with the primary
instance.

Critical notification: SYNCHRONIZING.

If you shut down a replica instance, you must wait approximately three minutes before restarting to see the
replication status. If you restart immediately and the process takes less than three minutes, you might not see
any messages in the System Activity Monitor. However, you can run a report to see the events.

If a replication error occurs, you can download log files to assist with troubleshooting For more information, see
the Help topic "Download Troubleshooting Files." .

Synchronize a Replica Instance
The primary instance data is replicated frequently on each replica instance in the deployment. You can view the
replication status of each replica instance in the Operations Console Replication Status Report page. When a
replica instance shows an Out of Sync status, you must manually synchronize this replica instance. The
synchronization process brings the replica instance data back into sync with the primary instance data.

Perform the following procedure to synchronize an out-of-sync replica instance with the primary instance.

Before you begin

You must be an Operations Console administrator.

Procedure

1. On the primary instance Operations Console, click Deployment Configuration > Instances >
Status Report.

2. For a replica instance with an Out of Sync status, click Sync.

Note: You can synchronize only one replica instance at a time.

The synchronize progress displays.

If the synchronization process does not finish after 30 minutes, or if the synchronize progress displays
an error, you can troubleshoot the problem by downloading the troubleshooting files on the replica
instance. For instructions, see the Help topic "Download Troubleshooting Files."

3. After the synchronization tasks are completed, click Done.

Flush the Cache
Flush the cache to remove old information frommemory. When you flush the cache, each selected object is
refreshed from the database the next time it is accessed.

Cache contents are refreshed every 10 minutes. Depending on cache settings, database replicated changes to
cached data may take up to 10 minutes to display on all instances after a change occurs on the primary. If you
do not want to wait for the automatic 10-minute refresh, you can flush the cache on each individual instance.
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Before you begin

You must be an Operations Console administrator and a Super Admin.

Procedure

1. In the Operations Console, on the machine where you want to flush the cache, clickMaintenance >
Flush Cache.

2. If prompted, enter your Super Admin User ID and password, and clickOK.

3. Under Flush Cache, do one of the following:

l Select Flush all cache objects to flush all the caches, and click Flush.

l Select Flush specific cache objects, select the specific caches that you want to flush, and
click Flush.

Deployment Backup

You use the Operations Console to create a backup of the deployment data. This backup can be used to repair a
deployment in the following ways:

l Restore data that is accidentally deleted

l Restore a malfunctioning primary instance

You can back up deployment data using one of the following methods:

l Back Up Now. A manual, one-time backup of the deployment. For instructions, see Create a Backup
Using Back Up Now on the facing page.

l Schedule Backups. Regular backups of the deployment according to a schedule that you specify. For
instructions, see Create a Backup Using Schedule Backups on page 126.

RSA recommends that you maintain a current backup. If a successful backup has not been created during the
past seven days and Critical System Event notifications are configured, the deployment sends a Critical System
Notification.

Authentication continues while you create a backup. However, backup operations can slow the authentication
process. RSA recommends that you back up the deployment data when authentication traffic is low and no batch
jobs are running.

The deployment encrypts backups because backups contain sensitive information. During the backup process,
you must specify a password that is used for encryption. During the restore process, you provide this password
so that the backup can be decrypted and checked for integrity.

The size of the internal database determines the time required to create a backup. If the internal database is
large, the process can take a long time.

You can save the backup on the appliance or at a remote location. RSA recommends saving a current backup in a
remote location so that you can restore the deployment to recover from a disaster.

Backup File Contents
The backup file (.RSAbackup) contains the following data:
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l Internal database. Includes configuration, policy, users, and groups.

l Authentication Manager files. Data and configuration files, such as update logs, bootloader settings,
keys, and passwords used to access internal services, such as the internal database.

l RADIUS. All data and configuration files necessary to restore the RADIUS primary, including any
imported trusted root certificates for Extensible Authentication Protocol-Tunneled Transport Layer
Security (EAP-TTLS) clients. All RADIUS data is included in the backup. You cannot back up or restore
RADIUS data separately.

l Internal database log file data. Administrative Audit Log, Runtime Audit Log, and System Log.

l Console SSL certificates. The certificates that secure communication between a browser and the
Operations, Security, and Self-Service Console.

The backup does not contain any files used to deploy the appliance. The backup only contains data that is added
or changed after the appliance is deployed.

The backup does not contain any files that were generated by an export of users and tokens to another
deployment. When the export is complete, download the file locally and delete the export job.

Create a Backup Using Back Up Now
Back Up Now creates a manual, one-time backup of a deployment.

Use Back Up Now before you perform significant maintenance tasks so that you can restore the deployment if
necessary. For example, you should use Back Up Now at the following times:

l Immediately after deploying the primary instance

l Before and immediately after applying an update

l After changing the arrangement of the deployment, for example, adding or deleting a replica instance,
or promoting a replica instance for maintenance.

Procedure

1. In the Operations Console of the primary instance, clickMaintenance > Backup and Restore > Back
Up Now.

2. In the Backup Name field, accept the default name, or replace it with a backup name of your own.

The default name consists of a timestamp and this extension: .RSAbackup. The timestamp uses the
following format: YYYYMMDDHHMM.

In the default name 201208251230.RSAbackup, for example, 2012 is the year, 08 is the month, 25 is
the day, 12 is the hour, and 30 is the minute when the backup was created.

If you replace the default filename, your namemust use this extension: .RSAbackup. This extension is
case sensitive.

3. In the Backup Password field, enter a valid password, and enter the same password in the Confirm
Backup Password field.

Note carefully the backup password you specify. You need this password to restore the deployment.

4. Under Backup Location, do one of the following:
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l Select Local Authentication Manager Server. The backup is saved on the appliance in the
directory /opt/rsa/am/backup.

l SelectWindows Shared Folder.

l In theWindows Shared Folder field, enter the path to an existing Windows shared
folder, for example, \\primary.company.net\backup_path.

l If the shared folder requires a user name, enter the user name in the Folder User Name
field, for example, Domain1\User1.

l If the shared folder requires a password, enter the password in the Folder Password
field, for example, password1.

l Select NFS (Network File System) Shared Folder. In theNFS Shared Folder field, enter
the path to an NFS server and file directory, for example, fileserver.company.net:/backup_
path.

5. Click Backup.

The Progress Monitor page displays the backup progress.

6. Click Done when the backup process completes.

Create a Backup Using Schedule Backups
Schedule Backups creates regular backups of the deployment data according to the days and times that you
specify. Use Schedule Backups to ensure that you always have a current backup. This makes it possible to
restore a deployment with a minimal loss of data.

Authentication takes place during the backup process. However, backup operations slow general system
performance. RSA recommends that you schedule the backups to take place during off-peak periods.

If you promote a replica instance to a primary instance, you must configure Schedule Backups on the new
primary instance.

RSA recommends that you maintain a current backup. If a successful backup is not created in 7 days, the
deployment sends a Critical System Notification if the deployment is configured to send notifications. The
deployment also sends a Critical System Notification if a scheduled backup is not successful.

Procedure

1. In the Operations Console of the primary instance, clickMaintenance > Backup and Restore >
Schedule Backups.

2. Under Schedule Backup Status, select On.

3. Under Backup Configuration, do the following:

a. In the Backup Password field, enter a valid password. In the Confirm Backup Password
field, enter the same password.

Carefully note the backup password you specify. You need this password to restore the
deployment.
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b. For Maximum Number of Archived Backups, accept the default of 4, or select a new number
from the drop-down list.

RSA recommends that you select a minimum of 4 backups. When the total number of scheduled
backups reaches the maximum number, the next scheduled backup will delete the oldest
scheduled backup.

4. Under Backup Location, do one of the following:

l Select Local Authentication Manager Server. The backup is stored on the appliance in the
directory /opt/rsa/am/backup.

l SelectWindows Shared Folder.

l In theWindows Shared Folder field, enter the path to an existing Windows shared
folder, for example, \\primary.company.net\backup_path.

l If the shared folder requires a user name, enter the user name in the Folder User Name
field, for example, Domain1\User1.

l If the shared folder requires a password, enter the password in the Folder Password
field, for example, password1.

l Select NFS (Network File System) Shared Folder. In theNFS Shared Folder field, enter
the path to an NFS server and file directory, for example, fileserver.company.net:/backup_
path.

5. Under Schedule, accept the default settings, or specify a different backup schedule.

For example, you can create backups on every Monday and Wednesday at 2:00 A.M.

6. Click Save.

Primary or Replica Instance Amazon Web Services Snapshots
You can take an Amazon Web Services (AWS) snapshot of a virtual appliance to capture the state of an
RSA Authentication Manager primary or replica instance at a particular point in time. Snapshots, however, do
not replace the Operations Console backup feature. Snapshots are very useful in a test environment because
they allow you to revert quickly any changes you make to the deployment.

RSA recommends that you use the Operations Console to maintain a current backup of Authentication Manager
in order to restore your deployment in a production environment.

To take an AWS snapshot and use it to restore the same primary or replica instance, do the following:

1. Take an AWS snapshot of the current volume:
a. Record the Instance ID for the AWS virtual appliance.

b. Navigate to Volumes, and search for the Instance ID.

c. Right-click the current volume and take a snapshot. Record the Snapshot ID.

2. Create a new volume from the snapshot:
a. Navigate to Snapshots, and search for the Snapshot ID.

b. Right-click the snapshot and create a new volume. Record the Volume ID.
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3. Restore the Authentication Manager instance by detaching the current volume and attaching the
new volume:

a. Stop the Authentication Manager instance that is being restored.

b. Navigate to Volumes, and locate the current volume for the Authentication Manager
instance.

c. Right-click and detach the current volume.

d. Search for the new volume, and attach it to the same instance with the device
/dev/sda1.

For detailed instructions, see the AWS documentation.

Additional tasks are required to restore an Authentication Manager instance from a snapshot. For more
information, see Restoring the Primary Instance to an Amazon Web Services Snapshot on page 139 and
Restoring a Replica Instance to an Amazon Web Services Snapshot on page 145.

Primary or Replica Instance VMware Snapshots
You can take a VMware snapshot of a virtual appliance to capture the state of an RSA Authentication Manager
primary or replica instance at a particular point in time. Snapshots, however, do not replace the Operations
Console backup feature. Snapshots are very useful in a test environment because they allow you to revert
quickly any changes you make to the deployment.

RSA recommends that you use the Operations Console to maintain a current backup of Authentication Manager
in order to restore your deployment in a production environment.

When you take a snapshot of an Authentication Manager instance, you must specify the following settings:

l Do not save the virtual machine’s memory.

l Choose to quiesce (disable) the guest file system. This option pauses running processes on the
Authentication Manager instance.

For additional instructions, see the VMware vSphere Client documentation.

Additional tasks are required to revert an Authentication Manager instance to a snapshot. For more information,
see Reverting the Primary Instance to a VMware Snapshot on page 140 and Reverting a Replica Instance to a
VMware Snapshot on page 146.

Primary or Replica Instance Hyper-V Checkpoints
You can create a Hyper-V checkpoint of a virtual appliance to capture the state of an RSA Authentication
Manager primary or replica instance at a particular point in time. Checkpoints, however, do not replace the
Operations Console backup feature. Checkpoints are useful in a test environment because they allow you to
revert quickly any changes you make to the deployment.

RSA recommends that you use the Operations Console to maintain a current backup of Authentication Manager
in order to restore your deployment in a production environment.

For instructions on creating a checkpoint, see the Microsoft Hyper-V documentation.

Additional tasks are required to revert an Authentication Manager instance to a checkpoint. For more
information, see Restoring the Primary Instance to a Hyper-V Checkpoint on page 141 and Restoring a Replica
Instance to a Hyper-V Checkpoint on page 146.

Primary Instance Data Restoration
If the primary instance data is accidentally deleted, but the primary instance is functioning properly, you can
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use the Operations Console to restore the deleted data using Restore from Backup.

Note: Restoring deleted data does not restore a malfunctioning primary instance, and can cause additional
problems. To restore a malfunctioning primary instance, see Primary Instance Restoration on page 132.

When you use Restore from Backup, the following activities take place:

l The RSA Authentication Manager services stop so that no other processes can connect to the database.
No administration or authentication operations can be performed on the primary instance during the
restore operation.

l All backup data that is saved in a remote location is copied to the primary instance.

l The backup data overwrites all the existing data.

l Some protected data, such as system passwords and database passwords, is restored.

The Restore from Backup operation does not restore data for changes that were made after the backup was
created. Those changes are lost. For this reason, users must provide the credentials they used before the
backup was created. Similarly, a risk-based authentication user might be challenged to confirm identity
because the behavioral and device data collected after the backup was created are unavailable.

All of the console certificates imported from a third-party certificate authority (CA) that are in the backup are
restored, but none of these imported console certificates are active. The restore process does not change the
active certificate on the deployment. The active certificate on the deployment remains active when the restore
process finishes.

After you restore the deployment data from a backup, you can use the Operations Console to activate any of the
restored certificates. For example, if you had replaced the default certificate on the old deployment with a
certificate signed by a third-party certificate authority (CA), this certificate is restored but not active. You can
use the Operations Console to activate this certificate on the restored deployment. For instructions, see the Help
topic "Replacing the Console Certificate."

Restoring Primary Instance Data on a Standalone Deployment
Data that has been accidentally deleted on a standalone deployment can be restored by completing the following
tasks.

Procedure

1. Troubleshoot the primary instance to determine that data is missing but the primary instance is still
functioning properly.

2. Perform the Restore from Backup procedure. For instructions, see Restore from Backup on the next
page.

The following figure shows the process.

Chapter 6: System Maintenance and Disaster Recovery 129



RSA Authentication Manager 8.3 Administrator's Guide

Restoring Primary Instance Data on a Replicated Deployment
When data has been accidentally deleted on a primary instance and the lost data has been replicated to the
replica instance, you can restore the primary instance data by completing the following tasks.

Procedure

1. Troubleshoot the primary instance to determine that data is missing but the primary instance is still
functioning properly.

2. Perform the Restore from Backup procedure. For instructions, see Restore from Backup below.

3. Manually synchronize each replica instance. For instructions, see Synchronize a Replica Instance on
page 123.

The following figure shows the process.

Restore from Backup
This procedure restores deployment data from a backup.

You use this procedure for the following purposes:
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l To restore data that is accidentally deleted

l To restore a malfunctioning primary instance

No administration or authentication operations can be performed while the data is restored. The restore process
takes longer to complete than the backup process because the authentication services are stopped and started.
The size of the internal database also determines the amount of time required to restore data. If the internal
database is large, the process can take a long time.

Before you begin

l You must have a backup created on your deployment.

l You must be an Operations Console administrator.

Procedure

1. In the Operations Console, clickMaintenance > Backup and Restore > Restore from Backup.

2. Under Backup Location, do one of the following:

l Select Local Authentication Manager Server.

l SelectWindows Shared Folder.

l In theWindows Shared Folder field, enter the path to an existing Windows shared
folder, for example, \\primary.company.net\backup_path.

l If the shared folder requires a user name, enter the user name in the Folder User Name
field, for example, Domain1\User1.

l If the shared folder requires a password, enter the password in the Folder Password
field, for example, password1.

l Select NFS (Network File System) Shared Folder.

In theNFS Shared Folder field, enter the NFS server host name and path to a NFS shared
folder, for example, fileserver.company.net:/backup_path.

3. Under Restore Options, do one of the following:

l Select All Data to restore deployment data.

If you select the All Data option, no administration or authentication operations can be performed
while the deployment is being restored.

l Select Log Data Only to restore just the Administrative Audit, Runtime Audit, and System log
data.

Select this option after you promote a replica instance to transfer the historical log data from the
previous primary instance to the new primary instance.

4. ClickNext.
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A list of backups is displayed. If you select Log Data Only, the backups created only on the current
deployment are displayed.

5. Select the backup (.RSAbackup) that you want to use, and clickNext.

You should use the last good backup created on the current deployment.

6. On the Restore from Backup page, confirm that you selected the correct backup, and do one of the
following:

l To select a different backup, click Back.

l To restore with the selected backup, enter the password for this backup, and click Restore. The
Progress Monitor page is displayed.

7. Click Done when the restore process is complete.

After you finish

l If you restore an Authentication Manager instance with a backup from another deployment, the restored
certificates cannot be activated because they use the hostname from the backup. Either create new
certificates, or continue to use the certificates that were present on the Authentication Manager instance
before the backup was restored. For more information, see the Help Topic "Replacing the Console
Certificate." 

l In a replicated deployment, synchronize each replica instance with the restored primary instance.For
instructions, see Synchronize a Replica Instance on page 123.

If you restored the primary instance with a backup that came from a different deployment, then the
restore operation automatically deletes each replica instance from the current deployment. A backup
that is restored from the current primary instance in the current deployment retains each replica
instance.

l If the deployment includes a web tier, do the following:

l If you restored the Authentication Manager instance with a backup that came from a different
deployment, you must re-enable the virtual host. This procedure is not required for a backup
that is restored from the original Authentication Manager instance in the current deployment. Do
the following:

a. Disable the virtual host. In the Operations Console, click Deployment Configuration >
Virtual Host & Load Balancing, clear the check box, and click Save.

b. Enable the virtual host. For instructions, see the chapter “Configuring a Virtual Host and
Load Balancer” in the RSA Authentication Manager Setup and Configuration Guide.

l Generate a web-tier deployment package, and run the Web-Tier Installer. For instructions, see
the chapter “Installing Web Tiers” in the RSA Authentication Manager Setup and Configuration
Guide.

Primary Instance Restoration

If the primary instance malfunctions either because the database schema is altered or a critical application file is
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deleted, the primary instance can become unavailable.

When the primary instance is unavailable, you cannot administer the deployment. For example, without the
primary instance, you cannot add users.

If you suspect that the primary instance is malfunctioning, you can restore the primary instance using one of
the following methods:

Primary Instance Replacement below

Replica Instance Promotion for Disaster Recovery on page 135

Restoring the Primary Instance to an Amazon Web Services Snapshot on page 139

Reverting the Primary Instance to a VMware Snapshot on page 140

Restoring the Primary Instance to a Hyper-V Checkpoint on page 141

Restoring the Primary Instance to a PING Backup on page 142

Primary Instance Replacement
You can restore a malfunctioning primary instance by replacing the primary instance with a new appliance and
restoring the primary instance using Restore from Backup.

If you use a backup to restore a primary instance with an IP address or hostname that is different from the
malfunctioning primary instance, you must generate the RSA Authentication Manager host configuration file
(sdconf.rec) and install this file on each authentication agent after replacing the appliance.

Replacing the malfunctioning primary instance can take a long time. In a replicated deployment, if a replica
instance runs out of storage space because data cannot be sent to the primary instance, the replica instance
might also become unresponsive. When this happens, the replica instance cannot authenticate users.

Replacing the Primary Instance in a Standalone Deployment
Perform the following tasks to replace a malfunctioning primary instance in a standalone deployment.

Procedure

1. Do one of the following:

l For a virtual appliance, deploy and configure a new primary appliance to replace the
malfunctioning primary instance. For instructions, see the RSA Authentication Manager Setup
and Configuration Guide.

l For a hardware appliance, shut down the appliance and remove the machine from service. Install
the original hardware appliance system image. For instructions, see Hardware Appliance System
Image Installation on page 152.

2. Restore the old primary instance on the new appliance using Restore from Backup. For instructions, see
Restore from Backup on page 130.

3. (Optional) Generate and install the RSA Authentication Manager host configuration file (sdconf.rec) on
each authentication agent if you use a backup to restore a primary instance with a different IP address or
hostname.

For instructions on generating a host configuration file, see the Help topic "Generate the Authentication
Manager Configuration File."

For instructions on installing a host configuration file, see the agent documentation.
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4. (Optional) If the deployment has a trust relationship with another realm and you restore the primary
instance on a machine with a new hostname, you must repair the trust relationship. For instructions, see
Trusted Relationship Repair on page 148.

5. For an Amazon Web Services virtual appliance, terminate the instance.

For a VMware or Hyper-V virtual appliance, delete the old primary instance virtual machine from the
disk. Use the VMware vSphere client, the Hyper-V System Center Virtual Machine Manager Console, or
the Hyper-V Manager. For instructions, see the vSphere or Hyper-V documentation.

The following figure shows the process.

Replacing the Primary Instance in a Replicated Deployment
Perform the following tasks to replace a malfunctioning primary instance in a replicated deployment.

Procedure

1. Do the following:

l For each virtual appliance, suspend the virtual machine. Use Amazon Web Services, the VMware
vSphere client, the Hyper-V System Center Virtual Machine Manager Console, or the Hyper-V
Manager. For instructions, see the vSphere or Hyper-V documentation.

l For each hardware appliance, press the power button to shut down the physical machine.

2. Deploy and configure a new primary instance to replace the malfunctioning primary instance. For
instructions, see the RSA Authentication Manager Setup and Configuration Guide.

3. Restore the old primary instance on the new appliance using Restore from Backup. For instructions, see
Restore from Backup on page 130.

If you are restoring the primary instance with a backup that comes from a different deployment, then the
restore operation automatically deletes each replica instance from the current deployment. A backup
that is restored from the original primary instance in the current deployment retains each replica
instance.

4. Do the following:

l In a virtual environment or a mixed virtual and hardware environment, delete the virtual machine
for the original primary instance and the virtual machine for each of the original replica instances
from the disk. Use Amazon Web Services, the VMware vSphere client, the Hyper-V System
Center Virtual Machine Manager Console, or the Hyper-V Manager. For instructions, see the
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vSphere, Hyper-V, or Amazon Web Services documentation.

l For a primary instance on a hardware appliance, shut down the malfunctioning primary instance
and remove the machine from service.

5. Do the following:

l For each virtual appliance, deploy and configure a new replica instance to replace each deleted
replica instance, and attach each replica instance to the primary instance. For instructions, see
the RSA Authentication Manager Setup and Configuration Guide.

l For each hardware appliance, turn on each replica instance.

You can install the original hardware appliance system image. For instructions, see Hardware
Appliance System Image Installation on page 152.

Attach each replica instance to the primary instance. For instructions, see the RSA Authentication
Manager Setup and Configuration Guide.

6. (Optional) Generate and install the RSA Authentication Manager host configuration file (sdconf.rec) on
each authentication agent if you use a backup to restore a primary instance with a different IP address or
hostname.

For instructions on generating a host configuration file, see the Help topic "Generate the Authentication
Manager Configuration File."

For instructions on installing a host configuration file, see the agent documentation.

7. (Optional) If the deployment has a trust relationship with another realm and you restore the primary
instance on a virtual machine with a new hostname, you must repair the trust relationship. For
instructions, see .

The following figure shows the process.

Replica Instance Promotion for Disaster Recovery
You can restore a malfunctioning primary instance by promoting a replica instance to become the primary
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instance.

Promoting a replica instance restores the primary instance more quickly than replacing the primary instance
with a new appliance, but the replica instance available for promotion needs to be physically accessible to an
Operations Console administrator to facilitate ongoing administration.

Promoting a replica instance to be the primary instance changes the topology of a deployment in the following
ways:

l The malfunctioning primary instance is deleted from the deployment.

l The promoted replica instance becomes the new primary instance.

l The RADIUS server on the new primary instance becomes the RADIUS primary. You cannot perform a
separate promotion of a replica RADIUS server.

l If web tiers are associated with the old primary instance, you must restart the web tiers that are
associated with the old primary instance.

l If web tiers are associated with any replica instance in the deployment, you must restart the web tiers
that are associated with any replica instance.

Promote a Replica Instance for Disaster Recovery
This procedure removes a malfunctioning primary instance from the deployment and promotes a replica
instance to be the new primary instance. Promoting a replica instance restores the ability to administer a
deployment.

While the replica instance is being promoted, users cannot authenticate to the replica, and you cannot perform
any administrative functions, such as adding users.

If the original primary instance and all replica instances are online and functional, then you can perform a
promotion for maintenance. For more information, see Promotion for Maintenance on page 113.

Before you begin

You must be an Operations Console administrator.

Procedure

1. Log on to the Operations Console of the replica instance that you are promoting, and click Deployment
Configuration > Replica Promotion> For Disaster Recovery.

2. On the Promote Replica to Primary page under Current Replica Instance Details, review the
information to verify that this is the replica instance that you want to promote.

3. Under Confirmation, select Yes, promote the replica, and click Promote.

The promotion progress displays. For detailed information about this process, click Advanced Status
View.

4. After all the promotion tasks are completed, clickNext.

5. Review the information under Summary/Results and Proposed Next Steps, and click Done.
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After you finish

l Check the following items on the new primary instance after you finish the promotion process, and make
any necessary changes.

Item Instructions

Primary Instance Web Tiers. If web tiers are associated with the
old primary instance, perform these steps:

1. Check the replication status of each replica instance to verify
that the replica status displays Normal.

2. After the status of all of each replica instance displays
Normal, wait five minutes to make sure that the server list
check has taken place.

3. Restart the bootstrapper server and web-tier services on each
web tier.

Check Replication Status on
page 122

See the Help topic "Managing the
Web-Tier Service."

Replica Instance Web Tiers. If web tiers are associated with any
replica instance, perform these steps:

1. Wait for the web-tier status to displayOffline.

This can take about 30 minutes.

2. Restart the bootstrapper server and web-tier services on each
web tier.

3. Wait for the web-tier status to displayOnline before
attempting to access the web-tier services.

See the Help topic "View Web-
Tier Deployments."

See the Help topic "Managing the
Web-Tier Service."

Identity Sources. Make sure that the identity sources that you use
are connected to the new primary instance.

See the Help topic "View the
Identity Sources in Your
Deployment."

Schedule Backups. Review the backup schedule for the primary
instance. Make sure that the new primary instance can communicate
with the backup location.

Create a Backup Using Schedule
Backups on page 126

Self-Service Console URL. Make sure that the link that is included
in e-mail notifications for Self-Service user account changes contains
the correct URL for the Self-Service Console.

See the Help topic "Configure E-
mail Notifications for Self-Service
User Account Changes.

Critical Notifications. Check SMTP configuration for critical
notifications and other purposes, like dynamic seed provisioning.

See the Help topic "Configure the
SMTP Mail Service.

l To make the historical log data from the former primary instance available on the new primary instance,
use the Operations Console to restore the log data from the last good backup of the old primary instance.
For instructions, see Restore from Backup on page 130.

Promoting a Replica Instance in a Deployment with One or More Replica
Instances
Perform the following tasks to promote a replica instance to be the primary instance.
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Before you begin

Make sure that the primary instance is unresponsive before you promote the replica instance.

If the primary instance is partially functional, then do the following:

l For an Amazon Web Services virtual machine, stop the primary instance.

l For a VMware or Hyper-V virtual machine, shut down the primary instance virtual machine. Use the
VMware vSphere client, the Hyper-V System Center Virtual Machine Manager Console, or the Hyper-V
Manager. For instructions, see the vSphere, Hyper-V, or Amazon Web Services documentation.

l For a hardware appliance, press the power button to shut down the primary instance.

Procedure

1. Promote a replica instance to primary instance.

For instructions, see Promote a Replica Instance for Disaster Recovery on page 136.

2. If web tiers are associated with the deployment, do the following.
l If web tiers are associated with the old primary instance, restart all the web tiers.

l If web tiers are associated with replica instances, wait for the web-tier status to displayOffline.
This can take about 30 minutes. Restart the bootstrapper server and web-tier services on each
web tier, and wait for the web-tier status to displayOnline before attempting to access the web-
tier services.

For instructions, see Promote a Replica Instance for Disaster Recovery on page 136.

3. (Optional) Restore the log data from the last good backup of the old primary instance to make the
historical log data on the old primary instance available on the new primary instance.

For instructions, see Restore from Backup on page 130.

4. (Optional) Generate and install the RSA Authentication Manager host configuration file (sdconf.rec) on
each authentication agent if you use a backup to restore a primary instance with a different IP address or
hostname.

For instructions on generating a host configuration file, see the Help topic "Generate the Authentication
Manager Configuration File."

For instructions on installing a host configuration file, see the agent documentation.

5. Do the following:
l For a virtual appliance, deploy and configure a new replica instance to replace the promoted
replica instance, and attach the new replica instance to the new primary instance.

l For a hardware appliance, install the original hardware appliance system image. For instructions,
see Hardware Appliance System Image Installation on page 152.

You can then run Quick Setup to configure a replica instance. Attach the replica instance. For
instructions, see the chapter “Deploying a Replica Appliance” in the RSA Authentication Manager
Setup and Configuration Guide.

6. Back up the new primary instance.

For instructions, see Create a Backup Using Back Up Now on page 125.
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7. For the Amazon Web Services virtual appliance, terminate the instance.

For a VMware or Hyper-V virtual appliance, delete the old primary instance from the disk. Use the
VMware vSphere client, the Hyper-V System Center Virtual Machine Manager Console, or the Hyper-V
Manager. For instructions, see the vSphere or Hyper-V documentation.

The following figure shows the process for a deployment with one primary instance and two replica instances.

Restoring the Primary Instance to an Amazon Web Services Snapshot
The following information about reverting the primary instance to an Amazon Web Services (AWS) snapshot is
only for the AWS virtual appliance. Restoring the primary instance to a snapshot is not supported for the
hardware appliance.

You can restore a malfunctioning primary instance by restoring a snapshot of a previous virtual machine state.

If you attempt to attach or synchronize a replica instance while restoring to a snapshot, the replica instance
status becomes Attachment Unsuccessful. This status displays on the Replication Status Report page of the
Operations Console. If this happens, you must delete this replica instance and attach a new one. For
instructions, see the Help topic “Delete a Replica Instance.”

You do not need to restore a replica instance when you restore a primary instance to a snapshot.

Restoring the Primary Instance to a Snapshot in a Standalone Deployment

In a standalone deployment, you can take snapshots of the primary instance and restore the primary instance to
a snapshot at any time. For more information, see Primary or Replica Instance Amazon Web Services Snapshots
on page 127.

Restoring the Primary Instance to a Snapshot in a Replicated Deployment

In a replicated deployment, you can take snapshots of the primary instance and restore the primary instance to
a snapshot at any time. For information, see Primary or Replica Instance Amazon Web Services Snapshots on
page 127.

After you restore a snapshot, all attached and working replica instances are out of sync with the primary
instance and must be synchronized. For instructions, see Synchronize a Replica Instance on page 123.

Next Steps After Restoring to a Snapshot in a Replicated Deployment

Because a snapshot preserves the virtual machine state at a particular point in time, you might need to perform
some additional tasks:
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l If you restore the primary instance to a snapshot that was taken before you changed the primary
instance hostname, the primary instance cannot communicate with any of the replica instances. To
restore communication, delete all the replica instances in the Operations Console of the primary
instance, and delete each replica instance virtual machine from the deployment. For instructions, see
the Help topic “Delete a Replica Instance.” You can replace the deleted replica instances with new ones.

l If you restore the primary instance to a snapshot that was taken before you changed a replica instance
hostname, the primary instance cannot communicate with that replica instance. To restore
communication, delete that replica instance in the Operations Console of the primary instance, and
delete that replica instance virtual machine from the deployment. For instructions, see the Help topic
“Delete a Replica Instance.” You can replace this deleted replica instance with a new one.

l If you take a snapshot of a replica instance before it is promoted to the primary instance, you cannot use
that snapshot to restore the new primary instance if it malfunctions. If the new primary instance
malfunctions, either promote a replica instance to be the primary instance or deploy a new primary
instance and restore the primary instance with a backup. If necessary, delete the malfunctioning
primary instance. For instructions, see Primary Instance Restoration on page 132.

l If you restore the primary instance to a snapshot that includes replica instances that were deleted after
the snapshot was taken, the Operations Console of the primary instance shows those replica instances
as still attached. To show the actual state of the deployment, delete these replica instances from the
Operations Console, and, if necessary, delete each replica instance virtual machine. For instructions, see
the Help topic “Delete a Replica Instance.”

l If you take a snapshot of the primary instance in a deployment that has an unattached replica instance
and this replica instance is attached after this snapshot is taken, this replica instance does not appear in
the Operations Console of the primary instance after you restore the primary instance to this snapshot.
To restore the actual state of the deployment, delete the virtual machine for this replica instance.

Reverting the Primary Instance to a VMware Snapshot
The following information about reverting the primary instance to a VMware snapshot is only for the VMware
virtual appliance. Reverting the primary instance to a snapshot is not supported for the hardware appliance.

You can restore a malfunctioning primary instance by reverting the primary instance to a snapshot of a previous
virtual machine state.

If you attempt to attach or synchronize a replica instance while reverting to a snapshot, the replica instance
status becomes Attachment Unsuccessful. This status displays on the Replication Status Report page of the
Operations Console. If this happens, you must delete this replica instance and attach a new one. For
instructions, see the Help topic “Delete a Replica Instance.”

You do not need to revert a replica instance when you revert a primary instance to a snapshot.

Reverting the Primary Instance to a Snapshot in a Standalone Deployment

In a standalone deployment, you can take snapshots of the primary instance and revert the primary instance to
a snapshot at any time. For information on taking snapshots, see Primary or Replica Instance VMware Snapshots
on page 128.

Reverting the Primary Instance to a Snapshot in a Replicated Deployment

In a replicated deployment, you can take snapshots of the primary instance and revert the primary instance to a
snapshot at any time. For information on taking snapshots, see Primary or Replica Instance VMware Snapshots
on page 128.
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After you revert to a snapshot, all attached and working replica instances are out of sync with the primary
instance and must be synchronized. For instructions, see Synchronize a Replica Instance on page 123.

Next Steps After Reverting to a Snapshot in a Replicated Deployment

Because a snapshot preserves the virtual machine state at a particular point in time, you might need to perform
some additional tasks:

l If you revert the primary instance to a snapshot that was taken before you changed the primary instance
hostname, the primary instance cannot communicate with any of the replica instances. To restore
communication, delete all the replica instances in the Operations Console of the primary instance, and
delete each replica instance virtual machine from the deployment. For instructions, see the Help topic
“Delete a Replica Instance.” You can replace the deleted replica instances with new ones.

l If you revert the primary instance to a snapshot that was taken before you changed a replica instance
hostname, the primary instance cannot communicate with that replica instance. To restore
communication, delete that replica instance in the Operations Console of the primary instance, and
delete that replica instance virtual machine from the deployment. For instructions, see the Help topic
“Delete a Replica Instance.” You can replace this deleted replica instance with a new one.

l If you take a snapshot of a replica instance before it is promoted to the primary instance, you cannot use
that snapshot to restore the new primary instance if it malfunctions. If the new primary instance
malfunctions, either promote a replica instance to be the primary instance or deploy a new primary
instance and restore the primary instance with a backup. If necessary, delete the malfunctioning
primary instance virtual machine. For instructions, see Primary Instance Restoration on page 132.

l If you revert the primary instance to a snapshot that includes replica instances that were deleted after
the snapshot was taken, the Operations Console of the primary instance shows those replica instances
as still attached. To show the actual state of the deployment, delete these replica instances from the
Operations Console, and, if necessary, delete each replica instance virtual machine. For instructions, see
the Help topic “Delete a Replica Instance.”

l If you take a snapshot of the primary instance in a deployment that has an unattached replica instance
and this replica instance is attached after this snapshot is taken, this replica instance does not appear in
the Operations Console of the primary instance after you revert the primary instance to this snapshot. To
restore the actual state of the deployment, delete the virtual machine for this replica instance.

Restoring the Primary Instance to a Hyper-V Checkpoint
The following information about restoring the primary instance to a Hyper-V checkpoint is only for the Hyper-V
virtual appliance. Restoring the primary instance to a checkpoint is not supported for the hardware appliance.

You can restore a malfunctioning primary instance to a checkpoint of a previous virtual machine state.

If you attempt to attach or synchronize a replica instance while restoring to a checkpoint, the replica instance
status becomes Attachment Unsuccessful. This status displays on the Replication Status Report page of the
Operations Console. If this happens, you must delete this replica instance and attach a new one. For
instructions, see the Help topic “Delete a Replica Instance.”

You do not need to restore a replica instance to a checkpoint when you restore a primary instance to a
checkpoint.

Restoring the Primary Instance to a Checkpoint in a Standalone Deployment

In a standalone deployment, you can create checkpoints of the primary instance and restore the primary
instance to a checkpoint at any time. For information on creating checkpoints, see Primary or Replica Instance
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Hyper-V Checkpoints on page 128.

Restoring the Primary Instance to a Checkpoint in a Replicated Deployment

In a replicated deployment, you can create a checkpoint of the primary instance and restore the primary
instance to a checkpoint at any time. For information on creating checkpoints, see Primary or Replica Instance
Hyper-V Checkpoints on page 128.

After you restore the primary instance to a checkpoint, all attached and working replica instances are out of
sync with the primary instance and must be synchronized. For instructions, see Synchronize a Replica Instance
on page 123.

Next Steps After Restoring to a Checkpoint in a Replicated Deployment

Because a checkpoint preserves the virtual machine state at a particular point in time, you might need to
perform some additional tasks:

l If you restore the primary instance to a checkpoint that was created before you changed the primary
instance hostname, the primary instance cannot communicate with any of the replica instances. To
restore communication, delete all the replica instances in the Operations Console of the primary
instance, and delete each replica instance virtual machine from the deployment. For instructions, see
the Help topic “Delete a Replica Instance.” You can replace the deleted replica instances with new ones.

l If you restore the primary instance to a checkpoint that was created before you changed a replica
instance hostname, the primary instance cannot communicate with that replica instance. To restore
communication, delete that replica instance in the Operations Console of the primary instance, and
delete that replica instance virtual machine from the deployment. For instructions, see the Help topic
“Delete a Replica Instance.” You can replace this deleted replica instance with a new one.

l If you created a checkpoint of a replica instance before it is promoted to the primary instance, you
cannot use that checkpoint to restore the new primary instance if it malfunctions. If the new primary
instance malfunctions, either promote a replica instance to be the primary instance or deploy a new
primary instance and restore the primary instance with a backup. If necessary, delete the
malfunctioning primary instance virtual machine. For instructions, see Primary Instance Restoration on
page 132.

l If you restore the primary instance to a checkpoint that includes replica instances that were deleted after
the checkpoint was created, the Operations Console of the primary instance shows those replica
instances as still attached. To show the actual state of the deployment, delete these replica instances
from the Operations Console, and, if necessary, delete each replica instance virtual machine. For
instructions, see the Help topic “Delete a Replica Instance.”

l If you restore the primary instance to a checkpoint in a deployment that has an unattached replica
instance and this replica instance is attached after this checkpoint was created, this replica instance
does not appear in the Operations Console of the primary instance after you restore the primary instance
to this checkpoint. To restore the actual state of the deployment, delete the virtual machine for this
replica instance.

Restoring the Primary Instance to a PING Backup
The following information about restoring the primary instance only applies to the hardware appliance. Using
PING to restore the primary instance is not supported for the VMware or Hyper-V virtual appliance.

You can use PING to restore a malfunctioning primary instance to a previous PING backup. RSA recommends
using PING after you initially deploy the hardware appliance. A successful backup is required in the event that
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the hardware appliance needs to be restored. Reverting a hardware appliance back to the original settings
requires a backup of the entire appliance, not just the database.

For instructions, see “Using PING to Back Up and Restore the RSA Authentication Manager 8.2, 8.2 SP1, or 8.3
Hardware Appliance” on RSA Link: https://community.rsa.com/docs/DOC-41697.

If a backup image is not available, you can install the original hardware appliance system image. For
instructions, see Hardware Appliance System Image Installation on page 152.

If you attempt to attach or synchronize a replica instance while restoring to a PING backup, the replica instance
status becomes Attachment Unsuccessful. This status displays on the Replication Status Report page of the
Operations Console. If this happens, you must delete this replica instance and attach a new one. For
instructions, see the Help topic “Delete a Replica Instance.”

You do not need to restore a replica instance to a PING backup when you restore a primary instance to a PING
backup.

Restoring the Primary Instance to a PING Backup in a Standalone Deployment

In a standalone deployment, you can use PING to back up and restore the primary instance at any time.

Restoring the Primary Instance to a PING Backup in a Replicated Deployment

In a replicated deployment, you can use PING to back up and restore the primary instance at any time.

After you restore the primary instance using a PING backup, all attached and working replica instances are out
of sync with the primary instance and must be synchronized. For instructions, see Synchronize a Replica
Instance on page 123.

Next Steps After Restoring to a PING Backup in a Replicated Deployment

Because a PING backup preserves the hardware appliance state at a particular point in time, you might need to
perform some additional tasks:

l If you created a PING backup of a replica instance before it is promoted to the primary instance, you
cannot use that backup to restore the new primary instance if it malfunctions. If the new primary
instance malfunctions, either promote a replica instance to be the primary instance or deploy a new
primary instance and restore the primary instance with a backup. For instructions, see Primary Instance
Restoration on page 132.

l If you restore the primary instance to a PING backup that includes replica instances that were deleted
after the backup was created, the Operations Console of the primary instance shows those replica
instances as still attached. To show the actual state of the deployment, delete these replica instances
from the Operations Console. For instructions, see the Help topic “Delete a Replica Instance.”

l If you restore the primary instance to a PING backup in a deployment that has an unattached replica
instance and this replica instance is attached after this PING backup was created, this replica instance
does not appear in the Operations Console of the primary instance after you restore the primary instance
to this PING backup. To restore the actual state of the deployment, reattach this replica instance.

Replica Instance Restoration

If a replica instance malfunctions either because the database schema is altered or a critical application file is
deleted, the replica instance can become undependable or unresponsive. When the replica instance is
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unavailable, you lose authentication failover and the ability to restore administration quickly if the primary
instance becomes unavailable.

If you suspect that a replica instance is malfunctioning, you can restore the malfunctioning replica instance
using one of the following methods:

Replacing a Replica Instance below

Restoring a Replica Instance to an Amazon Web Services Snapshot on the facing page

Reverting a Replica Instance to a VMware Snapshot on page 146

Restoring a Replica Instance to a Hyper-V Checkpoint on page 146

Restoring the Replica Instance to a PING Backup on page 147

Replacing a Replica Instance
Perform the following tasks to replace an unresponsive replica instance.

Before you begin

Make sure that the replica instance is unresponsive before you replace the replica instance.

If the replica instance is a virtual appliance and is partially functional, shut down the replica instance virtual
machine. Use the VMware vSphere client, the Hyper-V System Center Virtual Machine Manager Console, or the
Hyper-V Manager. For instructions, see the vSphere or Hyper-V documentation.

Procedure

1. Delete the unresponsive replica instance from you deployment.

For instructions, see the Help topic “Delete a Replica Instance.”

2. Deploy a new replica instance to replace the deleted replica instance, and attach it to the primary
instance.

For instructions, see the chapter “Deploying a Replica Appliance” in the RSA Authentication Manager
Setup and Configuration Guide.

3. Back up the primary instance.

For instructions, see Create a Backup Using Back Up Now on page 125.

4. Do one of the following:
l For a virtual appliance, delete the old replica instance from the disk. Use the VMware vSphere
client, the Hyper-V System Center Virtual Machine Manager Console, or the Hyper-V Manager.
For instructions, see the vSphere or Hyper-V documentation.

l For a hardware appliance, shut down the old replica instance and remove the machine from
service. Install the original hardware appliance system image. For instructions, see Hardware
Appliance System Image Installation on page 152.

The following figure shows the process.
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5. In a replicated deployment, synchronize each replica instance with the new primary instance. For
instructions, see Synchronize a Replica Instance on page 123.

Restoring a Replica Instance to an Amazon Web Services Snapshot
The following information about restoring the replica instance to a Amazon Web Services (AWS) snapshot is
only for the AWS virtual appliance. Restoring the replica instance to a snapshot is not supported for the
hardware appliance.

You can restore a malfunctioning replica instance by restoring the replica instance to a snapshot of a previous
virtual machine state.

When you restore a replica instance to a snapshot, any replica data that has not been sent to the primary
instance is lost. Replica data sent to the primary instance after the snapshot was taken is preserved.

You do not need to restore the primary instance when you restore a replica instance to a snapshot.

Restoring a Replica Instance to a Snapshot

In a replicated deployment, you can take snapshots of any replica instance and restore that replica instance to a
snapshot at any time. For information on taking snapshots, see Primary or Replica Instance Amazon Web
Services Snapshots on page 127.

After you restore to a snapshot, the replica instance is out of sync with the primary instance and must be
synchronized . For instructions, see Synchronize a Replica Instance on page 123.

Next Steps After Restoring to a Snapshot in a Replicated Deployment

Because a snapshot preserves the virtual machine state at a particular point in time, the primary instance might
not be able to communicate with a replica instance after you restore the replica instance to a particular
snapshot. This happens if you restore to a replica snapshot that is taken before you make these changes:

l You give the primary instance or replica instance a new hostname.

l You promote a replica instance to replace the primary instance.

To restore communication between the primary instance and the replica instance, delete the replica instance in
the Operations Console of the primary instance, and delete the replica instance from the deployment. For
instructions, see the Help topic “Delete a Replica Instance.” Replace the deleted replica instance with a new
replica instance.
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Reverting a Replica Instance to a VMware Snapshot
The following information about reverting the replica instance to a VMware snapshot is only for the VMware
virtual appliance. Reverting the replica instance to a snapshot is not supported for the hardware appliance.

You can restore a malfunctioning replica instance by reverting the replica instance to a snapshot of a previous
virtual machine state.

When you revert a replica instance to a snapshot, any replica data that has not been sent to the primary
instance is lost. Replica data sent to the primary instance after the snapshot was taken is preserved.

You do not need to revert the primary instance when you revert a replica instance to a snapshot.

Reverting a Replica Instance to a Snapshot

In a replicated deployment, you can take snapshots of any replica instance and revert that replica instance to a
snapshot at any time. For information on taking snapshots, see Primary or Replica Instance VMware Snapshots
on page 128.

After you revert to a snapshot, the replica instance is out of sync with the primary instance and must be
synchronized . For instructions, see Synchronize a Replica Instance on page 123.

Next Steps After Reverting to a Snapshot in a Replicated Deployment

Because a snapshot preserves the virtual machine state at a particular point in time, the primary instance might
not be able to communicate with a replica instance after you revert the replica instance to a particular snapshot.
This happens if you revert to a replica snapshot that is taken before you make these changes:

l You give the primary instance or replica instance a new hostname.

l You promote a replica instance to replace the primary instance.

To restore communication between the primary instance and the replica instance, delete the replica instance in
the Operations Console of the primary instance, and delete the replica instance virtual machine from the
deployment. For instructions, see the Help topic “Delete a Replica Instance.” Replace the deleted replica
instance with a new replica instance.

Restoring a Replica Instance to a Hyper-V Checkpoint
The following information about restoring the replica instance to a Hyper-V checkpoint is only for the Hyper-V
virtual appliance. Restoring the replica instance to a checkpoint is not supported for the hardware appliance.

You can restore a malfunctioning replica instance by restoring the replica instance to a checkpoint of a previous
virtual machine state.

When you restore a replica instance to a checkpoint, any replica data that has not been sent to the primary
instance is lost. Replica data sent to the primary instance after the checkpoint was created is preserved.

You do not need to restore the primary instance when you restore a replica instance to a checkpoint.

Restoring a Replica Instance to a Checkpoint

In a replicated deployment, you can create checkpoints of any replica instance and restore that replica instance
to a checkpoint at any time. For information on creating checkpoints, see Primary or Replica Instance Hyper-V
Checkpoints on page 128.

After you restore a replica instance to a checkpoint, the replica instance is out of sync with the primary instance
and must be synchronized. For instructions, see Synchronize a Replica Instance on page 123.
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Next Steps After Restoring to a Checkpoint in a Replicated Deployment

Because a checkpoint preserves the virtual machine state at a particular point in time, the primary instance
might not be able to communicate with a replica instance after you restore the replica instance to a particular
checkpoint. This happens if you restore the replica instance to a checkpoint that is taken before you make these
changes:

You give the primary instance or replica instance a new hostname.

You promote a replica instance to replace the primary instance.

To restore communication between the primary instance and the replica instance, delete the replica instance in
the Operations Console of the primary instance, and delete the replica instance virtual machine from the
deployment. For instructions, see the Help topic “Delete a Replica Instance.” Replace the deleted replica
instance with a new replica instance.

Restoring the Replica Instance to a PING Backup
The following information about restoring the replica instance only applies to the hardware appliance. Using
PING to restore the replica instance is not supported for the VMware or Hyper-V virtual appliance.

You can use PING to restore a malfunctioning replica instance to a previous PING backup. RSA recommends
using PING after you initially deploy the hardware appliance. A successful backup is required in the event that
the hardware appliance needs to be restored. Reverting a hardware appliance back to the original settings
requires a backup of the entire appliance, not just the database.

For instructions, see “Using PING to Back Up and Restore the RSA Authentication Manager 8.2, 8.2 SP1, or 8.3
Hardware Appliance” on RSA Link: https://community.rsa.com/docs/DOC-41697.

If a backup image is not available, you can install the original hardware appliance system image. For
instructions, see Hardware Appliance System Image Installation on page 152.

When you restore a replica instance to a PING backup, any replica data that has not been sent to the primary
instance is lost. Replica data sent to the primary instance after the PING backup was taken is preserved.

You do not need to restore the primary instance when you restore a replica instance to a PING backup.

Restoring a Replica Instance to a PING Backup

In a replicated deployment, you can use PING to back up and restore any replica instance at any time.

After you restore to a PING backup, the replica instance is out of sync with the primary instance and must be
synchronized . For instructions, see Synchronize a Replica Instance on page 123.

Next Steps After Restoring a PING Backup in a Replicated Deployment

Because a PING backup preserves the hardware appliance state at a particular point in time, the primary
instance might not be able to communicate with a replica instance after you restore the replica instance to a
particular PING backup. This happens if you restore a PING backup that is taken before you make these
changes:

l You give the primary instance or replica instance a new hostname.

l You promote a replica instance to replace the primary instance.

To restore communication between the primary instance and the replica instance, delete the replica instance in
the Operations Console of the primary instance. For instructions, see the Help topic “Delete a Replica Instance.”
Replace the deleted replica instance with a new replica instance.
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Restore Web Tier

Perform the following procedure to restore a web tier when it stops responding. These procedures apply when
you need to restore only the web tier, and the primary and replica instances are functioning normally.

Procedure

1. On the web-tier server, run the RSA Authentication Web-Tier Uninstaller for the platform. For
instructions, see the Help topics “Uninstall a Web Tier on Windows” or “Uninstall a Web Tier on Linux.”

2. Remove the web-tier deployment record:
a. In the Operations Console, click Deployment Configuration >Web-Tier Deployments >

Manage Existing.

b. On the Web-Tier page, select the web-tier to remove, and click Delete.

For complete instructions, see the Help topic “Delete a Web-Tier Deployment Record.”

3. In the Operations Console, click Deployment Configuration >Web-Tier Deployments > Add New
to add a new web-tier deployment record. For instructions, see the Help topic “Add a Web-Tier
Deployment Record.”

4. On the primary instance, generate a web-tier deployment package:

5. In the Operations Console, click Deployment Configuration >Web-Tier Deployments > Manage
Existing.

6. On the Web-Tier Deployments page, select the web tier for which to generate a web-tier package.

7. On the Generate Web-Tier Deployment Package page, enter a password for the web-tier package file.

8. Click Generate Web-Tier Package.

9. Click Download.

10. Run the RSA Authentication Web-Tier Installer for the platform. For instructions, see the chapter
“Installing Web Tiers” in the RSA Authentication Manager Setup and Configuration Guide.

Trusted Relationship Repair

When you restore an RSA Authentication Manager 8.2 primary instance on a machine with a new hostname, and
you had a trust relationship previously with another Authentication Manager 8.0 or later realm, you must restore
the trust relationship. between two deployments. For instructions, see Repair a Trust Relationship with a
Version 8.0 or Later Realm on the facing page.

For a trusted realm, the repair process ensures that the original trusted realm information, such as trusted
users and groups, is preserved. The process is similar to adding a trusted realm. Both the administrator of the
restored version 8.0 or higher deployment, and the administrator of the previously trusted 8.0 or higher
deployment participate in the repair process. However, only the administrator of the previously trusted realm
imports a trust package. The administrator of the restored deployment provides a trust package to the
administrator of the deployment where the trust will be repaired. This package is used to repair the trusted
realm.

Note: For information on restoring trust between RSA Authentication Manager and RSA SecurID Access, see the
Help Topic "Repair an RSA SecurID Access Trusted Realm."
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Repair a Trust Relationship with a Version 8.0 or Later Realm
If you restore the RSA Authentication Manager 8.3 primary instance on a machine with a new hostname, and you
had a trust relationship previously with another version 8.0 or later realm, perform the following procedure to
repair the trust between the two Authentication Manager deployments.

Note: You can also repair a trust relationship between RSA Authentication Manager and a Cloud Authentication
Service deployment. For instructions, see the Help topic "Repair a Cloud Authentication Service Trusted Realm."

Before you begin

The administrator of the restored deployment and the administrator of the deployment where the trust will be
repaired must be able to communicate directly while they perform this procedure.

Procedure

1. The administrator of the restored deployment performs the following steps to generate a trust package.

a. In the Security Console, click Administration > Trusted Realms > Manage Existing.

b. Under Trusted Realm Name, click the trusted realm name to repair.

c. From the context menu, click Generate Trust Package, and save the file (TrustPackage.xml).

d. After the trust package is saved, use a secure method to send the trust package to the
administrator of the deployment where the trust will be repaired.

2. The administrator of the deployment where the trust will be repaired performs the following steps to
import the trust package.

a. After receiving the trust package, click Administration >Trusted Realms > Manage
Existing.

b. Under Trusted Realm Name, click the trusted realm name to repair.

c. From the context menu, click Repair Trust.

d. In the Trust Package from Trusted Realm field, enter the path to the new trust package by
browsing to the package file, and clickOpen.

e. ClickNext, and contact the restored realm administrator.

3. The administrator of the restored deployment performs the following steps to share the confirmation
code with the administrator of the deployment where the trust will be repaired.

a. In the Security Console, click Administration > Trusted Realms > Manage Existing.

b. Under Trusted Realm Name, click the trusted realm name to repair.

c. From the context menu, click View, locate the confirmation code under Current Realm
Confirmation Code, and read the code to the administrator of the deployment where the trust
will be repaired to confirm that the trust package is valid.
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The Current Realm Confirmation Code must match the administrator’s Trusted Realm
Confirmation Code.

4. The administrator of the deployment where the trust will be repaired performs the following steps to
repair the trust.

a. On the Update Trusted Realm page under Trusted Realm Confirmation Code, read the Trust
Package Confirmation Code to the restored realm administrator to confirm that the trust
package is valid.

The Trusted Realm Confirmation Code must match the restored realm administrator’s Current
Realm Confirmation Code.

If the confirmation code does not match, ask the restored realm administrator to generate and
send a new trust package.

b. Click Confirm and Next.

c. (Optional) For Authentication Status, select Authenticate Trusted Users if you want your
realm to authenticate users from the trusted realm.

d. For Create Trusted Users in Security Domain, select the security domain that will own users
from the trusted realm.

After your realm authenticates users from the trusted realm, the users must belong to a security
domain in your realm. The security domain that you select must be configured to use the internal
database as an identity source.

e. (Optional) In the Trusted User Name Identifier field, enter a unique identifier that your realm
can recognize for the trusted user, and click Add. The unique identifier could be the user's
domain name or e-mail address, such as jsmith@company.com. The value must be unique
among trusted realms.

For example, suppose John Smith from Realm A is jsmith in his local realm. Your realm does not
know the identity of jsmith. If you enter yourcompany.com in this field, this user will be
identified within your realm as jsmith@yourcompany.com.

f. Click Save.

Repair Trusted Realm Discrepancy When the Backup is Incomplete
When you use a backup to restore a primary instance on a new machine, the connection information for trusted
realm authentication is contained in the backup. If you restore a primary instance with a backup that does not
match the deployment, you must repair the discrepancy. For example, if you create a backup and then add a
trusted realm, the backup will not contain the connection information for the trusted realm. If you restore a
primary instance with this backup, you need to perform additional tasks to remove any discrepancy.

The following table shows the tasks required to restore the discrepancies in the deployment when the backup
does not reflect the current state of the deployment.

Note: For information on creating or repairing an RSA SecurID Access trusted realm, see the Help topics "Add
an RSA SecurID Access Deployment as a Trusted Realm" and "Repair an RSA SecurID Access Trusted Realm."

Deployment Relationship Backup Type of Restoration Required Tasks

Deployment A (version 8.0 or later) has Backup does not Deployment B is restored with Regenerate the
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Deployment Relationship Backup Type of Restoration Required Tasks

a trust relationship with Deployment B
(version 8.0 or later).

contain trust
relationship
data.

backup on the same virtual
machine or hardware appliance.

trust package on
Deployment A.

On Deployment B,
add a new trust for
Deployment A.

Deployment A (version 8.0 or later) has
a trust relationship with Deployment B
(version 8.0 or later).

Backup does not
contain trust
relationship
data.

Deployment B is restored with
backup on a different virtual
machine or hardware appliance.

Regenerate trust
package on
Deployment A.

Generate a trust
package on
Deployment B.

On Deployment A,
repair the trust for
Deployment B.

On Deployment B,
repair the trust for
Deployment A.

Deployment A (version 8.0 or later)
does not have a trust relationship with
Deployment B (version 8.0 or later).

Backup contains
trust
relationship
data.

Deployment B is restored with
backup on the same virtual
machine or hardware appliance.

Generate the trust
package on
Deployment A.

Regenerate the
trust package on
Deployment B.

On Deployment A,
add a new trust.

On Deployment B,
repair the new trust
for Deployment B.

Deployment A (version 8.0 or later)
does not have a trust relationship with
Deployment B (version 8.0 or later).

Backup contains
trust
relationship
data.

Deployment B is restored with
backup on a different virtual
machine or hardware appliance.

Generate the trust
package on
Deployment A.

Regenerate the
trust package on
Deployment B.

On Deployment A,
add a new trust for
Deployment B.

On Deployment B,
repair the new trust
for Deployment A.
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Hardware Appliance System Image Installation

If you cannot recover a malfunctioning instance, or if you want to restore an instance to a pre-configured state,
you can install an RSA Authentication Manager 8.2 or later system image on the hardware appliance. Installing
an original system image is not supported on the virtual appliance.

Appliance Model Hardware
Installable
System
Image

Local
Installation

Remote
Installation

RSA SecurID Appliance
130

Dell PowerEdge R230
Version 8.2
SP1 or later

Yes Yes

Dell PowerEdge R210
Version 8.2
or later

Yes No

Intel-based
Version 8.2
or later

Yes No

RSA SecurID Appliance
250

Dell PowerEdge R630
Version 8.2
SP1 or later

Yes Yes

Dell PowerEdge R710
Version 8.2
or later

Yes Yes

Intel-based
Version 8.2
or later

Yes Yes

Installing an original system image on a hardware appliance removes all data associated with an RSA
Authentication Manager instance, including all data, logs, and configured settings, such as the network
settings. This operation also removes any files that you saved on the hardware appliance.

Consequences of Installing an Original System Image
Before installing an original system image, RSA recommends that you consider the consequences.

The following applies when installing an original system image on the primary instance:

l You cannot administer the deployment until a primary instance is available. If a primary instance is
unresponsive, RSA recommends that you promote a replica instance to reduce administrative downtime.
For more information, see Replica Instance Promotion for Disaster Recovery on page 135.

l Authentication requests are redirected to a replica instance when the primary instance is unavailable. If
replica instances are not available, users cannot authenticate until a primary instance is available.

l Data that accumulates on the replica instance while the primary instance is unavailable is lost.

l If you restore a backup file on a primary instance after installing an original system image, the primary
instance will not contain data for changes that were made after the backup file was created. For more
information, see Deployment Backup on page 124.

l You cannot reattach the replica instances to the primary instance after installing an original system
image. In this case, you must redeploy new replica instances and attach the replica instances to the
deployment.

If you perform a replica instance promotion for disaster recovery, you avoid redeploying and reattachingthe
replica instances. You also reduce the total amount of data that is lost. In this case, the data that exists on the
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promoted replica instance is preserved. However, the promotion processrequires that you synchronize the
remaining replica instances with the new primary instance. Any data that was recorded on the these replica
instances while the original primary instance was unavailable is lost during synchronization. For more
information, see Replica Instance Promotion for Disaster Recovery on page 135.

The following applies when installing an original system image on a replica instance:

l Data on the replica instance that did not replicate to the primary instance is lost.

l Authentication requests are redirected to other available instances.

l You must remove the replica instance from your deployment before restoring an original system image.

When installing an original system image to an instance and then adding an instance to your deployment, you
also must consider how these actions affect your network topology. For example, if you promote a replica
instance and restore an system image on the original primary instance, you may decide to configure the
restored appliance as a new replica instance. These actions may require that you restore RADIUS replication or
restart the web tiers.

Because restoring an original system image removes any files that are saved on the appliance, you must
transfer any files that you wish to save, such as backup files or log files, from the hardware appliance to an
external, accessible location. This is especially required if you wish to restore a hardware appliance and then
restore a backup file that is stored on the appliance.

Locally Install an Original System Image on a Hardware Appliance
For disaster recovery, you can use the following procedure to install an RSA Authentication Manager 8.2 or later
system image from a DVD on a hardware appliance. This operation removes all data, logs, and settings that are
associated with an Authentication Manager instance. Use this procedure if you can directly access the physical
hardware.

You can locally install RSA Authentication Manager 8.2 SP1 or later on an RSA SecurID Appliance 130 that is
based upon the Dell PowerEdge R230 or an RSA SecurID Appliance 250 that is based upon the Dell PowerEdge
R630.

For older hardware appliances, you can locally install a version 8.2 or later image on the Dell PowerEdge R210,
the Dell PowerEdge R710, or an Intel-based hardware appliance.

You can only perform this procedure on the hardware appliance. This operation is not supported on the virtual
appliance.

Before you begin

l (Optional) If the Operations Console is available for the primary or replica instance that is configured on
the hardware appliance, you can download a text file that contains the current network settings:

a. On the primary or replica instance, log on to the Operations Console.

b. Click Administration > Network > Appliance Network Settings.

c. Under Download Network Settings, click Download network settings.

d. Save the FQDN_backupOfNetworkSettings.txt file in an external secure location.

You can refer to this file when you configure the network settings on the restored appliance.
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l Transfer any files that you want to save, such as log files or backup files, from the hardware appliance to
an external, secure location.

To log on to the appliance operating system, you must use the rsaadmin operating system password,
and you must enable SSH. For instructions, see Log On to the Appliance Operating System with SSH on
page 160.

l Download the required ISO file, such as rsa-am-hardware-appliance-8.2.0.0.0.iso, rsa-am-
hardware-appliance-8.2.1.0.0.iso, or rsa-am-hardware-appliance-8.3.0.0.0.iso, from RSA
Download Central at https://download.rsasecurity.com, and save the ISO file to a location where you can
burn the file onto a DVD.

l On a DVD, burn the ISO file as a bootable disk image. To do this, you must use disc burning software
that allows you to burn disk images. For example, on a computer running Windows 7 or later, you can
use the Windows Disc Image Burner.

l Make sure that you have a keyboard and monitor for the appliance.

Procedure

1. Connect a keyboard and monitor to the appliance.

2. Connect the power cord to the appliance and, if necessary, power on the appliance.

3. When a warning message prompts you to insert the media with the image of Authentication Manager,
insert the DVD that you burned with the ISO file, and press CTRL + ALT + DELETE to reboot the
hardware appliance.

If the appliance does not boot from the DVD, you must access the appliance BIOS and select the option
that allows you to boot from the DVD drive.

4. In the installer boot menu, use the down-arrow key to select Install RSA Authentication Manager,
and press ENTER.

RSA Authentication Manager installs.

5. After the installation has completed, the DVD is ejected from the appliance. Remove the DVD.

6. When prompted whether you want to shut down the appliance, do one of the following:

l To shut down the appliance, type yes, and press ENTER.

l To keep the appliance running for the appliance set up process, type no, and press ENTER.

After you finish

Deploy the hardware appliance and perform Quick Setup to configure the appliance as a primary or replica
instance. For instructions, see the RSA Authentication Manager Setup and Configuration Guide.

Remotely Install the Original System Image on a Dell Hardware Appliance
For disaster recovery, perform this procedure to install an RSA Authentication Manager 8.2 SP1 or later system
image on an RSA SecurID Appliance 130 that is based upon the Dell PowerEdge R230 or an
RSA SecurID Appliance 250 that is based upon the Dell PowerEdge R630.

For older hardware appliances, you can install an RSA Authentication Manager 8.2 or later image on a upgraded
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RSA SecurID Appliance 250 that is based upon the Dell PowerEdge 710. The RSA SecurID Appliance 130 that is
based upon the Dell PowerEdge R210 does not include an integrated Dell Remote Access Controller (iDRAC) for
remote access.

You must have remote access to a supported Dell hardware appliance. You can only perform this procedure on
the hardware appliance. This operation is not supported on the virtual appliance.

This operation restores the original settings on the hardware appliance. All data associated with the
RSA Authentication Manager instance is permanently deleted, including log files, backup files, and configured
settings, such as network settings.

Before you begin

l Make sure that you have deployed an iDRAC. For instructions, see "Configuring Remote Access to the
RSA Authentication Manager Hardware Appliance" on RSA Link at
https://community.rsa.com/docs/DOC-67160.

l Download the required ISO file, such as rsa-am-hardware-appliance-8.2.0.0.0.iso, rsa-am-
hardware-appliance-8.2.1.0.0.iso, or rsa-am-hardware-appliance-8.3.0.0.0.iso, from RSA
Download Central at https://download.rsasecurity.com, and save the ISO file to a location that is
accessible to the iDRAC.

l (Optional) If the Operations Console is available for the primary or replica instance that is configured on
the hardware appliance, you can download a text file that contains the current network settings:

a. On the primary or replica instance, log on to the Operations Console.

b. Click Administration > Network > Appliance Network Settings.

c. Under Download Network Settings, click Download network settings.

d. Save the FQDN_backupOfNetworkSettings.txt file in an external, secure location.

You can refer to this file when you configure the network settings on the restored appliance.

l Transfer any files that you want to save, such as log files or backup files, from the hardware appliance to
an external, secure location.

To log on to the appliance operating system, you must use the rsaadmin operating system password,
and you must enable SSH. For instructions, see Log On to the Appliance Operating System with SSH on
page 160.

Procedure

1. Log on to iDRAC with your username and password.

2. Select the Console/Media tab, and click Launch Virtual Console

3. Select the ISO file that contains the original hardware appliance system image.

On an RSA SecurID Appliance 130 that is based upon the Dell PowerEdge R230 or an
RSA SecurID Appliance 250 that is based upon the Dell PowerEdge R630, do the following:

a. Click Virtual Media > Connect Virtual Media.

b. After the menu updates, click Virtual Media > Map CD/DVD.
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c. Select the ISO file, and clickMap Device.

d. Click Virtual Media, and click the name of the ISO image.

e. Press CTRL + ALT + DELETE to reboot the hardware appliance.

By default, the BIOS reboots the hardware appliance from the ISO file. If the settings
were changed, press F11: BIOS Boot Manager, select One-shot BIOS Boot menu,
and Virtual Optical Drive. The hardware appliance reboots automatically.

On an RSA SecurID Appliance 250 that is based upon the Dell PowerEdge R710, do the following:

a. Click Virtual Media > Launch Virtual Media.

b. Select the ISO file, and click Add Image.

c. Press CTRL + ALT + DELETE to reboot the hardware appliance.

By default, the BIOS reboots the hardware appliance from the ISO file. If the settings
were changed, press F11: BIOS Boot Manager, and select Virtual CD. The hardware
appliance reboots automatically.

4. In the installer boot menu, use the down-arrow key to select Install RSA Authentication Manager,
and press ENTER.

RSA Authentication Manager installs.

5. Detach the ISO image from the console, and power on the appliance, if necessary.

6. When prompted, configure the following network settings for the appliance:

l Fully Qualified Hostname

l IP Address

l Subnet Mask

l Default Gateway

l (Optional) Primary DNS Server

l (Optional) Secondary DNS Server

7. When prompted to confirm the network settings, verify the settings are correct. To accept the settings,
type y.

8. The Quick Setup URL and the Quick Setup Access Code display. Record the following required
information:

l The Quick Setup URL includes the IP address that you entered in step 6:

https://<IP Address>/

Quick Setup uses an IP address. The administrative consoles that are available after Quick Setup
completes use a fully qualified domain name (FQDN).

l The Quick Setup Access Code is required to initiate Quick Setup.

9. If you have not done so already, connect the appliance to the network.

After you finish

Perform Quick Setup to configure the appliance as a primary or replica instance. For instructions, see the RSA
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Authentication Manager Setup and Configuration Guide.

Remotely Install the Original System Image on an Intel Hardware Appli-
ance
For disaster recovery, perform this procedure to install an RSA Authentication Manager 8.2 or later system
image on an Intel version of the RSA SecurID Appliance 250 hardware appliance. The Intel version of the RSA
SecurID Appliance 130 does not include an Intel Remote Management Module (RMM) for remote access.

You must have remote access to a supported Intel hardware appliance. You can only perform this procedure on
the hardware appliance. This operation is not supported on the virtual appliance.

This operation restores the original settings on the hardware appliance. All data associated with the
RSA Authentication Manager instance is permanently deleted, including log files, backup files, and configured
settings, such as network settings.

Before you begin

l Make sure that you have deployed an Intel Remote Management Module (RMM). For instructions, see
"Configuring Remote Access to the RSA Authentication Manager Hardware Appliance" on RSA Link at
https://community.rsa.com/docs/DOC-67160.

l Download rsa-am-hardware-appliance-8.2.0.0.0.iso, or a later ISO file, from RSA Download Central
at https://download.rsasecurity.com, and save the ISO file to a location that is accessible to the RMM.

l (Optional) If the Operations Console is available for the primary or replica instance that is configured on
the hardware appliance, you can download a text file that contains the current network settings:

a. On the primary or replica instance, log on to the Operations Console.

b. Click Administration > Network > Appliance Network Settings.

c. Under Download Network Settings, click Download network settings.

d. Save the FQDN_backupOfNetworkSettings.txt file in an external secure location.

You can refer to this file when you configure the network settings on the restored appliance.

l Transfer any files that you want to save, such as log files or backup files, from the hardware appliance to
an external, secure location.

To log on to the appliance operating system, you must use the rsaadmin operating system password,
and you must enable SSH. For instructions, see Log On to the Appliance Operating System with SSH on
page 160.

Procedure

1. Log on to the Intel Remote Management Module (RMM) with your user name and password.

2. Select the Remote Control tab, and click Launch Console.

3. Select ISO file that contains the original hardware appliance system image. Do the following:

a. Click Device > Redirect ISO.

b. Press CTRL + ALT + DELETE to reboot the hardware appliance.
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By default, the BIOS reboots the hardware appliance from the ISO file. If the settings
were changed, press F6: Boot Menu, and select Virtual CDROM 1.00. The hardware
appliance reboots automatically.

4. In the installer boot menu, use the down-arrow key to select Install RSA Authentication Manager,
and press ENTER.

RSA Authentication Manager installs.

5. Detach the ISO image from the console, and power on the appliance, if necessary.

6. When prompted, configure the following network settings for the appliance:

l Fully Qualified Hostname

l IP Address

l Subnet Mask

l Default Gateway

l (Optional) Primary DNS Server

l (Optional) Secondary DNS Server

7. When prompted to confirm the network settings, verify the settings are correct. To accept the settings,
type y.

8. The Quick Setup URL and the Quick Setup Access Code display. Record the following required
information:

l The Quick Setup URL includes the IP address that you entered in step 6:

https://<IP Address>/

Quick Setup uses an IP address. The administrative consoles that are available after Quick Setup
completes use a fully qualified domain name (FQDN).

l The Quick Setup Access Code is required to initiate Quick Setup.

9. If you have not done so already, connect the appliance to the network.

After you finish

Deploy the hardware appliance and perform Quick Setup to configure the appliance as a primary or replica
instance. For instructions, see the RSA Authentication Manager Setup and Configuration Guide.
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Troubleshooting and Advanced Administration Using the Appliance
Operating System

Although you use the Operations Console and the Security Console to administer RSA Authentication Manager,
you use the appliance operating system to perform the following advanced administration tasks:

l Run Authentication Manager command line utilities (CLUs).

l Stop and start Authentication Manager services.

l Troubleshoot appliance problems.

You can access the hardware or virtual appliance operating system with a Secure Shell (SSH) client, a software
application that uses SSH to connect with a remote computer. The client is installed on a local computer that has
a network connection to the appliance. Before you can access the appliance operating system through an SSH
client, you must enable SSH on the appliance.

You can directly access the virtual machine deployed on a VMware host machine with the VMware vSphere
Client. You can directly access the virtual machine deployed on a Hyper-V host machine with the Hyper-V
System Center Virtual Machine Manager Console, or the Hyper-V Manager.

Enable SSH on the Appliance
Before you can log on to the appliance operating system using an SSH client, you must enable SSH on the
appliance.

You can define session lifetime settings for logging on to the appliance operating system. Session lifetime
prevents administrators from keeping sessions open indefinitely, which leaves the sessions vulnerable to
unauthorized access. The session lifetime settings apply when you access a hardware or virtual appliance
operating system with an SSH client. The session lifetime settings also apply when you access a virtual
appliance with the VMware vSphere Client, the Hyper-V System Center Virtual Machine Manager Console, or the
Hyper-V Manager.
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Procedure

1. In the Operations Console, click Administration > Operating System Access.

2. Select Enable SSH. In the SSH Settings section, select the checkbox for each NIC on which you want
to enable SSH. If you have multiple NICs configured, you can enable SSH on more than one NIC.

3. Under Session Lifetime Settings, select Time out idle sessions, and enter the time out duration, if
you want to time out sessions after a period of inactivity.

4. Click Save.

Log On to the Appliance Operating System with SSH
Use the following procedure to log on to the hardware appliance or virtual appliance operating system using an
SSH client.

Before you begin

l Obtain the rsaadmin operating system password.

l Obtain the hostname for the appliance virtual machine or the hostname for the hardware appliance.

l Enable SSH on the appliance. For instructions, Enable SSH on the Appliance on the previous page.

Procedure

1. Launch the SSH client, and connect to the appliance using the IP address or fully qualified hostname.

2. When prompted for the user name, type the operating system User ID, rsaadmin, and press ENTER.

3. When prompted for the password, type the rsaadmin operating system account password, and press
ENTER.

Log On to the Virtual Appliance with the VMware vSphere Client
Use the following procedure to log on to the VMware virtual appliance using the VMware vSphere Client.

Before you begin

You can define session lifetime settings for logging on to the appliance operating system. Session lifetime
settings prevent administrators from keeping sessions open indefinitely. For instructions, see Enable SSH on
the Appliance on the previous page.

Procedure

1. Log on to the VMware vSphere Client.

2. Right-click the virtual appliance name, and select Open Console from the context menu.

3. When prompted for the Login, type the operating system User ID, rsaadmin, and press ENTER.

4. When prompted for the password, type the rsaadmin operating system account password, and press
ENTER.

Log on to the Virtual Appliance with the Hyper-V Virtual Machine Manager
Console
Use the following procedure to log on to the Hyper-V virtual appliance using the Hyper-V System Center Virtual
Machine Manager (VMM) Console.

Before you begin

You can define session lifetime settings for logging on to the appliance operating system. Session lifetime
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settings prevent administrators from keeping sessions open indefinitely. For more information, see Enable SSH
on the Appliance on page 159.

Procedure

1. To access the Hyper-V virtual machine using the VMM Console, log on to the VMM server.

2. In the VMM console navigation pane, select VMs and Services.

3. Choose the top-level Hyper-V cluster to view all machines, or expand the cluster and navigate to the
specific Hyper-V cluster that hosts the virtual appliance.

4. Right-click the virtual appliance name, and select Connect or View > Connect via Console from the
context menu.

5. When prompted for the Login, type the operating system User ID, rsaadmin, and press ENTER.

6. When prompted for the password, type the rsaadmin operating system account password, and press
ENTER.

Log on to the Virtual Appliance with the Hyper-V Manager
Use the following procedure to log on to the Hyper-V virtual appliance using the Hyper-V Manager.

Before you begin

You can define session lifetime settings for logging on to the appliance operating system. Session lifetime
settings prevent administrators from keeping sessions open indefinitely. For more information, see Enable SSH
on the Appliance on page 159.

Procedure

1. Log on to the Hyper-V host machine.

2. On the Hyper-V host machine, in the Windows Start menu, click Server Manager > Tools > Hyper-V
Manager.

3. In the Hyper-V Manager, select the node and host from the left pane.

4. In the Virtual Machines pane, select the virtual appliance.

5. In the Actions pane, under the virtual appliance name, click Connect.

6. When prompted for the Login, type the operating system User ID, rsaadmin, and press ENTER.

7. When prompted for the password, type the rsaadmin operating system account password, and press
ENTER.

Run Clam Antivirus Software

Each RSA Authentication Manager instance includes Clam Antivirus (ClamAV) software. ClamAV is an open-
source software toolkit that is intended to reduce the risk of intrusion or malicious system or data access. Apply
software updates to ClamAV only as part of RSA-delivered updates. You are responsible for updating antivirus
definition files and running ClamAV in order to scan any Authentication Manager instance for known malware.

Before you begin

l This procedure assumes a knowledge of Linux commands.

l For the operating system account User ID rsaadmin, obtain the operating system password.
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l To access the operating system with a secure shell (SSH) client, you must enable SSH. You can also
access the operating system on a virtual appliance in the VMware vSphere client, the Hyper-V System
Center Virtual Machine Manager Console,or the Hyper-V Manager.For instructions on using SSH, see
Enable SSH on the Appliance on page 159.

Procedure

1. Log on to the appliance with the User ID rsaadmin and the current operating system password:
l On a hardware appliance or an Amazon Web Services appliance, log on to the appliance using an
SSH client.

l On a VMware virtual appliance, log on to the appliance using an SSH client, or the VMware
vSphere client.

l On a Hyper-V virtual appliance, log on to the appliance using an SSH client, the Hyper-V System
Center Virtual Machine Manager Console, or the Hyper-V Manager.

2. Update the antivirus definition files. Choose one of the following procedures:
l If the Authentication Manager instance has access to the Internet, you can automatically
download and apply the latest antivirus definition files. Type the following command:

sudo /usr/bin/freshclam

l If the Authentication Manager instance does not have access to the Internet, manually download
themain.cvd and daily.cvd antivirus definition files from the ClamAV web site:
http://www.clamav.net/

Copy the files into the /var/lib/clamav/ directory on the instance.

3. To scan files and directories for viruses manually, type the following line:

sudo clamscan -r / --exclude-dir=/proc --exclude-dir=/sys --exclude-
dir=/opt/rsa/am/rsapgdata --follow-dir-symlinks=0 --follow-file-
symlinks=0 --log=/var/log/clamav.log

To schedule automatic virus scans, create a cron job that runs the same command.

4. Check the scan results in /var/log/clamav.log.

RSA Authentication Manager Services

All RSA Authentication Manager services that are required for product functionality are started automatically.
You can also manage these services manually.

RSA Authentication Manager Services That Start Automatically
The following table lists the Authentication Manager services that start automatically.

Service Name Description Details

console RSA Console Server
Hosts the Security Console and
the Self-Service Console.

biztier RSA Runtime Server

admin
RSA Administration Server
with Operations Console

Hosts the Operations Console.
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Service Name Description Details

db RSA Database Server

primary_replication RSA Replication (Primary)
Runs on the primary instance
only.

replica_replication RSA Replication (Replica)
Runs on the replica instance
only.

radius RSA RADIUS Server

radiusoc
RSA RADIUS Server Operations
Console

For security reasons, the appliance does not start the Secure Shell (SSH) service automatically. Requiring an
administrator to manually start SSH limits remote access to the appliance operating system. Before you can log
on to the appliance operating system using an SSH client, you must enable SSH in the Operations Console. For
more information, see Log On to the Appliance Operating System with SSH on page 160.

Manage RSA Authentication Manager Services Manually
Use the following procedure to manage RSA Authentication Manager services manually. You can perform the
following actions on a selected service or on all services at the same time:

l Stop

l Start

l Display current status

l Restart

Procedure

1. Log on to the appliance with the User ID rsaadmin and the current operating system password:

On a hardware appliance or the Amazon Web Services appliance, log on to the appliance using an SSH
client.

On a VMware virtual appliance, you can log on to the appliance using an SSH client or the VMware
vSphere client.

On a Hyper-V virtual appliance, you can log on to the appliance using an SSH client, the Hyper-V System
Center Virtual Machine Manager Console, or the Hyper-V Manager.

For instructions, see Log On to the Appliance Operating System with SSH on page 160.

2. Change the directory. Type:

cd /opt/rsa/am/server

and press ENTER.

3. Run a command. Type the following, and press ENTER:

./rsaserv stop|start|status|restart [service name] [nodep] [exclude service name]

where:

l stop, start, status, restart, and nodep are options for managing the RSA service. Use nodep if
you do not want to start dependent services. Use exclude and the service name to exclude that
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service from the command.

l service name is the name of the Authentication Manager service that you want to manage.

Service names:

l all (All RSA services)

l console (RSA Console Server)

l biztier (RSA Runtime Server)

l admin (RSA Administration Server with Operations Console)

l db (RSA Database Server)

l primary_replication (RSA Replication Primary)

l replica_replication (RSA Replication Replica)

l radiusoc (RSA RADIUS Server Operations Console)

l radius (RSA RADIUS Server)

Examples:

To start all services, use the following command:

./rsaserv start all

To restart the database server without restarting any dependent services, use the following command:

./rsaserv restart db nodep

To stop all RSA services except for the RSA Administration services, use the following command:

./rsaserv stop all exclude admin

4. When you are done, type:

exit

and press ENTER.

Operating System Services that Start Automatically
Appliance operating system services that are required byRSA Authentication Manager are started automatically.
The following table lists the services configured for normal system operation at runlevel 5. Do not manually stop
the required services.

Service Name Description

acpid
Service to handle graceful power-off (ACPI)
events

auditd Audit logs activities of users.

cron Runs scheduled jobs.

dataeng DSM SA Data Engine Service

dbus Interprocess IPC service

dsm_om_shrsvc DSM SA Shared Service

earlysyslog Kernel syslog service (early)

haldaemon Hardware abstraction layer service

haveged Service to increase system entropy pool
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Service Name Description

instsvcdrv DSM SA Device Drivers

iptables Network firewall

irq_balancer Interrupt distributor

kbd Keyboard service

memorycontrol VMware Memory Control

network Network service

network-remotefs Network services for remote File Systems

purge-kernels Dynamic kernel configuration service

random Random data service

rpcbind Transport independent RPC portmapper

rsaservmgr RSA Service manager

smbfs Samba client file system

sshd

(Optional) Secure Shell (SSH) service. You can
enable SSH in the Operations Console. For
instructions, see Log On to the Appliance
Operating System with SSH on page 160.

syslog System logging service

validate-interfaces RSA interface validation service

validate-network RSA Network validation service

Super Admin Restoration

The Super Admin role is a predefined administrative role and the only role with full administrative permission for
the entire deployment. A Super Admin can:

l Delegate roles to all other administrators.

l Create the security domain hierarchy.

The Super Admin is created during deployment. Only a Super Admin can perform certain critical tasks. A
deployment must have at least one Super Admin.

If a Super Admin is deleted, use the Super Admin Restoration utility, restore-admin, to create a new Super
Admin. RSA recommends that you assign the Super Admin role to only the most trusted administrators.

You need to restore a Super Admin if any of the following conditions exist:

l The sole Super Admin has been deleted from the deployment.

l No users have been assigned the Super Admin role.

l The sole Super Admin has been locked out.

If a Super Admin has been locked out, recovery can occur in any of the following ways:

l Another Super Admin can manually unlock the Super Admin.

l If the lockout policy that applies to the Super Admin allows auto-unlock, you can wait for lockout to
expire.
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If the previous methods fail, use the Super Admin Restoration utility. For instructions, see Restore the Super
Admin below.

Restore the Super Admin
Use this procedure to restore the Super Admin user to a deployment using the Super Admin Restoration utility,
restore-admin.

The Super Admin Restoration utility is used to restore access to the deployment in an emergency. By default, the
lifetime for the Super Admin account that you create with this utility is 24 hours. The password you specify
when creating this Super Admin is not validated by the default password policy. Instead, the password is
validated by the initial password policy that is applied during Quick Setup. This initial password policy requires
between 8 and 32 characters, at least one alphabetic character, and at least one special character, excluding
spaces, @, and ~. RSA recommends as a best practice that you create a password that conforms to the current
default password policy when you use this utility.

Although it is possible to enter the Operations Console administrator credentials on the command line along with
the other options, this creates a potential security vulnerability. RSA recommends that you enter the password
only when the utility presents a prompt.

Before you begin

l You must be familiar with the Linux operating system.

l Do not perform this procedure on a replica instance.

l You must enable SSH through the Operations Console (OC). This provides access to the Operating
System (OS) shell command prompt.

l You must have OS login credentials (rsaadmin login ID and password). These credentials allow you to
login to the OS and access the OS shell command prompt.

l You must have OC credentials. These are required to execute the restore-admin command.

Procedure

1. Log on to the appliance with the User ID rsaadmin and the current operating system password:
l On a hardware appliance or the Amazon Web Services appliance, log on to the appliance using an
SSH client.

l On a VMware virtual appliance, log on to the appliance using an SSH client or the VMware
vSphere client.

l On a Hyper-V virtual appliance, log on to the appliance using an SSH client, the Hyper-V Virtual
Machine Manager Console, or the Hyper-V Manager.

For instructions, see Log On to the Appliance Operating System with SSH on page 160.

2. Change directories to /opt/rsa/am/utils.

3. Type:

./rsautil restore-admin -u newadmin -p adminpassword

4. where:
l newadmin is the User ID for the new Super Admin.
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l adminpassword is the password for the new Super Admin. The password requires between 8
and 32 characters, at least one alphabetic character, and at least one special character,
excluding spaces, @, and ~.

and press ENTER.

5. When prompted for the Operations Console Administrator username, enter the Operations Console
administrator User ID, and press ENTER.

6. When prompted, enter the Operations Console administrator password, and press ENTER.

7. When prompted with Are you sure you want to continue? (Y/N), type Y, and press ENTER.

After you finish

The Super Admin Restoration utility also resets the Security Console authentication policy to LDAP_
Password/RSA Password. In order for this change to take effect, use the Operations Console to flush the cache.
For instructions, see Flush the Cache on page 123.

RSA Authentication Manager Updates

RSA issues product updates periodically for RSA Authentication Manager in the form of patches and service
packs. RSA recommends applying product updates as they become available to ensure that the deployment is
secure and efficient. For each product update, RSA provides release notes that contain important information
about applying the update. To avoid problems, you should read all of the information in the release notes before
you apply the update.

You download product updates from RSA Link at https://community.rsa.com/community/products/securid.
Updates are provided in the form of an ISO image. RSA recommends that you do not burn the ISO image to a
physical DVD or CD. Instead, save the ISO image in a directory that is accessible to the deployment.

You use the Operations Console to apply product updates on each primary and replica instance. After you
download a product update, you specify the location of the ISO image. You can apply an individual update
through your local browser, or you can scan for stored updates in an NFS share, a Windows shared folder, or a
DVD/CD. After scanning, you can select an individual update to apply.

Note: Apply updates to embedded third-party products only as part of RSA-delivered updates. For example,
RSA provides the required updates to the virtual appliance and hardware appliance operating system.

If the deployment includes a web tier, you must update the web tier when you update the version of
Authentication Manager. Authentication Manager displays an update button in the Operations Console for each
web tier that is not up-to-date. For instructions, see the Help topic "Update the Web Tier."

View Software Version Information

View the version of RSA Authentication Manager that is installed in your deployment.

Procedure

1. In the Security Console, click Help > About RSA Security Console.

2. In the Version section, click See Software Version Information.
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3. On the Software Version Information page, view the software version information for each instance in
your deployment.

Verify an IP Address or Hostname

You can use the Operations Console to run operating system commands to verify an IP address or hostname.
The following table lists the supported commands.

Command Purpose

Ping

Determine if the host computer you are trying to reach is available, and determine the response
time.

For the Amazon Web Services appliance, ping requires you to enable the ICMP port in your security
groups. For security reasons, RSA does not recommend opening the ICMP port on the cloud, but if
you require ping to work, the ICMP port must be added to your security groups.

Traceroute See the network route between two computers with a list of intermediary routers.

NSLookup
(Name
Server
Lookup)

Query the DNS server to obtain the IP address or hostname.

Verify
Name
Resolution

Query a host to obtain the domain name, IP address mappings, and a list of configured DNS
servers.

ARP
(Address
Resolution
Protocol)

List the Media Access Control (MAC) address that is associated with an IP address.

You can view the command output in the Operations Console.

Procedure

1. Log on to the Operations Console of the appliance where you want to verify an IP address or hostname.

2. Click Administration > Network > Network Tools.

3. From the Select Command drop-down list, choose a command that you want to run to verify the IP
address or hostname.

Note: If you run the ARP command, you do not need to enter an IP address or hostname. All entries in
the ARP table are always displayed.

4. In the Enter Hostname or IP Address field, enter the IP address or hostname that you want to verify.
The IP address must be in IPv4 or IPv6 format.

l Example in IPv6 format: 3ffe:1900:4545:3:200:f8ff:fe21:67cf

l Example in IPv4 format: 19.117.63.126

The hostnamemust not exceed 255 characters. For example, authservices.corp.com
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5. From the Source Address drop-down list, select the IP address from which the command originates. On
an appliance with multiple NICs, you may choose a specific IP address, or select Any, to allow the
system to choose the IP address. The source address applies to the ping and traceroute commands only,
and allows you to use these commands to test connections between specific IP addresses.

6. Click Run Command.

The output is displayed in theOutput section of the page.
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